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About This Book

This document provides procedures to install, upgrade, or make additions to a
DEFINITY ONE™ Communications System (hereafter referred to as DEFINITY
ONE), using the compact modular cabinet (CMC) with the TN795 circuit pack.

This document is intended for use by trained installation technicians who have
Windows NT and local area network (LAN) training.

DEFINITY ONE is a high-functionality communications system for customers in
the 25-40 line size or smaller with growth potential up to 168 stations. This offer
provides DEFINITY® software, INTUITY® AUDIX® messaging, and DEFINITY Site
Administration (DSA) on a single hardware platform.

Conventions Used in This Book

» Circuit pack codes (such as TN763D) are shown with the minimum
acceptable alphabetic suffix (like the “D” in the code TN763D).

Generally, an alphabetic suffix higher than that shown is also acceptable.
However, not every vintage of either the minimum suffix or a higher suffix
code is necessarily acceptable.

=>» NOTE:
Refer to Technical Monthly: Reference Guide for Circuit Pack
Vintages and Change Notices for current information about usable
vintages of specific circuit pack codes (including the suffix).

The following conventions describe the systems referred to in this document.

» The word system is a general term encompassing Release 1.0 and
includes references to DEFINITY ONE.

» Information in this book is applicable for Release 1.0 unless otherwise
specified



DEFINITY ONE Communications System Release 1.0 Issue 1
Installation and Upgrades 555-233-109 December 1999

About This Book

Related Documents

XVi

DEFINITY ONE Communications System is abbreviated as DEFINITY
ONE.

Physical dimensions in this book are in inches followed by metric
centimeters (cm) in parentheses. Wire gauge measurements are in AWG
followed by the cross-sectional area in squared millimeters (mmz) in
parentheses.

Related Documents

As supplemental information, you may want the following documents when
installing a DEFINITY ONE Release 1.0 system:

BCS Products Security Handbook, 555-025-600

DEFINITY Enterprise Communications Server Release 7 Installation for
Adjuncts and Peripherals, 555-230-125

DEFINITY Enterprise Communications Server Release 7 Administrator’s
Guide, 555-230-502

DEFINITY Enterprise Communications System R7 Administration for
Network Connectivity 555-233-501

DEFINITY ONE Communications System Release 1.0 Maintenance,
555-233-111

DEFINITY ONE Communications System Release 1.0 Overview,
555-233-001

DEFINITY Enterprise Communications Server Release 7 System
Description Pocket Reference, 555-230-211

DEFINITY Communications System and System 75 and System 85
Terminals and Adjuncts, 555-015-201

Switch Administration for DEFINITY AUDIX, 585-300-509

DEFINITY ONE Communications System Release 1.0 Installation Quick
Reference Card, 555-233-738

How to Order Documentation

A complete list of DEFINITY ONE, DEFINITY, and AUDIX books is available in the
Business Communications System Publications Catalog, 555-000-010.

You can order this document and any other documentation directly from the
Lucent Technologies Business Communications System Publications Fulfillment
Center at 1-317-322-6791 or toll free at 1-800-457-1235.
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How to Comment on This Book

Lucent Technologies welcomes your feedback. Please fill out the reader

Issue 1

December 1999

XVii

comment card at the front of this book and return it. Your comments are of great

value and help us to improve our documentation.

If the reader comment card is missing, fax your comments to 1-303-538-1741 or
to your Lucent Technologies representative, and specify this document’s name
and number, DEFINITY ONE Communications System Release 1.0 Installation

and Upgrades, 555-233-109.

Where to Call for Technical Support

Telephone Number

Streamlined Implementation (for missing equipment)

1-800-772-5409

USA/Canada Technical Service Center

1-800-248-1234

Technical Service Center (INADS Database Administration)

1-800-248-1111

ITAC

1-303-804-3777

DEFINITY Helpline (software assistance)

1-800-225-7585

Lucent Technologies Toll Fraud Intervention

1-800-643-2353

Lucent Technologies Technical Care Center

1-800-242-2121

Lucent Technologies Corporate Security

1-800-822-9009

DEFINITY Site Administration (DSA) Domestic

1-800-242-2121

INTUITY AUDIX Helpline

1-800-242-2121

TSC Repair

1-800-242-2121

DEFINITY Maintenance and Service

1-800-242-2121

Call Accounting support

1-800-242-2121

UPS support

1-800-242-2121
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Security Issues

To ensure security for customers, Lucent Technologies offers services that can
reduce toll-fraud liabilities. Contact your Lucent Technologies representative for
more security information.

For Software Copy Protection information, see [Chapter 9,]“Troubleshooting”.

=> NOTE:
Login security is an attribute of the DEFINITY ONE Release 1.0 software.

Trademarks

This document contains references to the following Lucent Technologies
trademarked products:

« AUDIX®

= CallVisor®

« DEFINITY®

» DEFINITY ONE™ Communications System
= INTUTY®

The following products are trademarked by their appropriate vendor:
» LINX™ s a trademark of Illinois Tool Works, Incorporated

» Netscape Navigat0r® is a registered trademark of Netscape
Communications Corporation

. pcANYWHERE® is a registered trademark of Dynamic Microprocessor
Associates

= Windows NT™ is a trademark, and Windows® is a registered trademark,
of Microsoft Corporation.

» KeepInTouch® is a registered trademark of Paradyne Corporation
» Paradyne™ is a trademark of Paradyne Corporation

» U.S. Robotics® is a registered trademark of U.S. Robotics Corporation.
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The equipment presented in this document complies with the following
standards:

ITU-T (Formerly CCITT)
IPNS

DPNSS

National ISDN-1
National ISDN-2
ISO-9000

ANSI

FCC Part 15 and Part 68
EN55022

EN50081

EN50082

CISPR22

IEC 825

IEC 950

UL 1459

UL 1950

CSA C222 Number 225
TS001

Contact your Lucent Technologies representative for more information.
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Electromagnetic Compatibility

Standards

This product complies with and conforms to the following standards:

Limits and Methods of Measurements of Radio Interference
Characteristics of Information Technology Equipment, EN55022
(CISPR22), 1993

EN50082-1, European Generic Immunity Standard

FCC Part 15

Australia AS3548

=> NOTE:
The system conforms to Class A (industrial) equipment. Voice
terminals meet Class B requirements.

Electrostatic Discharge (ESD) IEC 1000-4-2

Radiated radio frequency field IEC 1000-4-3

Electrical Fast Transient IEC 1000-4-4

The system conforms to the following standards:

Electromagnetic compatibility General Immunity Standard, part 1;
residential, commercial, light industry, EN50082-1, CENELEC, 1991

Issue 1 (1984) and Issue 2 (1992), Electrostatic discharge immunity
requirements IEC 1000-4-2

Radiated radio frequency field immunity requirements IEC 1000-4-3
Electrical fast transient/burst immunity requirements IEC 1000-4-4
Power Harmonics IEC 61000-3-2, 1995

Anti-Static Protection

A CAUTION:

When handling circuit packs or any components of a DEFINITY ONE
system, always wear an anti-static wrist ground strap. Connect the strap to
an approved ground such as an unpainted metal surface on the

DEFINITY ONE system.
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Remove/Install Circuit Packs

A CAUTION:

The control circuit packs with white labels cannot be removed or installed
when the power is on. The port circuit packs with gray labels (older version
circuit packs had purple labels) can be removed or installed when the
power is on.

Federal Communications Commission
Statement

Part 68: Statement

Part 68: Answer-Supervision Signaling. Allowing this equipment to be operated in
a manner that does not provide proper answer-supervision signaling is in
violation of Part 68 rules. This equipment returns answer-supervision signals to
the public switched network when:

» Answered by the called station

» Answered by the attendant

» Routed to a recorded announcement that can be administered by the CPE

user

This equipment returns answer-supervision signals on all DID calls forwarded
back to the public switched telephone network. Permissible exceptions are:

» Acallis unanswered.

= Abusy tone is received.

» Avreorder tone is received.
Lucent Technologies attests that this registered equipment is capable of
providing users access to interstate providers of operator services through the
use of access codes. Modification of this equipment by call aggregators to block

access dialing codes is a violation of the Telephone Operator Consumers Act of
1990.

This equipment complies with Part 68 of the FCC Rules. A label is provided on
this equipment that contains, among other information, the FCC registration
number and ringer equivalence number (REN) for this equipment. If requested,
this information must be provided to the telephone company.
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The REN is used to determine the quantity of devices which may be connected

to the telephone line. Excessive RENs on the telephone line may result in devices
not ringing in response to an incoming call. In most, but not all areas, the sum of
RENSs should not exceed 5.0. To be certain of the number of devices that may be
connected to a line, as determined by the total RENs, contact the local telephone

company.

=>» NOTE:

The REN is not required for some types of analog or digital facilities.

Means of Connection (U.S.)

Connection of this equipment to the U.S. telephone network is shown in the

following table.

SOC/REN/

Manufacturer’s Port Identifier | FIC Code A.S. Code Network Jacks
Off/On Premises Station OL13C 9.0F RJ2GX, RJ21X,

RJ11C
DID Trunk 02RV2-T 0.0B RJ2GX, RJ21X
CO Trunk 02GS2 0.3A RJ21X
CO Trunk 02LS2 0.3A RJ21X
Tie Trunk TL31M 9.0F RJ2GX
1.544 Mbps Digital Interface 04DU9-B,C 6.0P RJ48C, RJ48M
1.544 Mbps Digital Interface 04DU9-BN,KN | 6.0P RJ48C, RJ48M
120A2 Channel Service Unit 04DU9-DN 6.0P RJ48C

If the terminal equipment (DEFINITY ONE system) causes harm to the telephone
network, the telephone company will notify you in advance that temporary
discontinuance of service may be required. But if advance notice is not practical,
the telephone company will notify the customer as soon as possible. Also, you

will be advised of your right to file a complaint with the FCC if you believe it is

necessary.

The telephone company may make changes in its facilities, equipment,
operations or procedures that could affect the operation of the equipment. If this
happens, the telephone company will provide advance notice in order for you to
make necessary modifications to maintain uninterrupted service.
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If trouble is experienced with this equipment, for repair or warranty information,
please contact the Technical Service Center at 1-800-242-2121. If the equipment
is causing harm to the telephone network, the telephone company may request
that you disconnect the equipment until the problem is resolved.

It is recommended that repairs be performed by Lucent Technologies certified
technicians.

The equipment cannot be used on public coin phone service or on party-line
service provided by the telephone company. Connection to party line service is
subject to state tariffs. Contact the state public utility commission, public service
commission or corporation commission for information.

This equipment, if it uses a telephone receiver, is hearing-aid compatible.
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Install and Cable the Cabinet

This chapter describes the process you use to install and cable the cabinet in
preparation for physically connecting and accessing DEFINITY ONE.

=>» NOTE:
Physical installation of the cabinet and cabling is basically the same as the ProLogix
cabinet and cabling with the exceptions of the processor interface cable (multileg
cable) and the absence of the SAT terminal. Until the cabling and cabinet installation
is complete, there is no need for access to any software such as SAT, etc.

This chapter is organized as follows:

« [‘Check Customer’s Order” on page 1-2|

« [“Correct Shipping Errors” on page 1-2|

« [“Unpack and Inspect” on page 1-2|

« [“Install the System Cabinet” on page 1-6|

« [‘Check AC Power and Ground” on page 1-12|

« [‘Cable the System” on page 1-20|

« [|“Install Main Distribution Frame and External Modem” on page 1-21|

« [“Install Equipment Room Hardware” on page 1-24|

« [“Set Ringing Option” on page 1-38|

« [“Install and Wire Telephones and Other Equipment” on page 1-40|

« [|‘Connect External Alarms and Auxiliary Connections” on page 1-52|

« [“Install the BRI Terminating Resistor” on page 1-55|

« [“Install Multi-Point Adapters” on page 1-59|

« [“Install Off-Premises Station Wiring” on page 1-62|
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= [‘Install Emergency Transfer Unit and Associated Telephones” on page]
1-67]

=« [‘Connect Modem” on page 1-76|

= [‘Connect Modem to Telephone Network” on page 1-75|

= [‘Set Neon Voltage to Prevent Ring Ping” on page 1-77|

= [‘Complete Installation” on page 1-78|

=« [‘View LEDs to Determine Power and Fan Alarm State” on page 1-78|

Check Customer’s Order

Check the customer’s order and the shipping packing lists to confirm that all
equipment is present. If any equipment is missing, report this to your Lucent
Technologies representative. Check the system adjuncts for damage and report
all damage according to local shipping instructions.

Correct Shipping Errors

1. Red-tag all defective equipment and over-shipped equipment and return
according to the nearest Material Stocking Location (MSL) instructions.

2. Direct all short-shipped reports to the nearest MSL. Contact the
appropriate location for specific instructions. For streamlined
implementation, call 1-800-772-5409.

Unpack and Inspect
READ THIS FIRST!

A CAUTION:
A fully loaded system weighs 58 Ibs (26.3 kg). Use lifting precautions. If the doors,
power unit, and circuit packs are removed, the unit weighs only 29 Ibs (13.1 kg).

1. Verify the equipment received. See|Figure 1-1]Actual equipment may vary
in appearance and may ship in separate packages.

2. Equipment comcodes are listed in|Table 1-1.

3. Before mounting the cabinet, remove the cabinet doors by opening them
and lifting them straight up and off of the hinge pins.
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Figure Notes

1. Left panel (also acts as a wall-mount template 7. Processor interface cable

and as a floor mount pedestal) 8. Single-point ground block
2. CMC cabinet 9. 14-inch (35.5 cm) 6 AWG (#40) (16
3. Right panel mm2) ground wire
4. External modem (not shipped with all systems) 10. Flash disk (backup)
5. #12 x 1-inch shoulder screws
6. AC power cord (NEMA 5-15P or IEC 320)

Figure 1-1. Equipment Packed with the CMC Cabinet

Table 1-1]lists the comcodes for equipment used with the CMC. If “Optional” is
checked, this means that you may or may not need the equipment, depending
on your site configuration.
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Table 1-1. Comcodes for Equipment Used with the CMC
Comcode Description Optional
847951662 | Left Panel
847951670 | Right Panel
847915238 | Right Door
847915246 | Left Door
601929763 | Processor Interface Cable (Multileg cable)
103557484 | TN795 Processor Circuit Pack
848320800 | Hard Disk Programmed
40763399 External Modem X
601929920 | Software CDs
408276897 | PCMCIA Ethernet Adapter Card
408166783 | Flash Disk (For Backup)
105631527 | TDM/LAN Bus Terminator (AHF110)
706827717 | Single-Point Ground Block
H600-487 14-inch (35.5 cm) 6 AWG (#40) (16 mm2) Green Ground
Wire
847987187 | CMC 110 Cross-Connect Assembly (Main Distribution X
Frame) - Recommended
407676691 | 120 VAC Power Distribution Unit (145D 6-AC)
107949364 | 650A Power Supply
848082715 | Fan Assembly
407745009 | Fan Air Filter
848477634 | LAN Crossover Cable (RJ45), 12-foot
405362641 | 120 VAC Power Cord
106278062 | Apparatus Blank (Circuit Pack Blank) (158P)
106606536 | Integrated Channel Service Unit (ICSU) (120A2) X
107988867 | DS1 Loopback Jack (T1 Only) (700A) X
107152969 | 75 Ohm DS1 Coaxial Adapter (888B) X
403613003 | 157B Connecting Block (“sneak current protectors”) X
406948976 | 6SCP-110 Protector X

Continued onlnext page
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Table 1-1. Comcodes for Equipment Used with the CMC — Continued

1-5

Comcode Description Optional
107435091 | 507B Sneak Current Fuse Panel X
407216316 | 220029 Sneak Current Fuse X
103970000 | Main Distribution Frame Label (Code 220A) X
104307327 | C6C cable — 50-foot (15.2 m) shielded DS1 cable with X

50-pin male to 15-pin male
104307376 | C6D cable — 50-foot (15.2 m) shielded DS1 cable with X
50-pin male on each end
104307434 | C6E cable — 100-foot (30.5 m) shielded DS1 cable with | X
50-pin male to 50-pin female
104307475 | C6F cable — 50-foot (15.2 m) shielded DS1 cable with X
50-pin male to 3 inch (7.62 cm) stub
102381779 | 3B1A Carbon Block X
104410147 | 3B1E-W Wide Gap Gas Tube X
105514756 | 3C1S Analog Line Protector - Solid State X
102904893 | 4B1C Carbon Block with Heat Coill X
104401856 | 4B1E-W Wide Gap Gas Tube w/Heat Coil X
104386545 | 4C1S Analog Line Protector - Solid State with Heat Coil X
105581086 | 4C3S-75 Digital Voice Circuit Protector - Solid State X
406144907 | ITW LINX Gas Tube, Avalanche Suppress X
901007120 | ITW Linx Ground Bar (used with above) X
406304816 | ITW Linx Replacement Fuse X
103972758 | Data Link Protector (1 circuit) X
103972733 | Data Link Protector (8 circuits) X
407063478 | Electrostatic Discharge (ESD) Wrist Strap
407691401 | Z3A2 Alarm Adapter X
Lucent UPS X
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Install the System Cabinet

Set the Carrier Address ID

[
.

LLI"'_

swdmdip2 KLC 051399

Figure 1-2. Setting Carrier Address ID (Right Side)

1. Proceed to either|‘Floor-Mount the Cabinet”|on page 1-7 or to [Fwall-Mount]
[the Cabinet’lon page 1-8.
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Floor-Mount the Cabinet

The cabinet dimensions (with floor pedestal) are 28.5 in. (72.4 cm) high, 24.5 in.
(62.2 cm) wide, and 12 in. (30.5 cm) deep. Maintain a service clearance of 12 in.
(30.5 cm) on the left, right, and front of the cabinet.

ﬁg indmflor KLC 110397

Figure Notes

1. Left panel (floor-mount pedestal) 3. 12 inches (30.5 cm) minimum from
nearest object (required to service

2. #12 x 1-inch shoulder screws o
the circuit packs)

Figure 1-3. Typical Floor Mount Installation

1. Proceed to[‘Cable the System”|on page 1-20.
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Wall-Mount the Cabinet

A CAUTION:

A fully loaded system weighs 58 Ibs (26.3 kg). Use lifting precautions. If the doors,
power unit, and circuit packs are removed, the unit weighs only 29 Ibs (13.1 kg).

Install Plywood Backing onto Wall
The plywood and the hardware to mount the plywood are installer-provided.

=>» NOTE:

The following plywood dimensions account for the extra space needed to
install the panels on each side of the cabinet. The cabinet is 24 inches
(0.6 m) wide and each panel is 12 inches (0.3 m) wide.

1. Install a 3/4-inch (2 cm) thick sheet of 2 x 4-foot (0.6 x 1.2 m) plywood
horizontally onto the wall. See [Figure 1-4]

The top of the plywood must be at least 54 inches (137 cm) from the floor.
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Install the System Cabinet

Install Cabinet — Wall-Mount

1-9

54"
(137 cm)

5" (12.7 cm)

indmpnl3 KLC 110397

Figure 1-4. Left Panel Used as Mounting Template

Place the template on the wall ensuring that the top surface is level.
Mark two 1/8-inch (0.3-cm) pilot holes in the mounting hole locations.
Remove the template from the wall.

Drill the two pilot holes.

ok w DN P

Thread two #12 x 1-inch shoulder screws partially into the holes.
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6. Set the cabinet onto the wall and align the slots with the shoulder screws.
See Figure 1-5. Slide the cabinet to the left to hold it in place. Tighten the
screws securely.

Figure Notes

1. #12 x 1-inch shoulder screws 2. #12 x 1-inch safety screw

Figure 1-5. Typical Wall-Mount Installation
7. Drill 2 lower mounting holes using the cabinet as a template.

8. Thread the 2 lower screws and tighten.

A CAUTION:
Be sure the right bottom safety screw is in place and tight.
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Install Left and Right Panels — Wall-Mount

—

1

indmins3 KLC 091197

Figure Notes

1. Left panel 2. Right panel

Figure 1-6. Left and Right Panel Installation

1. Align the cutouts in the panels with the cabinet hinges.

2. Drill a 1/8-inch (0.3 cm) pilot hole into the wall and secure the panels with
the #12 x 1-inch shoulder screws.
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Check AC Power and Ground

A CAUTION:

The AC power circuit must be dedicated to the system. The circuit must not be shared
with other equipment and must not be controlled by a wall switch. The AC receptacle
must not be located under the Main Distribution Frame and must be easily accessible.

A CAUTION:

The latch only removes DC power from the cabinet. Unseating the power supply
removes AC power from the power supply, but not from the cabinet. To remove AC

power from the cabinet, pull the AC power cord from the AC appliance connector on
the rear of the cabinet.

A CAUTION:

System grounding must comply with the general rules for grounding provided in
Article 250 of the National Electrical Code (NEC), National Fire Protection Agency
(NFPA) 70, or the applicable electric code in the country of installation.

A CAUTION:

AC mains wiring and testing must be performed by a qualified electrician and must
conform to Article 250 of the National Electrical Code (NEC), National Fire Protection
Agency (NFPA) 70, or the applicable electric code in the country of installation.

Check AC Power

Each CMC uses an auto-ranging 85 to 264 VAC power supply, 47 to 63 Hz, 330
Watts, 4.5 Amps (100-120 VAC) or 2.3 Amps (200 to 240 VAC), at 500 VoltAmps
(VA).

The AC power source can be 1 phase of 120 VAC with neutral (100 VAC for
Japan) with 15-Amp circuit breaker, or 1 phase of 220 or 240 VAC (200 VAC for
Japan) with 10-Amp circuit breaker. The AC cord uses a NEMA 5-15P plug or an
IEC 320 plug.

Before powering up the system, check the AC power in the equipment room
using a KS-20599 digital voltmeter (DVM) (or equivalent).

1. Measure the AC voltage between the hot and neutral sides of the
receptacle.

2. Depending on the AC power source, verify that the meter reads 90 to 132
VAC or 180 to 264 VAC. If not, have a qualified electrician correct the
problem.

3. Measure the voltage between the neutral and ground sides of the
receptacle.
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4. Verify that the meter reads 0 VAC. If not, have a qualified electrician
correct the problem.

5. When finished, set the AC main circuit breakers to OFF.

Approved Grounds

An approved ground is the closest acceptable medium for grounding the
building entrance protector, entrance cable shield, or single-point ground of
electronic telephony equipment. If more than 1 type of approved ground is
available on the premises, the grounds must be bonded together as required in
Section 250-81 of the National Electrical Code.

Grounded Building Steel — The metal frame of the building where it is
effectively grounded by 1 of the following grounds: acceptable metallic water
pipe, concrete encased ground, or a ground ring.

Acceptable Water Pipe — A metal underground water pipe, at least 1/2 inch
(1.3 cm) in diameter, in direct contact with the earth for at least 10 feet (3 m). The
pipe must be electrically continuous (or made electrically continuous by bonding
around insulated joints, plastic pipe, or plastic water meters) to the point where
the protector ground wire connects. A metallic underground water pipe must be
supplemented by the metal frame of the building, a concrete-encased ground, or
a ground ring. If these grounds are not available, the water pipe ground can be
supplemented by 1 of the following types of grounds:

» Other local metal underground systems or structures — Local
underground structures such as tanks and piping systems

» Rod and pipe electrodes — A 5/8-inch (1.6-cm) solid rod or 3/4-inch
(2-cm) conduit or pipe electrode driven to a minimum depth of 8 feet (2.4
m)

» Plate electrodes — Must have a minimum of 2 square feet
(0.185 square m) of metallic surface exposed to the exterior soil

Concrete Encased Ground — An electrode encased by at least 2 inches

(5.1 cm) of concrete and located within and near the bottom of a concrete
foundation or footing in direct contact with the earth. The electrode must be at
least 20 feet (6.1 m) of 1 or more steel reinforcing bars or rods 1/2-inch (1.3 cm)
in diameter, or at least 20 feet (6.1 m) of bare, solid copper, 4 AWG (26 mmz)
wire.

Ground Ring — A buried ground that encircles a building or structure at a depth
of at least 2.5 feet (0.76 m) below the earth’s surface. The ground ring must be at
least 20 feet (6.1 m) of 2 AWG (35 mm2), bare, copper wire.
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APPROVED FLOOR GROUNDS

A crution:
If the approved ground is inside a dedicated equipment room, then these
connections must be made by a qualified electrician.

Floor grounds are those grounds on each floor of a high-rise building that are
suitable for connection to the ground terminal in the riser closet and to the
cabinet single-point ground terminal. Approved floor grounds may include:

» Building steel

» The grounding conductor for the secondary side of the power transformer
feeding the floor

» Metallic water pipes
» Power-feed metallic conduit supplying panel boards on the floor

» A grounding point specifically provided in the building for the purpose

Uninterruptible Power Supply

The recommended UPS (Uninterruptible Power Supply) may be used for power
holdover. The type of UPS depends on the holdover requirements. Holdover
times vary from less than 10 minutes to up to 8 hours. The UPS must provide
surge protection for the CMC cabinet.

1. Connect the UPS to an electrical outlet capable of handling the power
requirements of the cabinets:

a. 100 VAC, 4.5 Amps.
b. 120 VAC, 3.8 Amps.
c. 200 VAC, 2.3 Amps.
d. 220-240 VAC, 2.0 Amps.

2. Be sure the cabinet is connected to an “unswitched” or “always on”
electrical outlet on the UPS.

3. Connect and administer the UPS. See [‘Connect External Alarms and|
[Auxiliary Connections” on page 1-52.

=>» NOTE:
If you choose to wire in the UPS as recommended, your hold over time will
be 1 minute prior to an automatic shutdown.
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Cabinet Power Switch

A cauTion:
The latch acts as the DC power switch and only removes DC power from
the cabinet, not AC power. To remove AC power, pull the AC power cord
from the appliance inlet. See Figure 1-7.

=

psdmdc RPY 011998

Figure Notes
1. Latch

—>» NOTE:
The processor is a double wide
board that covers both slots 1 & 2.

Figure 1-7. CMC Power Supply

Connect Cabinet Grounds and Other Grounds

The following additional grounding requirements must be met:
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= The approved ground wire must be green, 6 AWG (#40) (16 mmz),
copper, stranded wire. This is in addition to the ground wire in the AC
power cord.

= Bond all approved grounds at the single-point ground to form a single
grounding electrode system.

Install the Ground Block
1. Mount the ground block as shown in Figure 1-8.
2. Make the cable connections as shown in

@]}
o
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Figure Notes

1. #12 x 1-inch shoulder screws 2. Single-point ground block

Figure 1-8. Ground Block Installation to Right Panel
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Figure Notes
1. 6 AWG (#40) (16 mm2) cabinet 3. AC load center single-point ground

ground wire 4. 10 AWG (#25) (6 mm?) wire to
2. Single-point ground block coupled bonding conductor (CBC)

5. 6 AWG (#40) (16 mm2) ground wire
from single-point ground block to the
AC load center single-point ground

Figure 1-9. Typical Cabinet Grounding
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Install Coupled Bonding Conductor

The Coupled Bonding Conductor (CBC) provides for mutual inductance coupling
between the CBC and the telephone cables that are exposed to lightning. The
conductor can be a 10 AWG (#25) (6 mmz) wire tie wrapped to the exposed
cables, a metal cable shield around the exposed cables, or 6 spare pairs from
the exposed cable.

In a high rise building, connect the CBC to an approved building ground on each
floor. To provide the coupled bonding protection:

1. Connect 1 end of the conductor to a telephone cable building entrance
protector ground that is connected to an approved ground.

2. Route the rest of the conductor next to the exposed telephone cables
being protected until they reach the cross-connect nearest to the
telephone system.

3. Position the non-exposed telephone cables at least 12 inches (30.5 cm)
away from exposed telephone cables whenever possible.

4. Terminate the other end to the single-point ground block provided for the
telephone system.

Connect and Route the Power Cords

A CAUTION:

The AC power cord may connect to a properly rated power distribution unit,
individual AC power receptacles, or to a UPS. See|Figure 1-10.

1. Be sure the circuit breakers at the AC load center are OFF.

2. Connect the cabinet to an “unswitched” or “always on” electrical outlet.
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Figure Notes

1. Cabinet AC power cord 2. Surge-protected AC power
distribution unit (120 VAC
systems) (optional)

Figure 1-10. Routing AC Power Cords to a Power Distribution Unit
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Cable the System

Install Processor Interface Cable and TDM/LAN
Bus Terminators

1-20
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Figure Notes

1. TDM/LAN bus terminator 2. Processor interface cable

Figure 1-11. System Cable Connections

1. Connect the Processor Interface Cable to slot 2 connector behind the
cabinet. See Figure 1-11.

2. Install the TDM/LAN bus terminators.
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Install Main Distribution Frame and
External Modem

Install the MDF

A CAUTION:

The optional MDF is a special 110 cross-connect field and is smaller than standard
110 cross-connect hardware. Do not install standard 110 hardware inside the right
panel.

=>» NOTE:
The depth of any equipment installed inside the right panel must not exceed 2.5
inches (6.3 cm), otherwise the right cover panel cannot fit over the right panel.

The optional MDF represents the trunk/auxiliary field.

= Mount the optional MDF to the right panel using the following procedure:

Bottom-mounted MDF with Modem

1. On the rear of the MDF, cut the cable tie securing the top 5 cables to the
MDF mounting frame.

2. Mount the MDF to the right panel. See|Figure 1-12.

3. Secure all 10 cables to the bottom left bracket on the MDF with a cable tie.
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Figure Notes

1. Main distribution frame (MDF) 3. Processor interface cable (connect P2

2. External modem to modem)
4. #12 x 1-inch shoulder screw

=>» NOTE:

There should be no cable plugged
into slot 1.

Figure 1-12. Typical Bottom-Mount MDF and Modem Cable Routing
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Install the External Modem

The U.S. Robotics external modem is the recommended external modem.
DEFINITY ONE systems operate with this modem set to the factory default
settings.

=>» NOTE:
You may use a locally obtained, type-approved external modem (33.6 Kbps
and V.34 protocol). Contact your Lucent Technologies representative for
more information.

A WARNING:
If you use a modem other than the U.S. Robotics modem, the modem must be
configured in the software before it will recognize the modem and use it.

1. Use the hardware provided with the modem. See|Eigure 1-12 |If
top-mounting MDFs, mount the external modem to the plywood in a
location which allows the standard connection to the modem cable.

2. Route the modem cable (P2) from the Processor Interface Cable through
the cable trough and to the modem.

3. Connect the cable to the modem. Refer to[Appendix A]“Cable Pinouts” for
the pinout of the modem cable.

4. Plug the modem power cord into an electrical outlet and turn on the
modem.

5. Information about modem setup, administration, settings, and testing is
described in[‘Modem Setup and Administration”]on page 9-6.
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Install Equipment Room Hardware

Refer to DEFINITY Communications System Generic 1 and Generic 3 Main
Distribution Field Design, 555-230-630, for more information.

Cross-Connect the Cabinet to the MDF

1. Cross-connect the ports on the trunk and line circuit packs to the MDF as

required. See|Figure 1-14.

Allowable and Non-Allowable Circuit Packs

Table 1-2 lists the circuit packs that can and cannot be used with Release 1.0 of
DEFINITY ONE.

Table 1-2. Circuit Packs and Circuit Modules

Apparatus

Code Name Allowable

650A AC Power Unit Yes

982LS Current Limiter No

CFY1B Current Limiter No

CPP1 Memory Expansion No

ED-1E546 DEFINITY AUDIX R3 System No

(TN566)

(TN567)

ED-1E546 CallVisor ASAIl over the DEFINITY (LAN) Gateway R1 | No

(TN2208)

(TN2170)

J58890M-1 CallVisor ASAl/Call Visor PC/LAN over the DEFINITY No

(TN801) LAN Gateway R2

NAA1 Fiber Optic Cable Adapter Circuit Pack Yes

TN417 Auxiliary Trunk Yes

TN2305 ATM Trunk Yes

TN419B Tone-Clock No

TN420B/C Tone Detector No

TN429/B/C/D Analog Direct Inward/Outward Dialing (DIOD) Central | Yes
Office Trunk

Continued onlnext page
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Table 1-2. Circuit Packs and Circuit Modules — Continued
Apparatus
Code Name Allowable
TN429C Analog Central Office Trunk Yes
TN429D Analog DIOD Trunk - Analog Loop Start Yes
TN433 Speech Synthesizer Yes
TN436B Direct Inward Dialing Trunk Yes
TN438B Central Office Trunk Yes
TN439 Tie Trunk Yes
TN447 Central Office Trunk Yes
TN457 Speech Synthesizer Yes
TN459B Direct Inward Dialing Trunk Yes
TN464F DS1 Interface - T1, 24 Channel - E1, 32 Channel Yes
TN465B/C Central Office Trunk Yes
TN467 Analog Line Yes
TN468B Analog Line Yes
TN479 Analog Line Yes
TN553 Packet Data Line Yes
TN556C/D ISDN-BRI 4-Wire S/T-NT Interface Yes
TN568 DEFINITY AUDIX Slim No
TN570B/C Expansion Interface No
TN572 Switch Node Clock No
TN573B Switch Node Interface No
TN574 DS1 Converter - T1, 24 Channel No
TN577 Packet Gateway No
TN722B DS1 Tie Trunk Yes
TN725B Speech Synthesizer Yes
TN726B Data Line Yes
TN735 MET Line Yes
TN742 Analog Line Yes
TN744B/C Call Classifier No

Continued onlnext page
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Table 1-2. Circuit Packs and Circuit Modules — Continued
Apparatus
Code Name Allowable
TN744D Call Classifier - Detector Yes
TN746B Analog Line Yes
TN747/B Central Office Trunk Yes
TN748B/C/D Tone Detector No
TN750B Announcement No
TN750C Announcement Yes
TN753/B Direct Inward Dialing Trunk Yes
TN754/B/C Digital Line 4-Wire DCP Yes
TN755/B Neon Power Unit No
TN756 Tone Detector/Generator No
TN758 Pooled Modem Yes
TN760B/C/D/E | Tie Trunk Yes
TN762/B Hybrid Line Yes
TN763B/C/D Aucxiliary Trunk Yes
TN765 Processor Interface No
TN767B/C/D/E | DS1 Interface - T1, 24 Channel Yes
TN768 Tone-Clock No
TN769 Analog Line Yes
TN771/D Maintenance/Test No
TN772 Duplication Interface No
TN775/B/C Maintenance No
TN776 Expansion Interface No
TN777B Network Control No
TN778 Packet Control No
TN780 Tone-Clock No
TN787F/G/HIJ/K | Multimedia Interface No
TN788B Multimedia Voice Conditioner No
TN789 Radio Controller Yes

Continued onlnext page
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Table 1-2. Circuit Packs and Circuit Modules — Continued
Apparatus
Code Name Allowable
TN790B Processor No
TN791 Analog Line Yes
TN792 Duplication Interface No
TN793 Analog Line, 24-Port, 2-Wire Yes
TN794 Network Control/Packet Interface (NetPkt) No
TN795 Processor Yes
TN798B Processor No
TN799 Control LAN (C-LAN) Yes
TN801 LAN Gateway Interface No
TN802/B Internet Protocol (IP) Trunk Yes
TN1648/B System Access/Maintenance No
TN1650B Memory No
TN1654 DS1 Converter - T1, 24 Channel/E1, 32 Channel No
TN1655 Packet Interface No
TN1656 Tape Drive No
TN1657 Disk Drive No
TN2135 Analog Line Yes
TN2136 Digital Line 2-Wire DCP Yes
TN2138 Central Office Trunk Yes
TN2139 Direct Inward Dialing Trunk Yes
TN2140B Tie Trunk - Hungary, Italy Yes
TN2144 Analog Line Yes
TN2146 Direct Inward Dialing Trunk Yes
TN2147C Central Office Trunk Yes
TN2149 Analog Line Yes
TN2180 Analog Line Yes
TN2181 Digital Line 2-Wire DCP Yes
TN2182/B Tone-Clock - Tone Detector and Call Classifier No

Continued onlnext page
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Table 1-2. Circuit Packs and Circuit Modules — Continued

Apparatus

Code Name Allowable

TN2183 Analog Line Yes

TN2184 DIOD Trunk Yes

TN2185/B ISDN-BRI 4-Wire S/T-TE Interface (Trunk Side) Yes

TN2198 ISDN-BRI 2-Wire U Interface No

TN2199 Central Office Trunk Yes

TN2202 Ring Generator No

TN2207 DS1 Interface - (T1) 24 Channel and (E1) 32 Channel | Yes

TN2209 Tie Trunk - Russia Yes

TN2210 Tone Generator No

TN2214/B Digital Line, 24-Port, 2-Wire DCP - Category B only Yes

TN2215 Analog Line, 16-Port 2-Wire - Category B only Yes

TN2224/B Digital Line, 24-Port, 2-Wire DCP Yes

TN2238 ATM Trunk Interface (Multi-Mode) No

TN2242 TTC Japanese 2Mbit Trunk Yes

TN2301 Survivable Remote Logic Switch No

TN2305 ATM Interface (Multi-Mode) Yes

TN2306 ATM Interface (Single-Mode) No

TN2308 Direct Inward Dialing Trunk No

TN2464 DS1 Interface - T1, 24 Channel - E1, 32 Channel Yes

TN2793 Analog Line 24-Port Yes
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Circuit Pack Installation

A cauTion:

When handling circuit packs or any components of a DEFINITY ONE
system, always wear an authorized wrist ground strap. Connect the strap to
the ground connector provided on the system cabinet.

=>» NOTE:
All of the circuit pack slots in the CMC are “universal slots.” That is, any slot
can contain any type of port circuit pack.

Circuit Pack Slot Loading

1. Install the TN795 Processor circuit pack in slot 2 of the cabinet.

Load all port circuit packs.

2. A TN744D Call Classifier/Tone Detector circuit pack is required. Install the
TN744D into any port slot except for slots 1 and 2 (slot 3 is preferred but
not required.)

3. Seel[Table 1-3|for the recommended circuit pack layout.
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1.Slots1-5 3. 650 Power Supply
2. Slots 6 - 10 4. For Flash Disk

Figure 1-13. Cabinet and Slot Numbering
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The TN795 circuit pack is reserved for slots 1 and 2 and the TN744D circuit pack can go in
any of the other slots (slot 3 is recommended).

Table 1-3. Circuit Pack Installation Order (Loading)

Function Apparatus Code Load From Notes

Processor TN795 Slot 2

Announcement TN750C Any slot

Speech Synthesizer | TN725B Any slot

DS1/E1, ISDN PRI TN464F, TN767E, Lower Right Maximum of 7ISDN-PRI. Total
TN2242, TN2464 number of ISDN-PRI plus
(Guestworks and BCS number of ISDN-BRI circuit
only) packs must not exceed 7.

ISDN-BRI Trunk TN2185 Lower Right Maximum of 4

CO Trunk TN747B, TN465C, Lower Right

TN2199, TN2147C,
TN2138, TN438B

DID Trunk TN753, TN2139, TN2146, Lower Right
TN436B, TN459B

Tie Trunk TN760E, TN458, TN497, Lower Right
TN2140B

Auxiliary Trunk TN417 Lower Right

Modem Pool TN758 Lower Right

Data Line TN726 Upper Left

Digital Line TN754C, TN2181, Upper Left

TN2224/B, TN2214/B

Analog Line TN746B, TN2135, TN467, Upper Left
TN2144,TN2149, TN2180,
TN2183, TN2215,
TN468B,TN791

Hybrid Line TN762B Upper Left
MET Line TN735 Upper Left
Radio Controller TN789 Upper Left
ISDN-BRI 4-Wire TN556C/D Upper Left

S/T-NT Line (A-Law)

1. Cross-connect the port circuit packs to the MDF. See |[Eigure 1-14.
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Off-Premises Circuit Protection

Protection from hazardous voltages and currents is required for all off-premises
(out of building) trunks, lines, and terminal installations. Both over-voltage
protection (lightning, power induction, and so forth), and sneak current
protection are required. Sneak current protectors must be either UL listed/CSA
certified, or must comply with local safety standards.

Sneak current protectors must have a maximum rating of 350 mA, and a
minimum voltage rating of 600V, or as required by local regulations. The following
devices protect the system from over-voltages:

Analog trunks use the 507B sneak protector or equivalent. Over-voltage
protection is normally provided by the local telephone company.

Analog voice terminals use one of the following types of combined
over-voltage and sneak current protection, or equivalent;

— Carbon block with heat coil for UL code 4B1C
— Gas tube with heat coil for UL code 4B1E-W
— Solid state with heat coil for UL code 4C1S

DCP and ISDN-BRI terminals use the solid state 4C3S-75 with heat coil
protector, or equivalent.

DS1/T1 circuits require isolation from exposed facilities. This isolation may
be provided by a CSU (T1), or other equipment that provides equivalent
protection.



DEFINITY ONE Communications System Release 1.0 Issue 1

Installation and Upgrades 555-233-109 December 1999
1 Install and Cable the Cabinet
Install Equipment Room Hardware 1-34

Install Sneak Fuse Panels

Sneak current protection is required between the incoming RJ21X or RI2GX
network interface and the system for both trunk and off-premises circuit packs.
The model 507B sneak current fuse panel, or equivalent, is recommended for
sneak current protection. See Figure 1-15.

4

Sneak

Current
Protector

507B

sneak CJL 032096

Figure Notes

1. Sneak current protector 3. 25-pair female connector (Out)

(PEC 63210) 4. 220029 fuses (inside panel). Use a small

2. 25-pair male connector (In) screwdriver to pry top cover off

Figure 1-15. Model 507B Sneak Fuse Panel



DEFINITY ONE Communications System Release 1.0 Issue 1

Installation and Upgrades 555-233-109 December 1999
1 Install and Cable the Cabinet
Install Equipment Room Hardware 1-35

Approximately 8 inches (20 cm) of horizontal wall space is required for each
column of sneak fuse panels. Connector cables connect the network interface to
the sneak fuse panel. Also, use 157B connecting blocks equipped with SCP-110
protectors for sneak current protection.

=>» NOTE:
Sneak current protectors with a rating of 350 mA at 600 Volts must be UL
listed for United States installations and CSA certified for Canadian
installations. The panel contains two 25-pair connectors, fuse removal tool,
and fifty 220029 Sneak Fuses (and 2 spares). Use the SCP-110 protectors
with 110-type hardware and on the 507B Sneak Fuse Panel. The SCP-110
Protectors can be ordered separately and installed on the 157B connecting
block. Fifty protectors are required per block.

1. Install the 507B near the network interface or MDF with locally-obtained
#12 x 3/4-inch screws (or equivalent).
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Table 1-4 is a pinout of the cable wiring and associated fuse numbers.

Table 1-4. Sneak Fuse Connector Pinout

Connector Pin | Pair/Fuse
Numbers Number
26/1 1
2712 2
28/3 3
29/4 4
30/5 5
31/6 6
32/7 7
33/8 8
34/9 9
35/10 10
36/11 11
37/12 12
38/13 13
39/14 14
40/15 15
41/16 16
42/17 17
43/18 18
44/19 19
45/20 20
46/21 21
47/22 22
48/23 23
49/34 24
50/25 25
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Label the Main Distribution Frame

Figure 1-16 shows the graphic symbols used on the supplied labels for the
system, cross-connections, information outlets, and cables.

1. Write the floor and building identification on each label as required.
2. Insert the labels into the plastic holders.

3. Snap the holders into the appropriate locations on the MDF.
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Figure Notes

1. Floor and building identification 6. Site/satellite closet
2. Cabinet 7. Tie circuit

3. Carrier 8. Floor

4. Slot 9. Building

5. Information outlet

Figure 1-16. Label Graphic Symbols and Nomenclature

1. Label the cables as required using the supplied labels. Label code
number 220A (comcode 103970000) contains all required labels.
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Set Ringing Option
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evdmring KLC 042899

Figure Notes
1. Ringing option switch

—>» NOTE:
Look at the Label on the side of
the Power supply to see how to
set switch.

Figure 1-17. Ringing Option Selection
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Do Not Remove Board Until
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Figure Notes

1. PCMCIA slots 6. Emergency Transfer Switch

2. Red LED 7. Complete Shutdown - safe to pull
3. Green LED board when green LED is on

4. Amber LED 8. Shutdown Switch - gracefully shuts

down system
5. PCMCIA In-Use LED

Figure 1-18. TN795 Circuit Pack Faceplate
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Install and Wire Telephones and Other
Equipment

=>» NOTE:
Only 1 pair of wires is available for emergency transfer, and 1 pair of wires
is available for attendant console power.

The wiring procedures are similar for most of the DEFINITY System telephones
and other equipment.

This chapter provides wiring examples of these similar installation procedures.
These are examples only and actual wiring procedures may vary at each site.
The system can connect to all DTE terminals. The system can have RS-232 (or
EIA-232) or DCP interfaces.

All wiring pinouts for port circuit packs are in the tables at the end of this chapter.

Refer to[Figure 1-14Jon page 1-32 for punch-down information for common circuit
packs. The figure shows the colors of the punch-downs and is best viewed from
CD-ROM or on-line.

After installing the hardware, the data for the system and telephone features is
administered. These procedures are provided in DEFINITY Enterprise
Communications Server Release 7 Administrator’'s Guide, 555-233-502.

Telephone Connection Examples

The 302C1 Attendant Console describes a typical telephone connection. This
information is typical of the 603E, 84xx (4-wire), and 94xx telephones. The
attendant console always requires auxiliary (adjunct) power (-48 VDC). See

Figure 1-19./0Only 1 console can be powered by the system through the AUX
connector. The primary console should be powered from the system so it has the
same power failure backup as the system.

The maximum cabling distance for the console powered from the cabinet is 350
feet (100 meters) using 24 AWG (#5) (0.26 mm2) wire.
The general steps to connect a telephone are:

1. Choose a device to connect such as a 302C1 Attendant Console.

2. Choose the port circuit pack and its carrier and slot number, such as
TN754C, Carrier A, Slot 06.

3. Choose a port circuit on the port circuit pack, such as Port 05.
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Figure Notes
1. 302C1 attendant console 3. -48 VDC from adjunct power

2. 4-wire digital line circuit pack 4. Ground from adjunct power

Figure 1-19. 302C1 to Digital Line Circuit Pack Wiring

4. Install cross-connect jumpers to wire the terminal to the port circuit pack.
See Figure 1-19. This pinout is for a 4-wire Digital Line circuit pack.
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Connect Adjunct Power

The 400B2 adapter is convenient for connecting local -48 VDC power to a
modular plug. See Figure 1-20.

©

r749428 RPY 012098

Figure Notes

1. Surface-mounted information outlet 4. To telephone
2. To individual power unit (such as 5. Destination service access
1151A or 1151A2) point (DSAP) power cord

3. 400B2 adapter

Figure 1-20. 400B2 Adapter Connecting to a Modular Plug

Adjunct power can be provided from the equipment room or equipment closet
with 1145B power unit. The AUX connector (J1) on the processor interface cable
can provide power for 1 attendant console.

Adjunct power can be provided locally at the telephone or console by the 1151A
or 1151A2 Power Supply.
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Analog Station or 2-Wire Digital Station Example

This example is typical of the 2-wire digital stations,2-wire analog stations, analog
CO trunks, DID trunks, and external alarms. See Figure 1-21.

V' ©

T 24— >—» 28 T3
R 34— >—» 03 R3
2500wire RBP 040596
Figure Notes
1. 2500-type analog station 2. 2-wire analog line circuit pack

Figure 1-21. 2500-Type Analog Telephone Wiring

1. Choose a peripheral to connect (such as a 2-wire digital station).

2. Choose the port circuit pack to use and its carrier and slot number. For
example, TN2183 Analog Line, Cabinet 1, Carrier C, Slot 1.

3. Choose a port circuit on the port circuit pack, for example port 3.

4. Install cross-connect jumpers to connect the pins from the 2-wire station to
the appropriate pins on the port circuit pack.

5. Administer using DEFINITY Enterprise Communications Server Release 7
Administrator’'s Guide, 555-233-502.
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Analog Tie Trunk Example

\ 4 o

Tl 26 €«—< >—» 29 T2
Rl 1<€—< >—» 4 R2
T1l 27€—< >—» 30 T12
R11 2 €« >—» 5 RI12
El 28€¢—< >—» 31 E2
M1 3 €< >—» 6 M2

tie wire RBP 040596

Figure Notes

1. External trunk or adapter 2. Tie trunk circuit pack

Figure 1-22. Analog Tie Trunk Wiring

1. Before installing the Tie Trunk circuit pack, set the option switches as
described in[Chapter 1]“Install and Cable the Cabinet”.

2. Install cross-connect jumpers to connect the pins from the Tie Trunk circuit
pack to the appropriate leads on the external tie trunk. Names of the tie
trunk leads must be determined from the manufacturer or supplier of the
external trunk circuit. The example in Figure 1-22 shows a DEFINITY
System tie trunk connected to a DEFINITY System tie trunk.

3. Administer on the Trunk Group Screen. See DEFINITY Enterprise
Communications Server Release 7 Administrator's Guide, 555-233-502.
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Digital Tie Trunk Example

dig_tie RBP 040596

Figure Notes

1. External trunk 4. LO (Balanced output pair)
2. DS1 interface circuit pack, position 5. LI

1C06 6. LI (Balanced input pair)
3.LO

Figure 1-23. Digital Tie Trunk Wiring
1. Before installing the DS1 Interface circuit pack, set the option switches
according to[Chapter 1]“Install and Cable the Cabinet”.

2. Install cross-connect jumpers to connect the pins from the digital trunk
circuit pack to appropriate pins on the external digital trunk.

3. Administer the DS1 Interface circuit pack on the DS1 and Trunk Group
Screens. See DEFINITY Enterprise Communications Server Release 7
Administrator’'s Guide, 555-233-502.
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DS1 Tie Trunk Example

DS1 tie trunks provide a 1.544 Mbps (T1) or 2.048 Mbps (E1) digital data service
between 2 collocated systems or between the system and a data network. The
following cables can be used:

C6C connector cable — 50-foot (15.2-m) shielded cable with a 50-pin
male connector on 1 end and a 15-pin male connector on the other end.
Use to connect a DS1 tie trunk circuit pack to a Channel Service Unit.

C6D connector cable — 50-foot (15.2-m) shielded cable with a 50-pin
male connector on each end. Use to connect a DS1 tie trunks in
collocated cabinets.

C6E connector cable — 100-foot (30.5-m) shielded cable with a 50-pin
male connector on 1 end and a 50-pin female connector on the other end.
Use as an “extension” cable between the DSL1 tie trunk circuit pack and
other connector cables.

C6F connector cable — 50-foot (15.2-m) shielded cable with a 50-pin
male connector on 1 end and a 3 inch (7.62-cm) stub on the other end.
Use to connect the DS1 tie trunk circuit pack to channel multiplexers
requiring hardwired connections. See Table 1-5 for a pinout.

Table 1-5. Pinout of C6F Cable

Wire Color Lead Designation II:IISmber
White/Green LI (High Side) a7
Green LI 22
White/Brown LO 48
Brown LO (High Side) 23
White/Slate LBACK2 49
Slate LBACK1 24

Collocated DS1 Tie Trunks

Two DS1 tie trunk circuit packs can be in collocated systems. A DS1 tie trunk
circuit pack in 1 system can connect to a DS1 tie trunk in another system. Use a
C6D cable if the distance is less than 50 feet (15.24 m). If the distance is greater
than 50 feet (15.24 m), use a C6E cable.

=)>» NOTE:

The maximum distance between cabinets is 1310 feet (399.3 m).
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DS1 Tie Trunks Using T1 Channel Service Unit

Figure 1-24 shows a DSL1 tie trunk connected to an external T1 Channel Service
Unit (CSU). A 120A2 enhanced Integrated Channel Service Unit (ICSU) can be
used in place of a T1 external CSU. The CSU or ICSU interfaces the DSL1 tie
trunks with the 1.544 Mbps digital facility. Contact your Lucent Technologies
representative for maximum cabling distances.

| o 1
0012 RBP 070297

Figure Notes
1. To DSL1 tie trunk circuit pack 5. Ring (R)

2. C6C cable (If distance is over 50 6. Tip 1(T1)
feet (15.24 m), use C6E cable.)

7. Ringl (R1)
3. T1 external CSU or 120A2 ICSU 8. 1.544 Mbps T1 interface
4. Tip (T) 9. To T1 carrier

Figure 1-24. Typical Connections to Channel Service Unit
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3-Pair and 4-Pair Modularity

Figure 1-25 shows 3-pair and 4-pair modularity from the port circuit pack to the
voice or data terminal. Most terminals connect to an information outlet (modular
jack) installed at the work location.
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Figure Notes

1. Port circuit pack 5. Output from information outlet (4-pair
2. 25-pair connector pins (3-pair modularity)

modularity) 6. Voice or data terminal pins
3. MDF pins (3-pair modularity) 7. Adjunct power

4. Input to information outlet (4-pair
modularity)

Figure 1-25. 3-Pair and 4-Pair Modularity
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Adjunct Power Connections

Figure 1-26 shows typical connection locations for adjunct power.
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Figure Notes
1. Typical display telephone 9. 100P6A patch cord or jumpers
2. Individual power supply (such as 10. System side of MDF

1151A, not used if item 14 is used)
. 400B2 adapter

11. 25-pair cable to digital line circuit pack

12. Equipment room
. Information outlet (modular jack)

. 4-pair D-Inside Wire (DIW) cable

13. Satellite location

14. Bulk power supply (such as 1145B).
. Satellite site or adapter location Install at satellite location or equipment

. 25-pair D-Inside Wire (DIW) cable room (not both).
. Station side of MDF

0o N O 0o b~ W

Figure 1-26. Example Adjunct Power Connections
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Local and Phantom Power

An attendant console’s maximum distance from the system is limited.
See Table 1-6.

Table 1-6. Attendant Console Cabling Distances

. . 2
Enhanced Attendant 24 AWG Wire (0.26 mm?2) 26 AWG Wire (0.14 mm~)
Console (302C1) Feet Meters Feet Meters

With Selector Console
Phantom powered 800 244 500 152
Locally powered 5000 1524 3400 1037

Without Selector Console

Phantom powered 1400 427 900 274

Locally powered 5000 1524 3400 1037

Auxiliary Power

The nonessential functions of an attendant console and its optional 26A1 or 24A1
selector console derive power from an auxiliary power source. Provide auxiliary
power for an attendant console through this cable so the console remains fully
operational during short power outages.

=>» NOTE:
Only 1 console can derive auxiliary power from the system and through the
auxiliary cable located in the trunk/auxiliary field.
A console’s maximum distance from its auxiliary power source is:
= 800 feet (244 m) for a 302A1

= 350 feet (107 m) for a 301B1 and 302C1

An attendant console can also derive auxiliary power from:
= Individual 1151A or 1151A2 power supply
= MSP-1 power supply
= 258A-type adapters
= Bulk power supplies such as the 1145A1
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Install Attendant Console — Optional

1. Position the attendant console in the desired location and connect the
modular cord to the information outlet.

2. Install labels per the Attendant Console form and Display Module form
assignments.

3. Install a Digital Line circuit pack in the assigned carrier slot (if required).

4. Administer the Attendant Console forms in DEFINITY Enterprise
Communications Server Release 7 Administrator's Guide, 555-233-502.

Hard-Wire Bridging

A CAUTION:

Bridging or paralleling these endpoints can cause electrical damage to the
consoles or cause the circuit pack to remove power from the consoles.

Analog type hard-wire bridging is not allowed for 4-wire (only) DCP endpoints.
This is because hard-wire bridging provides no way of combining the digital
output of 2 bridged DCP sets. Also, a bridged endpoint causes the added load
to degrade the DCP signal.

Dual Wiring of 2-Wire and 4-Wire Endpoints

Do not simultaneously wire a 2-wire and 4-wire endpoint to the same equipment
location in an MDF, even though they connect to different colored wire pairs. The
system uses separate circuit packs to interface 2- and 4-wire endpoints, and
none are capable of interfacing both.

Install 26B1 Selector Console — Optional

1. Connect the supplied 3-foot (0.9 m) D8AC cable to the modular jack on
the bottom of the 26B1 Selector Console.

2. Route the cable to the attendant console and connect to the DXS/BLF
jack.

3. Attach labels according to the Attendant Console form.

4. Administer the console using DEFINITY Enterprise Communications
Server Release 7 Administrator's Guide, 555-233-502.
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Connect External Alarms and
Auxiliary Connections

=> NOTE:
The AUX connector is part of the Processor Interface cable assembly (J1). When the
wiring and administration is complete, give these wiring records to your Customer
System Administrator for troubleshooting purposes.

Alarm Input

Alarms can be generated on adjunct equipment, sent to the DEFINITY ONE
system, and recorded and reported as “external alarms.”

A CAUTION:
Pins 26 and 1 on the AUX connector are dedicated to the UPS alarm

input. Using these pins for other alarm inputs will cause the
DEFINITY ONE system to reset.

1. Connect 1 major alarm input wire pair and 1 minor alarm input wire pair to
the auxiliary field from the AUX connector (J1 on Processor Interface
Cable). See Table 1-7 and[Figure 1-27]on page 1-53.

Table 1-7. Alarm Inputs at AUX Connector

Alarm Input Type | Color AUX Connector

Minor White-Blue AP1 (Pin 27)
Blue-White Ground (Pin 2)

Major (UPS) White-Orange AP2 (Pin 26)
Orange-White Ground (Pin 1)

Alarm Output

The system provides a relay contact closure that can operate a
customer-provided alarm, such as a light or bell. The circuitry and power source
are customer- provided. The alarm device must not exceed a rating of more than
30 VAC RMS or 60 VDC at 0.75 Amps.

1. Connect the external alarm output. See[Table 1-8.

2. Type change system-parameters maintenance and press Enter.
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3. Change the “CPE Alarm Activation Level” field to the desired alarm level
and press Enter.

Table 1-8. Alarm Output at AUX Connector

Alarm Output Type | Color | AUX Connector
EXTALMA Violet-Green (Pin 48)
EXTALMB Green-Violet (Pin 23)

UPS Alarm Connection

)
:

fr—

L
g

cydmonel LIK 042999

Figure Notes

1. Lucent UPS 6. Pin 1, orange-white
2. Z3A2 alarm adapter 7. MDF
3. RJ45 (D8W) cable 8. 25-pair cable

9

. Processor interface cable (AUX
connector)

10. DEFINITY ONE

4. 103A or modular jack

5. Pin 26, white-orange

Figure 1-27. UPS Connection to DEFINITY ONE
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Only 1 emergency transfer power panel and 1 auxiliary power connection is
provided per system.

Connect emergency transfer power and auxiliary power as shown in Table 1-9.
Auxiliary power includes power to an attendant console or adjunct device.

Table 1-9. Emergency Transfer and Auxiliary Power

Power Type Color AUX Connector
Emergency Transfer Black-Blue XFER48 (Pin 36)
Blue-Black Ground (Pin 46)

Adjunct -48 VDC

Brown-Yellow

Yellow-Brown

ACCA48A (Pin 19)
Ground (Pin 44)

Telephone Pin Designations

Table 1-10 provides port circuit pack and telephone pin designations.

Table 1-10. Port Circuit Pack and Telephone Pin Designations

4-wire; 302C1, 8510T BRI
Pin on 8400-Series, 2-wire; 302C1, (with adjunct Z3A1 & Z3A2
Modular | 603E, 9403, 8400-Series, 603E, speaker Analog Station, ADU, Data
Plug 9434 9403, 9410, 9434 phone) Modem Module
1 TXT TXT
2 TXR T TXR
3 PXT TXT R PXT
4 T PXR
5 R PXT
6 PXR TXR PXR
7 -48VDC (-48VDC) (-48VDC)
8 GRD GRD GRD
circuit 4-wire digital 2-wire digital (16 or 24 | 4-wire BRI Analog line (16 Data Line
pack (8 ports) ports) Trunk Side or 24 ports)

PX PBX transmit T Tip (A

>

Terminal transmit R

Ring (B)
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Install the BRI Terminating Resistor

The resistors balance the cable plant between the receiver and the transmitter on
the interface. When using the TN2198 ISDN-BRI 2-Wire U Interface circuit pack,
an NT1 is required. A terminating resistor is always required near the terminal
when the BRI S-type interface circuit pack (TN556 BRI 4-Wire S-NT Line circuit
pack) is used (see #5ESS Switch Integrated Services Digital Network Customer
Premises Planning Guide, 533-700-100).

The resistor is built into the NT1 and can be 1 of 3 values, depending on the
configuration and the distance from the NT1 to the ISDN terminal. The resistor
value is controlled from the NT1. A terminating resistor adapter may be needed
near the terminal and can be placed in the satellite closet or work location.

A CAUTION:

The 440A4 terminating resistor and 110RA1-12 terminating resistor block
are UL listed. Most new installations are the 110RA1-12 terminating resistor
block. The following installation instructions should be observed.

= Never install telephone wiring during a lightning storm.

= Never install telephone jacks in wet locations unless the jack is
specifically designed for wet locations.

» Never touch uninsulated wires or terminals unless the telephone
line has been disconnected at the network interface.

» Use caution when installing or modifying telephone lines.
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Terminating Resistor Adapter

Figure 1-28 shows an 8-pin 440A4 terminating resistor adapter. The adapter has
an 8-wide plug at 1 end, a short cord, and an 8-wide jack at the opposite end.

| R c R c
VW—q VWA—
1 1
2 2
3 3
4 4
o . ; @
6 6
7 7
8 8
r910013 RPY 012098
Figure Notes
1. 8-wide plug 2. 8-wide jack

Figure 1-28. 8-Wide Terminating Resistor Adapter (440A4)
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Closet Mounted (110RA1-12)

The 110RA1-12 terminating resistor block consists of twelve 2-pair circuits and
provides the 100 Ohm termination used for ISDN-BRI circuits.

Figure 1-29 shows the wiring of the 110RA1-12. Three rows of 110D 4-connector
blocks contain resistors and capacitors. The bottom row is designated as the
input row and the top and middle rows are designhated as the output rows. The
circuit assembly is mounted on a standard 110A 100-pair mounting base.

1 2 3 4 45 46 47 48

© |[¢]e]e]¢] — — — — — [(T111|€9

1910014 RPY 012098

Figure Notes
1. Circuit 1 5. Input row “C”

2. Circuit 12 6. Only first circuit shown to all 12
circuits (2APR) per block

7. 110D 4-connector block

3. Output row “A”
4. Output row “B”

Figure 1-29. Terminating Resistor Block (110RA1-12)
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Figure 1-30 shows the wiring connections for the 110RA1-12 terminal block. The
TN556 BRI switch port is terminated to bottom row C.

°
)
¢
¢

& g

TR T1R1

© <

Figure Notes

1. Part of terminating resistor block 7. Basic multi-point option
2. White or purple field 8. 4-pair horizontal cables
3. Part of 4-pair blue field 9. Row “A”
4. From ISDN T-interface circuit 10. Row “B”

(2-pair) 11. Row “C”
5. To ISDN S/T-interface terminals

»

. 2-pair cross-connect

Figure 1-30. Typical Installation of Terminating Resistor Block

For point-to-point wiring, the top row connects to the blue station field. The pair
connects from the 110RA1-12 to the standard 4-pair circuit. Pair 1 from the
110RA1-12 is connected to Pair 1 of the station field, and Pair 2 is connected to
Pair 3 of the station field.

Two terminal basic multi-point applications are accommodated by connecting
row B (output) to the second terminal common to the multi-point circuit.
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Install Multi-Point Adapters

Use multi-point adapters to provide signal fanout of the T-interface. BR851-B or
the 367A perform fanout at the work station. These adapters support more than 1
ISDN terminal per horizontal 4-pair D-inside wire (DIW). To support multiple
horizontal runs, a MDF with multiple common rows performs fanout in the satellite
closet. The 110RA1-12 provides fanout for two horizontal runs and contains the
100 Ohm terminating resistor. Use this for basic multi-point or point-to-point with
terminating resistor in the closet. Other fanout blocks include the 110AB1-025M
and the 110AB1-050M.

BR851-B Adapter (T-Adapter)

The BR851-B supports 2 terminals on 1 multi-point BRI at the work station and is
used to fanout transmission and power. See Figure 1-31.

°=;>87654321

44311322
RTRTRTRT

!'&'&!‘!‘l‘l!
FECCCCCay
W ECCCCEDY.
W ECCCED DY
W ECCOD DY
ST 55657
S 565666
Jl Yo 555555
l 11111111
RTRTRTRT RTRTRTRT
44311322 44311322
87654321 87654321

E r910017 RPY 012098 g

Figure Notes
1. Wire pairs 4. Female

2. Pin numbers 5. T-Type adapter (BR851-B)
3. Modular plug (male)

Figure 1-31. Wiring Diagram of BR851-B
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The 367A adapter provides fanout for up to 7 terminals. See Figure 1-32.

(XX XXX X ]
0000000
0000000
0000000
0000000
([ X X XXX X ]
0000000
| T 0000000 |
87654321 87654321 87654321
Figure Notes
1.Jack 1 3. Jack 8
2. Jack 2 4. 367A adapter

Figure 1-32. Wiring Diagram of 367A Adapter
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Basic Multi-Point Installation Distances

Figure 1-33 provides cabling information for fanout of ISDN-BRI multi-point
installations. In Figure 1-33, the terminating resistor is located in the satellite
closet. All distances assume 24 AWG (0.26 mmz) D-Inside Wire (DIW).

A
\ 4

®

®
o (& ]

inst_dis RPY 012098

Figure Notes

1. S-interface source (TN556) . System cabinet

. Terminating resistor . Terminating endpoint 1

2
3. Satellite closet . Terminating endpoint 2
4

6
7
8
. Maximum distance from S-interface 9. Work location
10

source to work location (1600 feet) . . . :
. Maximum distance from information

(488 m) outlet to terminating endpoint (33
5. Maximum distance from satellite feet) (10 m)

closet to work location (250 feet) .

(76 m) 11. Information outlet

Figure 1-33. Basic Multi-point with One Work Location
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Install Off-Premises Station Wiring

The cabling for off-premises stations is provided by the local telephone company.
These stations can appear on any of the RJ21X network interfaces provided for
the CO trunks.

A CAUTION:
Use only an FCC-approved (or equivalent) analog type telephone (such as
a 2500-type) as an off-premises station. The TN746B and TN2183 Analog
Line circuit packs can be connected to off-premises stations.

1. Install an A25D cable between the RJI21X network interface and a sneak
fuse panel.

2. Atthe MDF, connect jumper wires between 1 row/connecting block in the
green field and up to 3 rows/connecting blocks in the purple field to
concentrate the analog line pairs.

3. Connect an A25D cable between the sneak fuse panel and the terminal
block connector associated with the green row in Step 2.

4. Install a green label on the terminal block to identify the remote location.

5. Administer per DEFINITY Enterprise Communications Server Release 7
Administrator’'s Guide, 555-233-502.

Install Off-Premises or Out-of-Building Stations

Out-of-building campus stations are those telephones not physically located in
the same building as the equipment room but are located on the same property.

Analog Off-Premises Stations

Figure 1-34|shows the connections for 1 to 8 off-premises analog telephones.
Only analog telephones connected to TN742, TN746B, TN2183, or TN769
Analog Line circuit packs can be installed out-of-building.

The maximum distance from the system cabinet to the out-of-building voice
terminal is 6000 feet (1828.8 meters) using 24 AWG (0.26 mm2) wire.
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crdfobt RPY 012398

Figure Notes

1. Locally engineered cables 7. Part of MDF
2. Out-of-building wiring 8. Station side (white field)
3. Multi-pair protector units (primary 9. System side (purple field)

protectors with heat coils or equivalent
with sneak current protection)
11. To analog line circuit pack

4. 356A adapter (TN2183, TN769, TN742, or
5. B25A cable TN7468B)

6. Out-of-building analog telephones

10. Cross-connect jumpers

Figure 1-34. Connections for 1 to 8 Out-of-Building Analog Telephones
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Figure 1-35 shows the connections for up to 24 off-premises analog telephones.
Concentrations of analog line pairs are used at both buildings to minimize the
off-premises wiring required. At the MDF, jumpers must be connected between 1
row/connecting block in the white field and up to 3 rows/connecting blocks in the
purple field. At the station location, a WP-90929, List 1 Concentrator Cable is
used. There are 8 station appearances on each of the 3 fingers of the
concentrator cable.

|
Y

—)
[
1]

tc—)
B oom
a

tc—J
BB | | BB
0

tc—2)
s
0

S ® S O o O

\ g
- [O =

=)

i3
| | i =

crdf240 RPY 012398

Figure Notes

1.
2.

o 00~ W

Locally engineered cables 7. Out-of-building analog telephones

Multi-pair protector units (primary 8. Part of MDF
protectors with heat coils or equivalent with 9. Station side (white field)

sneak current protection)
10. System side (purple field)

. B25A cable
. Concentrator cable (WP90929 List 1) 11. Cross-connect jumpers
. 356A adapter 12. To TN2183, TN769, TN742, or

TN746B analog line circuit pack

. Out-of-building wiring

Figure 1-35. Connections to 24 Out-of-Building Telephones
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Circuit Protectors

Carbon block, or equivalent protection is required at both building entrances.
Also sneak current protection is required. Protection can be provided by a 4-type
protector or a 3-type protector plus a separate sneak current protector. The
4-type protector is equipped with a heat coil.

The 4-type protector is the preferred device. For installations not using primary
protection, 4-type protectors should always be used. When the 3-type protector
is already installed, a separate sneak current protector is required. The multi-pair
protector units and the off-premises cabling must be locally engineered.
Connectorized multi-pair protector units (female 25-pair connector) are
recommended. Table 1-11 shows the recommended protectors.

Table 1-11. Analog Line Circuit Protectors

Protectors
Primary Sneak Current
Primary! (with heat coil) Protectors!
3B1A (carbon) 4B1C (carbon) 220029 Fuse
3B1E-W (wide-gap 4B1E-W (wide-gap gas tube) | SCP-1
gas tube)
3C1S (solid state) 4C1S (solid state)

1. The 3-type protectors should only be used if they are already part of the
existing protection system. A sneak current protector is always required when
a 3-type primary protector is used.

The maximum range of out-of-building analog telephones (500-, 2500-, or
7100-types) connected to an analog line circuit pack should be such that the
maximum loop resistance does not exceed 1300 Ohms.

The following voice terminals cannot be installed in an exposed environment:

» 7300-type voice terminals connected to TN762 Hybrid Line circuit packs

» Multi-button Electronic Telephone (MET) sets connected to TN735 MET
Line circuit packs

» Analog telephones connected to TN746 Analog Line circuit packs

Refer to[Table 1-1Jon page 1-4 for circuit protector ordering information
(comcodes).
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Digital Out-of-Building Telephones

Protection is required at both building entrances for digital out-of-building voice
terminals. There are 2 different types of protectors that can be used to protect
digital voice terminals and digital line circuit packs. The 2 protectors to use are
the 4C3S-75 Enhanced protector and the ITW Linx Enhanced Protector. These
units provide primary and sneak current protection. The 4C3S-75 is equipped
with a heat coil for sneak current protection. The ITW Linx is equipped with
replaceable fuses for sneak current protection.

The 4C3S-75 is only used with Vintage 14 or newer TN754 circuit packs. The
4C3S-75 can be used on all vintages of the TN754B circuit packs. The ITW Linx
may be used on all vintages of the TN754 circuit packs. Table 1-12 lists the
approved protectors.

=>» NOTE:
The TN2181 (2-Wire 16 Port Digital Line circuit pack) may not be approved
for some out-of-building uses. Contact your Lucent Technologies
representative for more information.

Table 1-12. Digital Voice Circuit Protectors

Enhanced Primary Protector
Circuit Pack (With Sneak Current Protection)
TN754B/C all vintages 4C3S-75 or ITW Linx
TN2181 4C3S-75 or ITW Linx
TN2224 4C3S-75 or ITW Linx

When possible, all new and reused wiring installations should use blocks that
accept the standard 5-pin plug-in 4C3S-75 protector. However, this may not be
cost-effective in some cases. For these installations, the ITW Linx protector may
be installed. An example of this is where screw-type carbon block protectors (or
other plug-incompatible types) are in place and it is too costly to re-terminate the
outside plant cable on a 5-pin mounting block for only a few out-of-building
terminals.

The ITW Linx Enhanced Protector may be installed in series with existing primary
protection. Note the 4C3S-75 protector cannot be installed in series with other
types of primary protection. It must be installed as the only protection on the line
entering the building. For the 4C3S-75 protector, various 25-, 50-, and 100-pair
protector panels are equipped with 110-type connecting blocks and/or RJ21X
connectors. The ITW Linx Enhanced Protector mounts directly on connecting
blocks and requires a separate ground bar.

The maximum range for out-of-building digital voice terminals is 3400 feet
(1036 m) when using 24 AWG (0.26 mmz) wire and 2200 feet (670 m) when using
26 AWG (0.14 mm2) wire. The range can extend to 5000 feet (1524 m) using 24
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AWG (0.26 mm?) wire or 4000 feet (1219 m) using 26 AWG (0.14 mm?) wire with
the use of a data link protector. The protector is an isolating transformer used to
remove phantom power on the system side and re-introduce it on the terminal
side.

When a protector is used, the voice terminal must be locally powered by an
external power supply or through the AC power cord provided with some of the
7400-type voice terminals. The protector is installed on the equipment side of the
protection in both buildings.

Refer to [Table 1-1Jon page 1-4 for circuit protector and data link protector
comcodes.

Install Emergency Transfer Unit and
Associated Telephones

=>» NOTE:
Install only 1 emergency transfer power panel per system.

Emergency transfer capability is provided by an 808A Emergency Transfer Panel
(or equivalent) mounted next to the trunk/auxiliary field. See |Figure 1-36.|Also
refer to[Table 1-9on page 1-54 for the pinout of the AUX (J1) connector.

Use analog telephones for emergency transfer. The 500 and 2500 type
telephones can also be used as normal extensions. Emergency transfer
capability may be provided on analog CO and Wide Area Telecommunications
Service (WATS) trunks.

The transfer panel provides emergency trunk bypass or power-fail transfer for up
to 5 incoming CO trunk loops to 5 selected station sets. The 808A equipment’s
Ringer Equivalency Number (REN) is 1.0 Amp.

At the MDF, the unit is controlled by a connection to a yellow terminal

row/connecting block in the trunk/auxiliary field. The unit is controlled by -48 VDC
from the EM TRANS RELAY PWR terminals.

Install the Emergency Transfer Panel

The 808A Emergency Transfer Panel is used in the following installation example.

1. Install the transfer panel on any mounting frame in either a vertical or
horizontal position. The housing has ears for screw-mounting and cutouts
for snap-mounting the unit in an 89-type mounting bracket.
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=>» NOTE:

Install the panel so it can be accessed only by authorized personnel.
The location must meet standard environmental considerations such
as temperature, humidity, and so forth.

2. Verify dial tone is present at each trunk circuit.

N

EMERGENCY
TRANSFER
PANEL

@ POWER

TRUNKITEST SWITCHES

- CIRCUIT
1

2> TRUNK OPTION
Cr= 1| Loop GROUND

3
- CT=12| S™RT START
5

- —

3
s> aom swircres musr e
9 7 THROWN TO ACTIVATE
8 >4 TRUNKOPTION

9
10>-5

|12 TRANSFER TEST SWITCH

- ACTIVATED —— NORMAL
OPERATION

-— —

TRUNK IDENTIFICATION

TRUNK

LINE EXT  — LoC

808A

J
led808a LIK 040896

Figure Notes
1. 808A emergency transfer panel 3. Trunk identification label

2. Circuit start selection switches 4. 25-pair male connector

Figure 1-36. 808A Emergency Transfer Panel



DEFINITY ONE Communications System Release 1.0 Issue 1

Installation and Upgrades 555-233-109 December 1999
1 Install and Cable the Cabinet
Install Emergency Transfer Unit and Associated Telephones 1-69
3. Locate the circuit start selection switches. See|Figure 1-36. These are the

first 10 two-position switches on the left side of the 808A. The switches set
each of the 5 incoming trunk lines to either loop start or ground start. Two
switches are used for each of the 5 circuits; switches 1 and 2 are used for
circuit 1, switches 3 and 4 are used for circuit 2, and so forth. See Table
1-13.

For loop start, set the switches to the left. For ground start, set the
switches to the right.

Table 1-13. Trunk/Test Switches

Switch Circuit

Number Number

1 1

2 1

3 2

4 2

5 3

6 3

7 4

8 4

9 5

10 5

11 Not Used

12 Test Switch
4. Connect a 25-pair cable between the male RJ21 25-pair connector on the

808A and the yellow field on the MDF.|Table 1-14|shows the pinouts.

Make cross-connections for each emergency trunk/emergency station
pair. See [Figure 1-37|and [Figure 1-38.]

. On the trunk identification label at the bottom of the panel, record the trunk

line, extension, and location for each circuit.

. To each voice terminal designated as an emergency terminal, attach a

label identifying it as such. The labels are provided with the unit.
Check the system for normal operation as follows:
a. Place the test switch (switch 12) in NORMAL OPERATION.

b. Ensure the power supply is providing -48 VDC at 80 mA maximum.
The power LED should be ON.
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c. Check wiring connections.

d. Verify there is dial tone on all emergency transfer sets.

Table 1-14. Pin Assignments for 25-Pair Connector on 808A

1-70

Pin Color Designation Connector/Description
26 W-BL TTC1 Tip-PBX Trunk Circuit 1

1 BL-W RTC1 Ring-PBX Trunk Circuit 1
27 W-O TTK1 Tip-CO Trunk Circuit 1

2 o-w RTK1 Ring-CO Trunk Circuit 1

28 W-G TLC1 Tip-PBX Line Port 1

3 G-W RLC1 Ring-PBX Line Port 1

29 W-BR TST1 Tip-Emergency Terminal 1
4 BR-W RST1 Ring-Emergency Terminal 1
30 W-S TTC2 Tip-PBX Trunk Circuit 2

5 S-W RTC2 Ring-PBX Trunk Circuit 2
31 R-BL TTK2 Tip-CO Trunk Circuit 2

6 BL-R RTK2 Ring-CO Trunk Circuit 2

32 R-O TLC2 Tip-PBX Line Port 2

7 O-R RLC2 Ring-PBX Line Port 2

33 R-G TST2 Tip-Emergency Terminal 2
8 G-R RST2 Ring-Emergency Terminal 2
34 R-BR TTC3 Tip-PBX Trunk Circuit 3

9 BR-R RTC3 Ring-PBX Trunk Circuit 3

35 R-S TTK3 Tip-CO Trunk Circuit 3

10 SR RTK3 Ring-CO Line Port 3

36 BK-BL TLC3 Tip-PBX Line Port 3

11 BL-BK RLC3 Ring-PBX Line Port 3

37 BK-O TST3 Tip-Emergency Terminal 3
12 O-BK RST3 Ring-Emergency Terminal 3
38 BK-G TTC4 Tip-PBX Trunk Circuit 4

13 G-BK RTC4 Ring-PBX Trunk Circuit 4
39 BK-BR TTK4 Tip-CO Trunk Circuit 4

14 BR-BK RTK4 Ring-CO Trunk Circuit 4

Continued onlnext page
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Table 1-14. Pin Assignments for 25-Pair Connector on 808A — Continued

Pin Color Designation Connector/Description
40 BK-S TLC4 Tip-PBX Line Port 4

15 S-BK RLC4 Ring-PBX Line Port 4

41 Y-BL TST4 Tip-Emergency Terminal 4
16 BL-Y RST4 Ring-Emergency Terminal 4
42 Y-O TTC5 Tip-PBX Trunk Circuit 5

17 o-Y RTC5 Ring-PBX Trunk Circuit 5
43 Y-G TTK5 Tip-CO Trunk Circuit 5

18 G-Y RTK5 Ring-CO Trunk Circuit 5

44 Y-BR TLCS Tip-PBX Line Port 5

19 BR-Y RLC5 Ring-PBX Line Port 5

45 Y-S TST5 Tip-Emergency Terminal 5
20 SY RST5 Ring-Emergency Terminal 5
46 V-BL CcoM1 Common 1 Relay Contact
21 BL-V NO1 Normally Open 1 Contact
47 V-O NC2 Normally Closed 2 Contact
22 o-v NC1 Normally Closed 1 Contact
48 V-G COM2 Common 2 Relay Contact
23 G-V NO2 Normally Open 2 Contact
49 V-BR

24 BR-V

50 V-S GRD Ground From PBX

25 SV -48PX -48V from Alarm Panel (AUX Cable)

9. Check the system for emergency transfer operation as follows:
a. Place the test switch (switch 12) in the ACTIVATED position.
b. The power LED should be OFF.

c. Verify there is CO dial tone for all emergency transfer sets.
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10. Connect the 808A to the MDF with a B25A or A25B cable. Figure 1-37

shows the connections at the trunk/auxiliary field for a telephone used only
for emergency transfer.
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Figure Notes

1. To network interface circuitry 4. To power transfer unit

2. To CO trunk circuit pack 5. To control carrier AUX

3. To blue or white station distribution field connector

Figure 1-37. Connections for Telephone Used for Emergency Transfer
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Figure 1-38 shows the connections at the trunk/auxiliary field for a telephone
used for emergency transfer and as a normal extension.
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Figure Notes

1. To network interface facility 4. To CO trunk circuit pack
2. To blue or white station field 5. To power transfer unit
3. To analog line circuit pack 6. To control carrier AUX connector

Figure 1-38. Connections for Telephone Used for Emergency Transfer and as
Normal Extension
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Install Telephone for Power Transfer Unit

Trunk/Auxiliary Field: Telephone Used Only for Emergency Transfer

1.

Connect a pair of wires between the -48V and GRD terminals on the yellow
emergency transfer row/connecting block and the EM TRANS RELAY PWR
terminal. See|Figure 1-37.

Connect CO trunk leads from the purple field to the TC terminals on the
yellow emergency transfer row/connecting block for each trunk.

. Connect CO trunk leads from the green field to the TK terminals on the

yellow emergency transfer row/connecting block for each trunk.

Connect the ST leads on the yellow emergency transfer row/connecting
block for each emergency transfer telephone to the ST terminal
appearance in the yellow trunk/auxiliary field. The ST terminal leads
should be terminated on the following pairs: 1, 4, 7, 10, 13, 16, 19, or 22
(the first pair of any 3-pair group).

Connect the ST leads from the terminal in Step 4 to the assigned terminal
in the blue or white station distribution field.

Trunk/Auxiliary Field: Telephone Used for Emergency Transfer and as
Normal Extension

1.

Connect a pair of wires between the -48V and GRD terminals on the yellow
emergency transfer row/connecting block to the EM TRANS RELAY PWR
terminal. See|Figure 1-38.

Connect CO trunk leads from the purple field to the TC terminals on the
yellow emergency transfer row/connecting block for each trunk.

Connect CO trunk leads from the green field to the TK terminals on the
yellow emergency transfer row/connecting block for each trunk.

Connect telephone leads from the purple analog line board row/
connecting block to the LC terminals on the yellow emergency transfer
row/connecting block for each telephone.

Connect ST leads on the yellow emergency transfer row/connecting block
for each emergency transfer telephone to the ST terminal appearance in
the purple trunk/auxiliary field.

Connect the ST leads from the terminal in Step 5 to the assigned terminal
in the blue or white station distribution field.

Telephone Installation

1.
2.

Connect the telephone to the information outlet.

Install patch cords/jumper wires between the system side and the station
side of the station distribution field on the MDF.
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Connect Modem to Telephone
Network

1. Cross-connect the network jack on the modem to the network interface
(via a 103A or modular wall jack). See Table 1-15 for the pinout.

Table 1-15. Pinout of Network Jack

Pin Number | Signal
1 Unused
2 Tip

3 Ring

4 Unused

33.6 Faxmodem

¢

Sportster

0

,_I
HFEEEEEE

O

]
OFF . on

modmcabl KLC 110397

Figure Notes

1. Pin 1 of network jack 2. Modem

Figure 1-39. Network Jack on U.S. Robotics Modem
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Connect Modem

The U.S. Robotics® external modem is the recommended external modem for
Release 1.0. A locally obtained, type-approved external modem may be used.
Contact your Lucent Technologies representative for information.

If any other Robotics modem is installed, refer to the setup instructions provided
with that modem.

External Modem Option Settings

Use Table 1-16 to check or set the 8 option switches on the U.S. Robotics

modem.

Table 1-16. U.S. Robotics Model External Modem Switch Settings

Switch | Setting Function

1 OFF (Up) DTR (Data Terminal Ready) override

2 OFF (Up) Verbal result codes (text-formatted feedback characters such as connected
or no carrier)

3 ON (Down) | Enable result codes

4 OFF (Up) Displays keyboard commands (local echo)

5 OFF (Up) Sets auto answer

6 OFF (Up) CD (Carrier Detect) override (modem sends CD signhal on connect, drops
CD on disconnect)

7 OFF (Up) Power-on and ATZ reset software defaults (loads Y or Y1 configuration from
NVRAM)

8 ON (Down) | AT (Attention) command set recognition (enables recognition, smart mode)

The modem is pre-configured and should work correctly. See|“Modem Setup and|

|Administration”i on page 9-6 for procedures on how to verify that the correct

defaults are set; how to configure the modem, if necessary; and how to test the

modem.
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Set Neon Voltage to Prevent Ring Ping

=> NOTE:
If the ringing option is set to 50 Hz, neon voltage is not available. If 25 Hz is selected,
the maximum voltage is 120 volts. Refer to[“Set Ringing Option”|on page 1-38.

=>» NOTE:
Set the control to OFF if there are no neon message waiting lamps or if LED message
lamps are used. See Figure 1-40.

} | —
Si didmt1 KLC 053097

Figure 1-40. Setting the Neon Voltage

1. Call a telephone with a neon message indicator and leave a message.

2. Check for “ring ping” (single ring pulse) each time the lamp flashes
(approximately every 3 seconds).

3. Adjust the control clockwise in small increments until the ring ping stops.
Be sure that the message lamp still lights when the adjustment is finished.
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Complete Installation

1. Enter logoff and press Enter to prevent unauthorized changes to data.

2. Set the left and right doors onto the hinge pins and close the doors. The
doors must be closed to prevent EMI emissions. Tighten the door screws.

3. Set the right cover panel onto the right panel and secure. Do not use
force.

View LEDs to Determine Power and
Fan Alarm State

Use the LEDs on the front of each power unit to determine its state.

1. Table 1-17 shows the LED and alarm conditions. Ring voltage and neon
bus output do not activate alarm status.

Table 1-17. LED and Alarm Conditions

Condition LED Status | Alarm State | Fan Alarm

Normal Red off open high
Yellow on

No Input Power Red off closed open
Yellow off

One or More DC Red on closed no state

Outputs Present Yellow off

Fan Alarm Red on closed low
Yellow off
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Connectivity and Access to
DEFINITY ONE

This chapter provides background information on connectivity and access. Its
purpose is to aide understanding and implementation of subsequent chapters.
There are no installation procedures in this chapter.

This chapter is organized as follows:
=> NOTE:

Physical installation connections are primarily made via PCMCIA. Other
connections are alternate methods shown for completeness.

[“Physical Connections” on page 2-2|

— [“Via a PCMCIA Ethernet (NIC) Network Connection” on page 2-2|

— [“Via Local Monitor/Mouse/Keyboard” on page 2-2|
— [“Via RAS (Modem) Dial Up” on page 2-3|

— [“Via Customer LAN” on page 2-7|

The following access methods are based on the task and/or situation:

[‘Access Methods” on page 2-8|

— [“Via a Telnet Session” on page 2-8|

— [“Via a Web Browser Session” on page 2-10|
— [“Via pcANYWHERE” on page 2-13|

« [‘System Administration/DEFINITY Site Administration (DSA)” on page]
2-17

[“DEFINITY ONE Lucent Personnel Logins” on page 2-19|
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This chapter first shows the procedures for physical connection to DEFINITY
ONE. Once you are physically connected to DEFINITY ONE, you must access
the system. Several ways to access the system are provided.

(See for a tear-out “cheat sheet” detailing physical connection and
access methods, and login information.)

=>» NOTE:
Detailed descriptions of the operation of the Microsoft Windows operating
system and environments are beyond the scope of this document. Please
refer to your Microsoft documentation for details concerning the
Windows 95/98 and Windows NT systems.

Physical Connections

Via a PCMCIA Ethernet (NIC)
Network Connection

Follow the procedure, [‘Connect the Laptop Computer to DEFINITY ONE”|on
page C-2, in Appendix C, “Miscellaneous Procedures”. PCMCIA is the preferred
procedure for making the physical connection.

Via Local
Monitor/Mouse/Keyboard

This access method is used when plugging the monitor into DEFINITY ONE
making it look like a PC. The processor interface cable is on slot 2 of DEFINITY
ONE. Customers have their own monitor/mouse/keyboard setup.

1. Plug in the monitor to the processor interface on the back of DEFINITY
ONE.

2. Plug in the mouse to the processor interface on the back of DEFINITY
ONE.

3. Plug in the keyboard to the processor interface on the back of DEFINITY
ONE.

=>» NOTE:
If these devices are plugged in while the system is running, you must
reboot so that the system will recognize these peripherals. After the first
time, they are hot pluggable.

After entering your login and password, you receive the DEFINITY ONE desktop.
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This connection method is used by the technician, INADS, or the customer to dial
in remotely using a modem. On DEFINITY ONE, the Windows NT Remote Access
Subsystem (RAS) is listening for incoming calls from COM1, to which a modem is
connected. Setting up this connection from a Services laptop computer is a
standard Windows NT dial up networking operation and is illustrated in the

following procedure.

1. On the laptop computer, double click My Computer.

2. Double click Dial Up Networking.

A screen similar to the following appears:

B2 Dial-Up Networking

J File  Edit “iew Go Fawontes Connections Help
G = ! 2 | ¥
Hiact Earard Up | Create {irjat | Cut
J Address ;E Dial-Up Metworking :J

drgaurd

| |

|2 object(s]

iz

=—>» NOTE:

If you have not already created a connection icon for DEFINITY ONE, do

the following:
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1. Double click on “Make New Connection”.

Make Hew Connection

Twpe a name far the computer pau are dialing:

!Definit_l,lEl =]

Select a modem:

todenn of Xircon Ethernet+toden [CEM 52

LConfigure. ..

< Blach I Hest = I Cancel |

2. Enter the name of the computer you are dialing (be sure to select
the appropriate modem).

3. Click Next.

4. Enter the area code and phone number of the system you are
calling, then click Next.

Make New Connection

Type the phone number for the computer pou want ko call:

Area code; T elephone nurmber;
EEIIEE B EEHEE:

Countr code:
!Llniteu:l States of Amernica [1] j
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5. Click Finish. Your new icon will appear in the Dial-Up Networking
screen.

Make New Connection

You have successfully created a new Dial-Up Metworking
connection called:

Click Finizh to zave it in your Dial-lp Mebworking folder.
Double-click it to connect,

To edit thiz connection later, click it, click the File menu
and then click Properties.

< Back I Finizh I Cancel

3. Double click the machine name to which dial up networking has been
administered. For these example screen shots, the machine name is
“estonia”.

A screen similar to the following appears:

=+ Connect To [ 7] ’

Uzer name: ITEISEICCESS

Pazzwaord: I

™| Save passwend

Phone pumber; IEDE” B

Dialing from: DR Lab ~| Dil F'r-:uperties...l
Connect I Cancel |
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The user name and password set up on this screen must be rasaccess
with the appropriate password. Note that the password will be the same
for each DEFINITY system being contacted. Click Connect.

4. A screen similar to the following appears.

Comect g

Enter a uzer name and passward with access to the
rernote network, domain.

Lser name: Irasaccess
Password; I’“"“‘"“"1
Domair: I

[T Save pazsword

s I Cancel

This is a prompt for a network password that is not needed unless disks
will be mounted, etc. Leave the domain entry blank and click OK.

5. Click Connect.

E
X

=+ Connecting to Estoma

Status: Dialing... Cancel |

This popup screen indicates that the laptop is trying to dial the DEFINITY
ONE server.
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After a connection is established, a screen similar to the following
appears:

Connection Established [ 7] |

You are connected to Eztonia.

To digconnect or bo view gtatus information,

double-click the dial-up icon in the status area ‘ tﬁ % '| 245 FIM |

of the tazkhar.

“You can alzo double-click the connection icon |2 )

it the Dial-Up Metwarking folder. E i

[ Do not show this dialog box in the future.

tore Details...

This indicates that the dial up connection to the DEFINITY ONE system is
established and the laptop has joined the DEFINITY ONE LAN.

Once the dial up connection is established, the caller must use one of the
access methods. See[‘Access Methods”[on page 2-8.

Via Customer LAN

It is up to the customer to install their own LAN. The customer’s LAN connects to
the ethernet jack of the processor interface cable. See[*Administer Customer’s|
[CAN Interface” on page 3-10 to configure DEFINITY ONE as a node on the
customer’s network.
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Access Methods

Via a Telnet Session

This access method is used by Lucent technicians to:
» register DEFINITY ONE with INADS
» activate license files
» execute GAS commands from a bash shell
» access DEFINITY ONE SAT session
» set up the IP address for DEFINITY ONE using setip command

See|Appendix C, “Connect to SAT Session via Telnet” for{information on
connecting to SAT via Telnet.

=>» NOTE:
The IP address will be different depending on the type of physical

connection established. Refer to the [Chapter HJ“Installer's Connectivity

Quick Reference Tear-Out Sheet”.

1. On the laptop, click Start > Run from the Windows task bar. The Run

dialog box displays.

Hun [ 7] i
s==3l  Type the name of a pragram, folder, or document, and
3 “whindows will oper it for pou.
Open:  |telnet 192.11.136 =]

¥ | Buriin Separate Memon Space

0k ! Cancel J Browse. .. J

2. Entertel net {DEFINITY ONE | P Address}. Click OK.

A Telnet session will open on your desktop.
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=>» NOTE:

At this point, there are two different scenarios depending on whether the
license file has already been installed.

a. If there is no license file, you will be prompted for your login and

password. The only valid login is lucent3. Use the appropriate
password and continue to step 3.

Telnet - estonia

LConnect  Edit Temminal Help

Login: Tucents
rassword: |

b. If the license file has been installed, you will receive a challenge

response instead of a password prompt as shown in the figures
below. Use any valid Lucent login. See['DEFINITY ONE Lucent|

[Personnel Logins”|on page 2-19 for a list of valid logins. Continue to
step 3.

E Telnet - estonia

LConnect  Edit Teminal Help

Login: Tucent3

Challenge: 080-5703 Product ID:7000000000
response: I

elnet - estonia

LConnect Edit Teminal Help

Login: Tucents

Challenge: 080-5703 Product ID:7000000000
Response: 4654430

Erter Command:
[audix | bash | and | definity | help | exit]
Lac=>i
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3. Enter your User Name and Password at the prompts. Once the Lucent
Access Control (LAC) process accepts your inputs, you will be admitted
into the system.

4. Enter a command to continue.

¥ Telnet - "Wind5

Connect Edit Teminal Help

Login: Tucent3
Challenge: 183-9616
RESpONSE: 2697369
Erter Command:
Laudix | bash | cmd | definity | help | exit]

Lac =

Via a Web Browser Session

Customers or Lucent personnel can use this method of access to DEFINITY ONE
(Windows NT or Windows 95 on their PC) to:

=« administer DEFINITY and AUDIX
= backup and restore
= shut down the system
= activate and stop pcANYWHERE
= download DSA and Message Manager
The software can be downloaded to the technician’s laptop or a computer on the

customer’s network. The web browser provides a single point from which to start
administration activity.

You can use the web browser interface once a physical connection is
established.

1. Open your web browser.
2. Verify that you are not using a proxy server:

= Ifyou are using Netscape, click Edit > Preferences > Advanced >
Proxies and make sure that Direct Connection to the Internet is
checked.

= If you are using Internet Explorer, click View > Internet Options >
Connection and make sure that Bypass Proxy Server for Local
(Intranet) Addresses is checked.
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3. Type http:// <ip address> in the address area of the web browser. See
[Appendix HJ “Installer's Connectivity Quick Reference Tear-Out Sheet”.

The ProductName home page is displayed.

Lucent Technologles @
Beil Labs Innowat o

DEFINITY ONE™ Communications Sysfem

The singie solution for
your smaii business needs.

Home

Administer
1

System DeriniTy ONE provides you with
a high functionality, cost
effective system enabling you to
meet your current business
challenges head on while
providing the infrastructure to
bridge you to future
opportunities.

User Services

4. Click Administer System.
You receive a screen similar to the following:
Uzername and Password Required

Enter uzername for august.dr.lucent. com at
auguzt.dr lucent. com;

Uszer Mame: ||

Pazzword: |

Ok, I Cancel

5. Type your user name and password. Click OK.
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6. You receive the following screen:

You receive a Notice screen similar to the following:

NOTICE:
By uze of this system, you accept the terms and condittons of the lcense
Home agreements for all third party software included with this product. Faiure to
comply with these agreements could result in legal action by the third party
Administer vendor(s).
System
Thiz product 15 designed for the use of authonized Lucent Technologies products
User Services only. Use of this system for any other third party applications is strictly prohubited
annd will result in the nullification of Lucent Technologies warranty and post
Download warranty obligations.

Software

Thiz system is restricted to authorized users for legitimate business purposes.

Tnauthorized access 15 a criminal wiolation of the law. Copyright (o) 1992 -
Lucent Technologies UTnpublished & Mot for Publication

[T Don't show this message again

Continue |

Lucent Technologles @
BaellLabs Innowations -

T T e

y

LU VSR —

7. After reading the screen, click Continue.

Once permissions have been granted, you are able to navigate freely
through the system and you receive the following screen:

System Administration

= DEFINITY ECS on Bosnia . The first two links will worke only

o Tntuity AUDTE on Bosnia ' you have already matalled
Hirie = Default AUDEE Settings DEFINITY Site Administration
YL o AUDI Metworlong OfL FOoUr Cotnputer.
Administer .
S System MMaintenance Click on the
System. aBackup & Restore. ) Devwnload Saftwars link
User Services o Shutdewn or Bestart Bosma at the 1eft to install

Remote Control - polnywhere DEFINITY Site Administration.
Download o Start Host Service on Bosma
Software o Stop Host Zervice on Bosnia

o start Java Client on your computer

Lucent Technologles @
BaellLabs Innowations -
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Via pcANYWHERE

The following procedures describe how to start pcANYWHERE® on DEFINITY
ONE and how to start a client session from the laptop computer.

A CAUTION:
Be certain to turn off p)cANYWHERE when done.

Start the pcANYWHERE Application on
DEFINITY ONE

The customer or Lucent personnel uses pcANYWHERE whenever direct access
to Windows NT desktop on DEFINITY ONE is required for such actions as

= Mmapping drives

» accessing NT operations

» upgrading software

In order to access pcANYWHERE:

1. Bring up your browser (Netscape or Internet Explorer) and verify that you
are not using a proxy server:

» If you are using Netscape, click Edit > Preferences > Advanced >
Proxies and make sure that Direct Connection to the Internet is
checked.

» If you are using Internet Explorer, click View > Internet Options >
Connection and make sure that Bypass Proxy Server for Local
(Intranet) Addresses is checked.

2. In the browser window, type:
http://<IP address>
You receive the DEFINITY ONE home page.



DEFINITY ONE Communications System Release 1.0 Issue 1

Installation and Upgrades 555-233-109 December 1999
2 Connectivity and Access to DEFINITY ONE
Access Methods 2-14

Lucent Technologles @
Beil Labs Innowat o

DEFINITY ONE™ Communications Sysfem

The singie solution for
your smaii business needs.

Home

Administer
System

DeriniTy ONE provides you with
a high functionality, cost
effective system enabling you to
meet your current business
challenges head on while
providing the infrastructure to
bridge you to future
opportunities.

User Services

3. Click Administer System in the left pane.
You will be prompted for a login and password.
4. Use lucent3 as the login and type the appropriate password.

5. On the resulting administration screen, click Start Host Service to activate
the pcANYWHERE host.

=—>» NOTE:
This can also be accomplished through the pcANYWHERE GAS

command in a bash shell. See[Appendix G]“GAS Commands in the

bash shell”.
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Start a pcANYWHERE Client Session from
the Laptop Computer

=>» NOTE:
There are two ways to start a pcANYWHERE client session. If
pcANYWHERE is installed on the laptop, use this procedure.

=>» NOTE:
If you don't have pcANYWHERE on your laptop computer, you can use
pcANYWHERE through the Java client provided through the web interface.
See the next procedure, [‘Start a pcANYWHERE Java Client Session Via the|

[Web Browser]on page 2-16.
1. Click Start > Programs > pcANYWHERE.

2. Within pcANYWHERE, if you have a client icon for DEFINITY ONE, double
click this icon. Otherwise create one as follows:

a. Onthe pcANYWHERE screen, click Remote Control.
b. Click Add Remote Control Item.

c. Give the new remote control item a unigue name.

=>» NOTE:
Once this icon is created, it can be used to connect to any
DEFINITY ONE, so a generic name is best.
d. Click Next.
e. Select tcp/ip as the connection device.
f. In the machine name field, type <IP address>.
g. Click Next.
=>» NOTE:
You may check the Automatically begin remote session
upon wizard completion box if you want to bring up the
session as you exit the wizard.
h. Click Finish.

i. If you did not check the box in step g, double click the newly
created icon.

A connection to DEFINITY will be established.

j- When prompted for a login ID use lucent3.
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k. Leave the domain entry blank.
I. When prompted for a password, enter the appropriate password.

The Windows NT desktop of the DEFINITY ONE system will be
displayed on the laptop.

When using pcANYWHERE, the Windows NT desktop overlays the
Windows 95 desktop, it is sometimes difficult to know which
desktop screen is being referenced. For example, to access the
Start menu of the laptop’s Windows 95 desktop, you may have to
scroll the Windows NT desktop up or down using the scroll bar on
the right side of the pcANYWHERE screen. You may want to
temporarily reduce the pcANYWHERE screen when access to the
Windows 95 desktop is required.

Start a pcANYWHERE Java Client Session Via
the Web Browser

This is one of the two ways to start a pcANYWHERE Client Session. See the
previous procedure, FStart a pc ANYWHERE Session from the Laptop Computer’]
for the other way.

1. Start your web browser. Refer to the procedure in this chapter, “Start a
Web Browser Session.”

2. Click Start Java Client on your computer.

=>» NOTE:
You do not have to have any pcANYWHERE software loaded on your
PC or laptop. Your web browser needs to be either Netscape
Navigator version 4.1 or later or Internet Explorer version 4.0 or later.
The Java client is known as “pcANYWHERE EXPRESS.”

A license agreement appears.
3. Click Yes.

=>» NOTE:
If you click No to this message or any other message, or if you reject
anything at any time, a connection will not be made. If you click
Back on the web browser window, a screen appears on which other
actions (including attempting to reconnect) can be performed.

A warning that the Java applet is requesting additional privileges may
appear. It is trying to contact the DEFINITY ONE server. If this happens,
click the Grant button. Also click Remember this decision if you do not
want to see this warning again.

A connect window appears, asking you to choose which system to
connect to. Only one TCP/IP host will be shown: <IP address> (unless you
are connected via the customer’s LAN).
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4. Highlight this and click Connect.

If no hosts are shown, the pcANYWHERE server on DEFINITY ONE is
probably not running. If this is the case, make sure that you activated
pcANYWHERE properly. If you are sure that it is running, enter <IP
address> in the Host Name: field and click Connect.

A “Connecting to Host” window appears for a while, and is replaced by a
“Security Dialog” window.

5. Type the Login Name and Password. Use lucent3 and its password.

Another “Connecting to Host” window appears for a while and then the
web browser window contains a view of the DEFINITY ONE’s main
console screen.

The screen will probably be larger than the web browser window and so
scroll bars will show and can be used to look at different parts. The Full
Screen icon in the top toolbar can be clicked and the DEFINITY ONE
screen becomes as large as the PC or laptop’s screen and scroll bars are
no longer needed. When this is done, the toolbar is hidden, and the right
arrow button in the upper left corner can be clicked to display the toolbar
again.

A WARNING:
Changing the window size of your web browser window (by
dragging a corner or maximizing) or going to other links with that
window will either disconnect the session or attempt to run a new
session. Use only the controls on the pcANYWHERE EXPRESS
toolbar until you are ready to disconnect.

=—>» NOTE:

To continue to use the web browser while you are connected through
pcANYWHERE EXPRESS, use the web browser’'s new window
feature.

6. Click the End Session icon to cause a confirmation window to appear.

7. Click “Yes” to disconnect from DEFINITY ONE and allow the web browser
window to be used again.

System Administration/DEFINITY Site
Administration (DSA)

DSA provides standard Windows look and feel for performing basic switch
administration. This includes wizards, tabbed windows, menus, and dockable
windows. Customers who use DSA may administer telecommunications
equipment as only a portion of their job responsibilities, and few users will be
expert users.
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DSA offers customers a graphically-enhanced command line interface (called
the Graphically Enhanced DEFINITY Interface, or GEDI) and a terminal emulation

mode for SAT administration.

Commands available in the DEFINITY ONE system are accessible from the DSA
application. Once the application is connected to the switch, commands can be
entered on the command line in a similar way to using the SAT screen, or
commands can be selected from the command lists appearing in the left frame
of the screen, as shown in the screen below.

I’ DEFINITY Site Administration - con

File Edit Yiew Tool: Window Help

LI DEFINITY Site Administration - conl
File Edit Wiew Tools Window Help

H| lEex] EE &l (=2 Es][EE e
= =l

General
& Start GEDI
“E add User

#% Change Uzer name

= Add Bridged Appearance
¢ Browse Dial Ranges
& Browse Stations

T Browse Unuzed Ports

E Find Unuzed E stenzsion

&% Print Button Labels

Advanced

Add Spztem

t‘*‘i Tasks |"E Tree I

@ Workzpace

«

EIE

{E] Button Labels

contny test switch

-] Abbreviated Dialing
& Call Center

-] Coverage

-3 Groups

- Metwork

-] Parameters

-] Station

-] Status

=] System

----- [#l change cos

----- [ change dialplan

----- [®] change feature-access-cr
----- ] ligt authorization-cods
----- [#] ligt cor

----- [#] list extension-type

----- [#] list logins

----- [#] zettime

% Tasks B Tree

Use the Help key for a list of options.

Click the Help menu for help with DSA. For further information regarding the
operation of the DSA application, refer to['System Administration/DEFINITY Site|

[Administration (DSA)”|on page 2-17
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DEFINITY ONE Lucent Personnel

Logins

These are the DEFINITY ONE logins for Lucent personnel. See [‘Enable Customer|
[Logins”|on page 3-5 for further information on logins.

December 1999

Logins to Enter System Logins to Enter DEFINITY | Logins to Enter AUDIX
lucentl dinit atsc

lucent2 dinads acraft

lucent3 dcraft acraft

= Each row of logins has the same password. For example, the lucentl,

dinit, and atsc logins all have the same password.

= The lucent logins are used for web browser and pcANYWHERE access.

= Alllogins can be used for Telnet access.

= The d and alogins (columns 2 and 3) are used for DSA access.




DEFINITY ONE Communications System Release 1.0 Issue 1
Installation and Upgrades 555-233-109 December 1999

2 Connectivity and Access to DEFINITY ONE
DEFINITY ONE Lucent Personnel Logins 2-20



DEFINITY ONE Communications System Release 1.0 Issue 1
Installation and Upgrades 555-233-109 December 1999

3 System Initialization
3-1

System Initialization

This chapter provides the tasks needed to initialize the DEFINITY ONE system.
This chapter is organized as follows:

=« [“Power Up and Observe LEDs” on page 3-2|
= [“Connect the Laptop Computer to DEFINITY ONE” on page 3-2|

=« [“Use the setip Command’” on page 3-2|

=« [“Start a Telnet Session” on page 3-2|

= [“Verify the Software Version Number” on page 3-2|

=« [“Determine the Serial Number” on page 3-3|

= [“Obtaining a License File” on page 3-3|

= [|‘Resolve Alarms” on page 3-4|

=« [“Place a Test Call” on page 3-4|

= [|“Enable Customer Logins” on page 3-5|
« [“Administer DEFINITY ONE” on page 3-9|
— Set the Time/Day on DEFINITY ONE

— Check System Status from bash
— DEFINITY Commands
— Modem Set-up

= [|“Set Up Call Accounting” on page 3-12|
« [“Administer DEFINITY for AUDIX Initialization” on page 3-14]
=« [*AUDIX Administration” on page 3-22|

« [|“Download Message Manager and DSA” on page 3-24]
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Power Up and Observe LEDs

See['LED Boot Sequence”|on page E-1.

Connect the Laptop Computer to
DEFINITY ONE

For this procedure, see|‘Connect the Laptop Computer to DEFINITY ONE"|on
page C-2.

Use the setip Command

For this procedure, see[‘setip Command”|on page G-3.

Start a Telnet Session

Refer to[‘Via a Telnet Session”|on page 2-8 for an explanation of how to start a
Telnet session.

Verify the Software Version Number

1. From the bash command shell, enter swversion and press Enter. This will
display information about the version of software running on the system.
The first line will display a string like:

Rel ease=G3V7c. 00. 0. 030.0
which shows the load number of the software; in this case, load 30.

2. Remove the CD-ROM that was shipped with the system in the door of the
cabinet. Verify that the load number stamped on the CD-ROM matches the
load number found in step 1.

3. Ifthe load numbers match, continue with determining the serial number. If
the load numbers do not match, the system software may need to be
updated before proceeding further. Refer to ['Update Software”|on page
5-1. If the software on the hard drive is newer than the software on the
CD-ROM, then escalate the problem.
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Determine the Serial Number

1. From the bash command prompt, type serialnumber and press Enter.
The serial number is read and displayed.

2. Be sure that the serial number matches the label on the front of the circuit
pack. If it doesn’t match, use the serial number you obtained from the
software mechanism — not from the label.

Obtaining a License File

The procedure required for the installation technician to obtain a license file
includes tasks performed by both the technician and the DEFINITY Database
Administration (DBA) Group at INADS.

1. Connect to the Laptop Computer following the procedure,
[Laptop Computer to DEFINITY ONE”|on page C-2.

2. Establish a Telnet session following the procedure[‘Via a Telnet Session’]
on page 2-8.

3. At the LAC prompt, enter the bash command.

4. Call (800) 248-1234 and press the numbers for the INADS administrator
group (6 and then 2).

5. Ask for the license file by supplying the following information:
— Human Resources ID (HRID)
— DOSS order number
— TN795 serial number
— Installation Location (IL) code
— INADS modem telephone number

You will be assigned a RAS IP address by the database administrator at
INADS.

6. Execute the setip command on DEFINITY ONE by typing setip ras = and
the INADS IP address. See[setip Command’]on page G-3 and [‘Setting]
[the Name of the Switch”|on page C-15.

7. Reboot the system, using the reboot nice command in the bash shell.

8. Notify INADS that the system is ready to be dialed into. The INADS
database group will establish connection to the system and download the
license file.

9. Register adjuncts if applicable. Inform INADS if there are any other
products to be registered, such as DEFLAN, CMS, etc., especially if there
are products that should alarm to INADS. Also tell INADS if there are any
external devices to alarm off the switch.
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The installconfig command takes information from the license file and causes
the system to reboot. After the system starts again, DEFINITY ONE's IDs with new
passwords are set that correspond to what was in the install file. The control file
has the serial number of the TN795 circuit pack and is valid only on this circuit
pack. The control file cannot be used to activate software on any other DEFINITY
ONE system.

The system is ready and all applications on the DEFINITY ONE platform are
automatically started by the Watchdog process.

The DEFINITY ONE Emergency Transfer light goes out.

The installation is complete. Since translations were not removed, they are still
present on the system. A restore is not needed during the normal installation.

Since the system rebooted, the browser and pcANYWHERE connections will be
lost.

Resolve Alarms

Resolve any alarms using DEFINITY ONE Communications Server
Maintenance, 555-233-111.

Check System Status

See|“bash Commands”|on page G-1 for information about bash commands that
are used in installation and administration.

1. Bring up a bash shell.

2. To verify system health, execute d1stat and alarmstat.

Place a Test Call

1. From any telephone connected to a digital line circuit pack, call any
nearby telephone connected to an analog line circuit pack.

2. Verify that the dial tone, ringing pattern, and talk path are acceptable.

3. Place a call through the Central Office (outside call) to any nearby
telephone.

4. Verify that the dial tone, ringing pattern, and talk path are acceptable.
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Enable Customer Logins

This section contains information on

[“Enable AUDIX logins” on page 3-5|

— [net user commands|

[‘Enable Customer Web Logins” on page 3-6|
« [‘Enable DEFINITY Logins” on page 3-6|
|— Forced Password Aging (DEFINITY-Specific)|
|— Logoff Notification (DEFINITY-Specific)|

See[Appendix B, ‘et Up and Use of Customer Logins” for information and
procedures on

= AUDIX logins for customer accounts (vm, sa, browse)
= customer logins to the web interface

= user level logins within DEFINITY

Enable AUDIX logins

See[‘Windows NT Logins for the Customer”|on page B-2 for information on
logins. Appendix B includes further information on the AUDIX logins sa, vm, and
browse, and the uses of each login as well as AUDIX commands accessible to
each login.

net user commands

The net user commands are used to manipulate NT level logins on the DEFINITY
ONE system. These commands are used to administer NT user logins on the
command line rather than through the User Manager. Use of these commands
eliminates the need to use pcANYWHERE to administer user logins.

The net user commands can be used to add new logins, change passwords on
existing logins, or simply to enable/disable existing NT accounts. Execute the
following commands from a bash shell:

To change the password of an existing login,
net user username newpassword

To enable an existing login that is disabled,
net user username /active

The sa, vm, and browse logins already exist. Assign them new passwords and
enable them.
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Enable Customer Web Logins

When the system leaves the factory, the only login that has access to the web
interface is the login NTadmin. The customer may wish to create additional
logins; for example, to access the Message manager. See|'Windows NT Logins|
[for the Customer”]on page B-2.

Enable DEFINITY Logins

Release 1.0 provides enhanced login/password security by adding a security
feature that allows users to define their own logins/passwords and to specify a
set of commands for each login.

= The system allows up to 14 simultaneous connections (logins) to
DEFINITY ONE. (DEFINITY can have 5 connections, AUDIX can have 2
connections, and the rest of the connections are reserved for shell
commands.)

» Each DEFINITY ONE login name can be customized

— Logins must be 3 to 6 alphabetic/numeric characters, or a
combination of both.

— A password must be from 4 to 11 characters in length and contain
at least 1 alphabetic and 1 numeric symbol.

Password aging is an optional feature that the super-user administering the
logins can activate (see below).

=>» NOTE:
If several users are logging in and out at the same time, a user may see the
message: Tr ansi ent command conflict detected; please try

| at er . After the “users” have completed logging in or out, the terminal is
available for use.

Forced Password Aging (DEFINITY-Specific)

= The password for each login can be aged starting with the date the
password was created, or changed, and continuing for a specified
number of days (1 to 99).

» 7 days before the password expiration date, the user is notified that the
password is about to expire at the login prompt.

=  When the password expires the user is required to enter a new password
into the system before logging in.
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» Ifaloginis added or removed, the “Security Measurement” reports are not
updated until the next hourly poll, or a clear measurements
security-violations command is entered.

» Once a non-super-user has changed the password, the user must wait 24
hours to change the password again.

Logoff Notification (DEFINITY-Specific)

Security is enhanced by providing a logoff notification screen to a system
administrator at log off while either the facility test call or remote access features
are still administered. The administrator can be required to acknowledge the
notification before completing the logoff process. Logoff notification is
administered on the Login Administration screen.

Super_User (DEFINITY)

Release 1.0 of DEFINITY ONE is delivered to the customer with one customer
“super-user” login/password defined. The customer is required to administer
additional login/passwords as needed. The super-user login has full customer
permissions and can customize any login created.

Login permissions for a specified login can be set by the super-user to block any

object that may compromise switch security. Up to 40 administration or
maintenance objects commands can be blocked for a specified login id.

Administer Login Command Permissions

Users with super-user permissions can set the permissions of the logins they
create. The Command Permissions Categories form displays fields to which a
user with super-user permissions can give or limit access. These commands are
divided into three categories:

= Common Command
= Administration Commands

» Optional Maintenance Commands

Each of the three main categories have subcategories listed under them that
when set to y give permission to use the command sets associated with that
category. When the Command Permissions Categories form is displayed for a
login, the subcategories fields appear with the fields set to give the login full
permissions for that login type. The super-user administering login permissions
can set any of these field to deny access to a command category for the
specified login. If the super-user making the assignments has full super-user
permissions and would like to limit permissions for a category, the super-user
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can do so by entering y in the Addi ti onal Restricti ons field located under
the Administration Category section of the Command Permissions Categories
form.

For information about login names, login groups, and WEB access rights, see
[Appendix B]“Set Up and Use of Customer Logins”.

The net user commands are used to manipulate NT level logins on the DEFINITY
ONE system. For information about net user commands, see['net user]
[commands”]on page 3-5.

DEFINITY Commands for User Login

DEFINITY commands refer to the set of commands that execute under the
DEFINITY application running on the ProductName system platform and can be
accessed through the SAT terminal emulator or the DEFINITY Site Administration
application.

These commands are grouped into three command categories. Each of the three
command categories has a group of command subcategories listed under them,
and each command subcategory has a list of command objects that the
commands acts on. A super-user can set a user’s permissions to restrict or block
access to any command in these categories. These categories are displayed on
the Command Permissions Categories form.The three main categories are:

» Common Commands
— Display Administrative and Maintenance Data
— System Measurements
» Administration Commands
— Administer Stations
— Administer Trunks
— Additional Restrictions
— Administer Features
— Administer Permissions
» Maintenance Commands
— Maintain Stations
— Maintain Trunks
— Maintain Systems
— Maintain Switch Circuit Packs

— Maintain Process Circuit Packs
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If your password has expired, you see the message:

/ Login: tel nor \

Passwor d:
Your Password has expired, enter a new one.

Reenter Current Password:

New Passwor d:

\ Reent er New Password: /

Figure 3-1. Password Expiration Screen

If your password is within 7 days of the expiration date, you see:

WARNI NG Your password will expire in X days

Administer DEFINITY ONE

DEFINITY ONE Commands

DEFINITY ONE bash commands are useful for administration and installation
tasks. These commands are allowed for the lucent1 login. Refer to[*bash|
[Commands’]on page G-1, and DEFINITY ONE Communications System
Maintenance, 555-233-111 (also on the documentation CD), for information
about these commands.

Set Date/Time/Time Zone (Windows NT)

1. Connect to DEFINITY ONE desktop by following the procedure, —
Monitor/Mouse/Keyboard”{on page 2-2 or ‘{Via a PCMCIA Ethernet (NIC)

Network Connection”{on page 2-2.

2. Click Settings > Control Panel.
You receive the Control Panel screen.
3. Click Date/Time.
You receive the Date/Time Properties screen.
4. Do the following:
a. Select the correct day, month, and year.
1. Goto the Time box.

2. Select the hour using the up and down arrow.
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3. Select the minutes using the up and down arrow.
4. Select AM or PM using the up and down arrow.
The seconds start at the beginning of the minute.
b. Click Time Zone.
1. Select the correct time zone.

If you are in an area that does not go on daylight savings
time, uncheck the box before Automatically adjust clock
for daylight savings change.

Administer Customer’s LAN Interface

It is up to the customer to install their own LAN. The customer’s LAN connects to
the ethernet jack of the processor interface cable. See[‘setip Command”|on
page G-3 for more information on the setip command from the command line
interface. You can also use the Windows NT method to change interface
parameters.

The customer provides:
» [P address
= Subnet mask
» Default gateway

In the event that a customer needs a new IP address, customers can access the
NT desktop via p)cANYWHERE.

Change Customer Options

Refer to DEFINITY Enterprise Communications Server Release 7 Administrator’s
Guide, 555-233-502, to view a sample screen.

The following DEFINITY features are part of the basic software package and do
not require activation. They default to y (yes) on the Optional Features form.

» ARS/AAR Partitioning
» Emergency Access to Attendant
= Service Observing

—>» NOTE:

A lucentl login is required to change customer options. Contact your
regional Customer Software Administrator (CSA) to perform this function.
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1. In a SAT session or DSA window, type change system-parameters
customer-options and press Enter.

2. Using the customer order, enable the optional features purchased by the
customer (as shown by PEC codes on the customer order).

3. Press Enter when finished to submit the form.
4. Log off and then log back in to set the customer option changes.

5. Type save translations.

Set Up Your System

You are now ready to follow procedures to launch your system including:
» Setting up dial plans, feature access codes (FACs), and extension ranges
» Adding extensions for users
» Setting up special features
» Setting up routing

» Assigning and changing users

See[‘Configure DSA”lon page 7-7 to set up DSA.

For more information, see

» DEFINITY System'’s Little Instruction Book for Basic Administration,

555-230-727

» DEFINITY System'’s Little Instruction Book for Advanced Administration,
555-233-712

» DEFINITY System'’s Little Instruction Book for Basic Diagnostics,
555-233-713

» DEFINITY Enterprise Communications Server Release 7 Administrator’'s
Guide, 555-233-502

» The on-line DSA help

Add Translations

1. Refer to DEFINITY Enterprise Communications Server Release 7
Administrator’'s Guide, 555-233-502, to add new terminals.
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Administer Telephone Features

1. Administer these features (DEFINITY Translations, AUDIX Mailboxes, etc.)
per customer order via one of two ways:

a. DSA (web)

DSA must be installed on the laptop or remote PC that is connected
to the system

Connect the PCMCIA card with the laptop or through Remote PC
using the web browser (Windows Explorer or Netscape).

b. Lucent Access Control (LAC) [telnet]
(For direct SAT access without going through DSA)

Telnet to DEFINITY ONE through the LAC to receive the SAT screen.
See the procedure [‘Start a Telnet Session”jon page 3-2.

Set Up Call Accounting

Lucent Technologies provides the following call accounting products to help
reduce telephone expenses, optimize resources, assigh costs, identify abuse,
and clearly understand telephone expenses and convey that understanding to
others:

» Telecommunications Management System (TMS)
» Call Accounting System NT (CAS-NT)
» Call Accounting System (CAS) for Windows

The following is an example of how to set up one of these products, Call
Accounting System (CAS) for Windows, a comprehensive call accounting
package that runs on your PC as a Windows application. It receives Call Detail
Records (CDRs) from a switch on premises and processes the information into
management reports. DEFINITY ONE creates the CDR file where the CDR
records are written the file is put into a directory. CAS for Windows is widely
compatible and requires little maintenance, even while collecting data,
generating reports, and managing remote data collection sites.

CAS for Windows needs access to come across the network to access the file
and directory with full read and write permissions. DEFINITY ONE has to share
the CDR directory with full permissions. This procedure will only work if you have
a keyboard and monitor, pcANYWHERE, or have already mapped your PC to the
drive on DEFINITY ONE.

=>» NOTE:
Depending on the customer’s specific network, the setting up of CAS for
Windows access will vary. See your system/network administrator to ensure
that proper permissions are set up for your file and directory.
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1. Fromthe DEFINITY ONE desktop, right click Start, either locally or through
pcANYWHERE.
2. Click Explore.

10.

11.

12.
13.

14.

15.

You receive the Windows Explorer screen.
Click + by the D drive.

You receive the D drive folders.

Click + by Lucent Data.

You receive the Lucent Data folders.

Click Cdr.

If cdr has been enabled in the switch, you see two files, cdr.out and
cas.in.

The CAS for Windows (CDR Collection device) obtains the CDR records
from cas.in and then removes that file. The current CDR records are
placed in cdr.out. When this file reaches a certain size, the cdr.out file is
renamed cas.in. CAS for Windows obtains those CDR records from cas.in
as more current records are placed in cdr.out.

In order for CAS for Windows to remove cas.in, the CDR folder must be
shared with permissions granted to the user login under which CAS for
Windows is running.

Right click cdr.

Click Properties.

Click Sharing.

You receive the CDR Properties screen.

Click Shared As.

Click Permissions.

You receive the Access Through Shared Permissions screen.
You see that Everyone / Full Control is highlighted.

Click OK.

You receive the Properties screen.

Click Security.

Click Permissions.

You receive the Directory Permissions screen.

Click Add.

You receive the Add Users and Groups screen and see the groups.

Click Show Users.
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16. Highlight the login under which CAS for Windows will be running. (See the
LAN administrator if you do not know the user.)

17. Click Add.
You see the user in the Add Names box.
18. Click Full Control under Type of Access.
19. Click OK.
You receive the Directory Permissions screen.
20. Click OK.
You receive the CDR Properties screen.
21. Click OK.

You see the hand on cdr that means sharing.

Administer DEFINITY for AUDIX
Initialization

Check Dial Plan
1. Atthe SAT or DSA window, type disp dial.

You receive the Dial Plan Record form, which should have the correct local
node number and extension length.

display dialplan

DIAL PLAN RECORD
Local Node Number: 13
ETA Node Number:
Uniform Dialing Plan: 4-digit ETA Routing Pattern:
UDP Extension Search Order: local-extensions-first
FIRST DIGIT TABLE
First Length
Digit - 1 - -2 - -3 - -4 - -5- -6 -
1:
2: extension
3:
4:
5:
6:
T: dac
8:
9: dac
0:
%*; fac fac
#: fac fac

2. Make note of the local node number (first digit) and the extension length.
The number of digits or the local node number can only be changed
through the web interface.

3. Press Fi[Cancel].
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Check Hunt Groups

1. Atthe SAT or DSA window, type list hunt group.

You receive the Hunt Groups form.

list hunt-group group

HUNT GROUPS

Grp Grp
No. Name/ Grp ACD/ Que No. Cou Notif/ Dom Message
Ext Type MEAS Vec MCH Siz Mem Path Ctg Adj Ctrl Center
1 monroe voice hunt
2000 ucd-mia n/- n none 8 8 n A
2 paradox veice hunt
2600 ucd-mia n/- n none 8 8 n n
3  rockuille uoice hunt
2650 ucd-mia n/- n  none 6 8 n h

Command successfully completed
Command :

2. Note the following information about the AUDIX hunt group:

= Grp No.
= Grp Name
«  Ext

3. Press Fi[Cancel].

Check Class of Service
1. Atthe SAT or DSA window, type disp cos.

You receive the Class of Service form.

display cos

CLASS OF SERVICE

0 1 2 3 45 6 7 8 910111213 1415
Auto Callback n Yy Yy n ynynynwynwyhnuyn
Call Fwd-All Calls n 'y nyynmnyynmnywynnywy
Data Priuvacy n Yy nonnnwywyywyonmnonmnuyWyyWuy
Priority Calling n Yy n nnonnmnwnuywywywywyuy.py
Console Permissions n n nnhn nNnnNnnNnnNnnNnnNDNDNDNDNDNDN
0ff-hook Alert nnnNnnNnnNnnnnnNnR~NONHORANDNDNMNDNDRN
Client Room nnnNnnNnnNnnnnnNnR~NONHORANDNDNMNDNDRN
Restrict Call Fud-Off Net Yy Yy Y Y Yy yyyyyywywyyH py
Call Forwarding Busy/DA n N h N nNnnNMNDNMNDNMRNDNDNDNDNDN
Personal Station Access (PSA) n n n n n n n n n nn nnanonoan
Extended Forwarding All n N h N nNnnNMNDNMNDNMRNDNDNDNDNDN
Extended Forwarding B/DA n N h N nNnnNMNDNMNDNMRNDNDNDNDNDN
Trk-to-Trk Transfer Querride n n n n n n n h nh h nnnannon
QSIG Call Offer Originations n N h N nNnnNMNDNMNDNMRNDNDNDNDNDN

Command: I

2. Find the COS you plan to use for the AUDIX port stations, it is usually COS
5.

3. Make sure that Data Privacy and Restrict Call Fwd-Off Net are setto y.
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4. Make sure the other fields are set to n.

5.

Press F1 [Cancel].

Check Class of Restriction

1.

At the SAT or DSA window, type disp cor 1, where 1 is the COR you plan
to use for the AUDIX port stations.

You receive the Class of Restriction form.

display cor 1 Page 1 of H
CLASS OF RESTRICTION

COR Number: 1
COR Description: audix

FRL: 7 APLT? y
Can Be Seruice Observed? n Calling Party Restriction: none
Can Be A Service Observer? n Called Party Restriction: none
Time of Day Chart: 1 Forced Entry of Account Codes? n
Priority Queuing? n Direct Agent Calling? n
Restriction Ouerride: none Facility Access Trunk Test? n
Restricted Call List? n Can Change Couerage? n

Access to MCT?
Category For MFC ANI:
Send ANI for MFE? n
MF ANI Prefix: Automatic Charge Display?
Hear System Music on Hold? y PASTE (Display PBX Data on Phone)?
Can Be Picked Up By Directed Call Pickup?
Can Use Directed Call Pickup?

Gruui Controlled Restriction: inactive

Make sure that the COR has an FRL of 7 to allow for Outcalling and Fax
Print.

Fully Restricted Seruice?

=]

=3 333

Make sure that Calling Party Restriction is set to none.
Make sure that Time of Day Chart is set to 1.

Press F7 [Next Page].

You receive page 2 of the Class of Restriction form.
Press F7 [Next Page].

You receive page 3 of the Class of Restrictions form.

display cor | Page 3 of H
CLASS OF RESTRICTION

CALLING PERMISSION (Enter "y" to grant permission to call specified COR)

0?7 y 127 y 247 y 367 y 487 y 6B? y 2% y 84?7 y
1?7y 132 y 25? y 37? y 497 y 61? y 73?7y 857 y
2? y 149 y 267 y 387 y 50?7 y 62? y TH? y 867 y
37y 157 y 27?7 y 397 y 51?7 y 637 y 75?7y 87? y
4? y 16? y 287 y 409 y 527 y 64? y 767 y 887 y
5? y 17?7 y 297 y 1Py 53? y 65? y T7? y 897 y
6? y 18?7 y 307 y 42? y 54?7 y 66?7 y 787 y 90?7 y
TPy 19?2 y 31? y 439 y 55? y 67? y 79?7 y 91? y
8? y 207 y 32?7 y 447 y 567 y 68?7 y 80?7 y 92? y
9?7 y 21?7 y 33?7 y 45? y 57?7 y 697 y 817 y 93? y
10? y 22? y 342 y 46? y 587 y 70?7 y 82? y 94? y
11?2 y 23? y 35?7y 477 y 597 y T1?y 83?7 y 95? y

—
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7. Make sure that all fields are set to y so there are no restrictions.

=>» NOTE:
Pay attention to toll fraud issues.

8. Press Fi[Cancel].

Add Stations

This procedure sets up stations for AUDIX ports.

1. Atthe SAT or DSA window, type add sta <number>, where number is the
station you want to use for the first AUDIX port.

You receive the Station form.

change station 2001 Page 1 of 3
STATION

Extension: 2001 Lock Messages? n BCC: ©
Type: 2500 Security Code: TN: 1
Port: B1A1201 Couerage Path 1: COR: 1
Name: monroe up#i Couerage Path 2: C0S: 5

Hunt-to Station: Tests? n

STATION OPTIONS

0ff Premise Station? n Message Waiting Indicator:

—

2. Type 2500 in the Type field.
3. Type 01A1201 in the Port field.

=>» NOTE:
This is a virtual port used to communicate between DEFINITY and
AUDIX.

Type a name in the Name field.

Enter the correct COR and COS.

Make sure that Tests? is set to n.

N g &

Press F7 [Next Page].
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You receive page 2 of the Station form.

change station 2001 Page 2 of 3
STATION
FEATURE OPTIONS
LWC Reception: audix

LWC Activation? n Coverage Msg Retrieval? n
CDR Privacy? n Auto Answer: none

Redirect Notification? n Data Restriction? n

Per Button Ring Control? n Call Waiting Indication? n

Bridged Call Alerting? n Att. Call Waiting Indication? n

Switchhook Flash? y Distinctive Audible Rlert? n

Ignore Rotary Digits? n Adjunct Superuision? y
H.320 Conuersion? n

Per Station CPN - Send Calling Number? _

Audible Message Waiting?

=

8. Make sure that LWC Reception is set to audix.

9. Make sure that all other fields, except for Switchhook Flash and Adjunct
Supervision are set to n.

10. Press F7 [Next Page].

You receive page 3 of the Station form.

STATION
SITE DATA
Room: Headset? n
Jack: Speaker? n
Cable: Mounting: d
Floor: Cord Length: 8
Building: Set Color:

ABBREVIATED DIALING
List1: List2: List3:

HOT LINE DESTINATION
Abbreviated Dialing List Number (From aboue 1, 2 or 3): _
Dial Code:

Line Appearance: call-appr

—

11. Make sure that Line Appearance is set to call-appr.

12. Press F3 [Enter].

13. Type duplicate station <number>, where number is the station you set
up for the first AUDIX port.
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14. You receive the Duplicate Station form.

o

uplicate station 2081 Page 1
STATION

o
%
=

Security
Port Name Code Room

o M
o X
o
o
[
o
o
*
o
o
o
®

15. Add the 7 remaining stations.

This allows you to add all of your stations at the same time on the same
form.

Make a Hunt Group
1. Atthe SAT or DSA window, type add hunt next.

You receive the Hunt Group form.

add hunt-group next Page 1 of 10
HUNT GROUP
Group Number: 4 ACD? n
Group Name: AUDIX Queue? y
Group Extension: 29008 Uector? n
Group Type: ucd-mia Couerage Path:
TN: 1 Night Seruice Destination:
COR: 1 MM Early Answer? n

Security Code:
ISDN Caller Display:

Calls Warning Threshold:

Queue Length: 8
Time Warning Threshold: :::

2. Note the Group Number.
3. Type a name in the Group Name field.

4. Type the Group Extension, that is the Extension from the Hunt Groups
form.

5. Make sure that Group Type is set to ucd-mia.
6. Make sure that Queue is y and Queue Length is 8.

7. Press F7 [Next Page].
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8. You receive page 2 of the Hunt Group form.

add hunt-group next Page 2 of 10
HUNT GROUP

Message Center: audix

Calling Party Number to INTUITY AUDIX? n
LWC Reception: none

First Announcement Extension: Delay (sec): __

—

9. Make sure that Message Center is set to audix.

10. Press TAB.
The field Calling Party Number to INTUITY AUDIX field appears.
11. Make sure that this field is set to n.
12. Make sure that LWC Reception is set to none.
13. Press F7 [Next Page].

You receive page 3 of the Hunt Group form.

add hunt-group next Page 3 of 10
HUNT GROUP
Group Number: 4 Group Extension: 2960 Group Type: ucd-mig
Member Range Allowed: 1 - 200 Administered Members (min/max): 8 /O
Total Administered Members: @
GROUP MEMBER ASSIGNMENTS
Ext Name Ext Name
1: 2001 14:
2: 2002 15:
3: 20083 16:
4: 2004 17:
5: 2085 18:
6: 2006 19:
T: 2807 20:
8: 2008 21:
9: 22:
10: 23:
11: 24:
12: 25:
13: 26:
At End of Member List

14. Type the extensions of the 8 stations you entered before.

15. Press F3 [Enter].
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Change Coverage Path
1. Atthe SAT or DSA window, type add cov pa 1.

You receive the Coverage Path form.

add couerage path 2 Page 1 of 1
COVERAGE PATH

Coverage Path Number: 2
Hunt after Couerage? n

Next Path Number: Linkage
COUERAGE CRITERIA
Station/Group Status Inside Call Outside Call
Active? n n
Busy? y y
Don't Answer? y y Number of Rings: 3
A11? n n
DND/SRC/Goto Couver? y y

COUERAGE POINTS
Terminate to Couerage Pts. with Bridged Appearances? n

Pointl: hi Point2: Point3:

Point4: Point5: Point6:

Make sure that Number of Rings is set to 3.

3. Make sure that Pointl is set to the AUDIX hunt group that you previously
set up.

4. Press F3 [Enter].

Add Test Phones
1. Atthe SAT or DSA window, type add sta next.
add station next Page 1 of 4
STATION
Extension: 2009 Lock Messages? n BCC: ©
Type: 6408D+ Security Code: TN: 1
Port: Couerage Path 1: 2 COR: 1
Name: test station 1 Coverage Path 2: CcoS: 1
Hunt-to Station:
STATION OPTIONS
Data Module? n Personalized Ringing Pattern: 1
Speakerphone: 2-way Message Lamp Ext: 20089
Display Language: english Mute Button Enabled? y

—

Type the type of phone you are using in the Type field.

Type the port in the Port field.

4. In the Coverage Path 1 field, type the number of the coverage path you
just created or changed.

o

Fill in any other appropriate fields.
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AUDIX Administration

This section provides information about AUDIX commands and administering
AUDIX initialization. For additional information about AUDIX administration, refer
to the AUDIX Administration PDF files on the Documentation CD and DEFINITY
ONE Communications System AUDIX Command Line Administration Quick
Reference, 555-233-737.

AUDIX Commands

Commands available to change system settings and subscriber information in
the AUDIX application are executable from the AUDIX command prompt. Users
access the AUDIX command prompt from the DSA or Telnet interface. To view a
list of commands, click Fe [Choices], from the command prompt. You receive the
following AUDIX screen:

monroe Active Alarms: none Logins: 1

gadd to enter new administrative records
audit to validate system data
change to modify existing administrative records

copy to copy announcements and fragments

display to display administrative records and maintenance logs
exit to exit from AUDIX administration and maintenance

get to request remote updates

help to display available types of help

list to produce reports

logoff to leg off the system

print to send the command output to the attached printer
remove to remoue administrative records

reset to restart or shutdown the Messaging Core

test to test alarm origination or outcall

toggle to toggle the function key settings

trace to turn on amis trace

enter command: I

Adding an AUDIX Subscriber

After completing the machine level translations, subscribers must be added to
the DEFINITY ONE system. The following forms detail the addition of AUDIX
subscribers. Bring up the AUDIX forms via DSA or Telnet.

1. Start at the AUDIX command prompt screen.

2. Enter the command Add Subscriber and the extension number that the
new subscriber will use.

3. Enter the data for the subscriber on page 1 of the Add Subscriber Form as

detailed in[Table 3-1jon page 23.
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Add Subscriber Form, page 1
nonr oe Active Al arms: WA Cogins: 1
add subscri ber 2600 Page 1 of 2
SUBSCRI BER
Nane: Jones, John Locked? n
Ext ensi on: 2600 Passwor d:
CCS: cl ass01 M scel | aneous 1:
Swi tch Number : M scel | aneous 2:
Conmunity | Dt M scel | aneous 3:
Secondary Ext: M scel | aneous 4:
Account Code: Covering Extension:

Emai | Address:

Press [ENTER] to execute or press [CANCEL] to abort
enter command: add subscriber 2600

Br oadcast Mai |l box?

Table 3-1.

Field Definitions for Add Subscriber Screen, Page 1

Field

Valid Input Description

Name

Subscribers Name This is the name of the subscriber. Tn the
example above: Jones, John

Extension | Extension number This Is the extension number assigned on the

Definity for the subscriber

Password

Can be alpha or numeric  Subscribers password. Input a temporary
password and instruct the new subscriber to
change their password when they log in to
AUDIX

COSs

class00 o class1T Class of service; contains feafures that a
AUDIX subscriber could be enabled to use.
Setup the Class of Service on the system
before adding subscribers.

4. Press F3 [Enter] to save the information.

When adding subscribers to AUDIX, the preferred method is to first set up a
Class of Service (COS) for a group of AUDIX subscribers. Using this method the
data is filled in for you on page 2 of the Add Subscriber form. The following is an
example of page 2 of the Add Subscriber form.
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Add Subscriber Form, page 2
nonr oe Active Al ar s WA Logins: 1
add subscri ber 2600 Page 2 of 2
SUBSCRI BER CLASS OF SERVI CE PARAMETERS
Addr essi ng Fornmat: extension Logi n Announcenent Set: System
System Mul tilingual is OFF Call Answer Primary Annc. Set: System
Call Answer Language Choice? n Call Answer Secondary Annc. Set: System
PERM SSI ONS
Type: call-answer Announcenent Control ? n Qutcal ling? n
Priority Messages? y Broadcast: none | MAPI Access? y
| MAPI Message Transfer? vy Fax Creation? y Trusted Server Access? y
| NCOM NG MAI LBOX Oder: fifo Category Order: nuo
Retention Tines (days), New. 10 ad: 10 Unopened: 10
OUTGO NG MAI LBOX Oder: fifo Cat egory Order: unfda
Retention Tines(days), File Cab: 10 Del i ver ed/ Nondel i verabl e: 10
Voi ce Mail Message (seconds), Maximum Length: 1200 M ni mum Needed: 32
Call Answer Message (seconds), Maxi mum Length: 1200 M ni num Needed: 8
End of Message Warning Tine (seconds):
Maxi mum Mai ling Lists: 25 Total Entries in all Lists: 250
Mai | box Size (seconds), Maxi mum 1200 M ni mum Guarantee: 0

Press [ENTER] to execute or press [ CANCEL] to abort
enter command: add subscri ber 2600

Download Message Manager and DSA

Install Message Manager

See[Chapter 8,]“Message Manager Installation” for instructions on installing

Message Manager.

Download DSA

=>» NOTE:

The IP address will be different depending on the type of physical

connection has been established.

1. Bring up your browser (Start > Programs > Netscape or Internet

Explorer).

2. Type http:// <IP address> in the address area of the web browser.
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The ProductName home page is displayed:

Lucent Technologles é
Bail Labt Inncwat on.

DEFINITY ONE™ Comymunications System

The singie solution for
your smali business needs.

Home

Administer

DerinTy ONE provides you with
a fully featured, cost effective
systemn enabling you to meet
your current business
challenges head on while
providing the infrastructure to
bridge you to future
opportunities.

3. Click Administer System.
You receive a screen similar to the following:

Username and Pazsword Required E3

Enter uzermame for august. dr. lucent. com at
auguzt. dr.lucent. com:

Uzer Mame: ||

Password: I

Ok I Cancel I

4. Type your user name and password.

=>» NOTE:
If you are in Services, use a Services login (lucentl, lucent2, or
lucent3) and use the NT passwords from the LAC password/ASG
challenge. The customer uses a customer login such as NTadmin.
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5. You receive the following screen:

NOTICE:
By uze of this system, you accept the terms and condittons of the lcense
Home agreements for all third party software included with this product. Faiure to
comply with these agreements could result in legal action by the third party
Administer vendor(s).
System
Thiz product 15 designed for the use of authonized Lucent Technologies products
User Services only. Use of this system for any other third party applications is strictly prohubited
annd will result in the nullification of Lucent Technologies warranty and post
Download warranty obligations.

Software

Thiz system is restricted to authorized users for legitimate business purposes.

Tnauthorized access 15 a criminal wiolation of the law. Copyright (o) 1992 -
Lucent Technologies UTnpublished & Mot for Publication

[T Don't show this message again

Continue |

Lucent Technologles @
BaellLabs Innowations -

Al e e T T e

6. After reading the screen, click Continue.

You receive the following screen:

System Administration
o DEFINITY EC2 on Bosnia " The first two links will work only
o Tntuity AUDTE on Bosnia ' you have already matalled
Hirie = Default AUDEE Settings DEFINITY Site Administration
o AUDI Metworlong OfL FOoUr Cotnputer.
ST AR E System Maintenance Click on the
a Backup & Restore. . Devwnload Saftwars link
User Services o Shutdewn or Bestart Bosma at the 1eft to install
Remote Control - polnywhere DEFINITY Site Administration.
Download o Start Host Service on Bosma
Software o Stop Host Zervice on Bosnia

o start Java Client on your computer

Lucent Technologles @
BaellLabs Innowations -

7. Click Download Software in the left pane.
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You receive the Software Download screen.

Home

Administer
System

User Services

Download
Software

Software Download

o DEA (DEFINITY Site & dministration)
Download D34 to your computer to remotely administer Definity ECS and
Intuity Audix.
{158 meg, updated: Aug rd, 1008)

o Message Manager
Download Message Manager Software to your computer to access your

Intuity Audix messages.

Lucent Technologles @
BaellLabs Innowations -

8. Click DSA.

You receive the Save As dialog box.

9. Choose a destination.

Issue 1
December 1999
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You receive the Saving Location screen that shows that DSA is being
saved to the drive you chose. When it is finished saving DSA, you return to
the Software Download screen.

10. Go to the drive to which you saved DSA and double click on the
application.

You receive the Unpacking DEFINITY Site Administration screen and a
Welcome screen.

11. Click Next.
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12. You receive the DEFINITY Site Administration screen that includes a
Installing screen and related information.

nstalling DEFINITY Site Administration

Welcome to the DEFINITY Site Adrinistiation (DSA)
instalation progrem. This program wil nstal DSA on
your computer

that
befare contining, To do se,

1. Minimize this window by clicking = in the upper right
come of the

2 Bt anp Wi you have open

Mavi the DEFINITY Site.
Adniristiaion Setup buiton on the: Task Bar.

e production i
portion o it mey resul i severe civi and ciminl 3
wil be prasecuted t the masimum estent possible unde la

Hest> Cancel

Press Next.
13. You receive a setup dialog box that prompts you to “please wait.”
14. Click Finish when the “please wait” message disappears.

You receive a README file that contains useful information about DSA.
DSA is installed on your PC and a DSA icon appears under Start >
Programs > DEFINITY Site Administration.
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Start a DSA Session

1. Bring up your browser (Start > Programs > Netscape or Internet
Explorer).

2. Type http:/l <IP address> in the address area of the web browser.

The ProductName home page is displayed:

Lucent Technologles 6
Bail Labt Inncwat on. -

DEFINITY ONE™ Comymunications System

The singie solution for
your smali business needs.

Home

Administer
System DerinTy ONE provides you with
a fully featured, cost effective
systemn enabling you to meet
your current business
challenges head on while
providing the infrastructure to
bridge you to future
opportunities.

User Services

3. Click Administer System.
You receive a screen similar to the following:

Username and Pazsword Required E3

Enter uzermame for august. dr. lucent. com at
auguzt. dr.lucent. com:

Uzer Mame: ||

Password: I

Ok I Cancel I

4. Type your user name and password.

=>» NOTE:
If you are in Services, use a Services login (lucentl, lucent2, or
lucent3) and use the NT passwords from the LAC password/ASG
challenge. The customer uses a customer login such as ntadmin.
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5. You receive the following screen:

NOTICE:
By uze of this system, you accept the terms and condittons of the lcense
Home agreements for all third party software included with this product. Faiure to
comply with these agreements could result in legal action by the third party
Administer vendor(s).
System
Thiz product 15 designed for the use of authonized Lucent Technologies products
User Services only. Use of this system for any other third party applications is strictly prohubited
annd will result in the nullification of Lucent Technologies warranty and post
Download warranty obligations.

Software

Thiz system is restricted to authorized users for legitimate business purposes.

Tnauthorized access 15 a criminal wiolation of the law. Copyright (o) 1992 -
Lucent Technologies UTnpublished & Mot for Publication

[T Don't show this message again

Continue |

Lucent Technologles @
BaellLabs Innowations -

Al e e T T e

6. After reading the screen, click Continue.

You receive the following screen:

System Administration
o DEFINITY EC2 on Bosnia " The first two links will work only
o Intuity AUDIX on Bosma if you have already installed
Hirie = Default AUDEE Settings DEFINITY Site Administration
YL o AUDI Metworlong OfL FOoUr Cotnputer.
ST AR E System Maintenance Click on the
a Backup & Restore. . Devwnload Saftwars link
User Services o Shutdewn or Restart Bosmia at the left to install

Remote Control - polnywhere DEFINITY Site Administration.

Download o Start Host Service on Bosma
Software o Stop Host Zervice on Bosnia
o start Java Client on your computer

Lucent Technologles @
BaellLabs Innowations -

7. Click DEFINITY ECS or INTUITY AUDIX on <machine name> in the right
pane.

This will launch DSA.
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8. Set up daily automatic backups of AUDIX. These could be to a PCMCIA
card, or preferably, to a directory on your server. See[‘Perform Scheduled|

[Backup (Web)"Jon page C-30.

Scheduling Backups

See|‘Perform Backup”|on page C-17.
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AUDIX Digital Networking

This chapter provides the information you need to administer digital networking
after the initial system administration is complete. See INTUITY AUDIX
Administration for further information.

This chapter is organized as follows:

« [“Initial Administration Tasks” on page 4-1|

=« [“Viewing the Feature Options Window” on page 4-3|

=« [“Changing the Number of Administered Remote Users” on page 4-4|

« [“*Administering Networking Channels” on page 4-5|

= [“Changing Local Machine Information” on page 4-6|

=« [*Adding a Remote Machine” on page 4-11|

=« [|“Performing a Full Remote Update” on page 4-18|

» |‘Resetting Automatic Deletion of Nonadministered Remote Users” on|
Eaﬁe 4-1§|

=« [“Viewing Remote Extensions” on page 4-19|

Initial Administration Tasks

The following tasks need to be performed as part of the initial administration
process. The Initial Administration Tasks table shows the tasks in sequential
order. Some of the tasks are performed by the technician at the time of
installation. Confirm that each of the tasks was performed. If not, you must
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complete the task. The design center provides the information for completing the

administration. Ensure that you have design center specifications for TCP/IP,
network channels, the local machine, and all remote machines.

Table 4-1.

Initial Administration Tasks

Task

Description

Screens, Windows, or
Commands

Complete Windows NT and
switch administration (normally
done by the technician at the
time of installation).

Define the machine name,
TCP/IP address, and the switch
to work with AUDIX digital
networking.

Windows NT Settings

screens and Switch screens

View digital networking settings.

See|"Viewing the Featurel
|O§tions Window" on éaée 4-3.|

Verify that the purchased digital
networking options are correctly
displayed.

List Configuration Window

Verify or change the number of
administered remote users
(normally done by the technician
at the time of installation). See

[‘Changing the Number of|
|Administered Remote Users” on

Define the number of
administered remote users to be
equal to or greater than the
number of all mailboxes on all
remote systems.

System Parameters Limits
Screen

Administer network channels
(normally done by the technician
at the time of installation). See

“Administering Networking|
Channels” on éaée 4-5.|

Enable the channels to create a
communication link between the
ACCX card and the switch or the
LAN card and the LAN.

Networking Channel
Administration Window

Change the local machine.

“Chanqing Local Machine|
Information” on §a§e 4-6.|

Define local machine
information for digital
networking.

Machine Profile Screen;
Local Machine
Administration Window

Add a remote machine or
change a remote machine
(normally done by the technician
at the time of installation). See

page 4-11.

‘Adding a Remote Machine” on

On the local machine, define
information about each remote
machine, including the machine
name, password, connection
type, and dial string.

Digital Network Machine
Administration Window;
Machine Profile Screen

Administer the AUDIX system
on the remote machines.

On each remote machine,
define information about the
local machine.

Remote Machine Profile
Screen of the remote
machine

Perform a full remote update.

See|“Performing a Full Remote]
Update” on page 4-18.

Manually run a remote update
for each remote machine to
bring the network up to date
immediately.

get remote update
command
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Table 4-1. Initial Administration Tasks
Task Description Screens, Windows, or

Commands

Set automatic deletion of
nonadministered remote users.
See|“Resetting Automatic|

Sets the system to delete
nonadministered remote users
automatically.

System Parameters
Features Screen

View remote extensions. See

[“Viewing Remote Extensions”|

Check that remote users were
added to the local database.

List Remote Extensions
Screen

Record remote machine names.

Record the names of remote
systems so that local users hear
voiced confirmations when
addressing messages to users
on those remote systems.

Use the telephone to
perform this task.

Viewing the Feature Options Window

View the Feature Options Window to see the purchased options for digital
networking. This window is display only. It can be changed only by certified
Lucent Technologies personnel.

To display the Feature Options window:

1. Start at the AUDIX Command Prompt Screen.

denuer

Active

Alarms: A

Logins: 3

|enter command :

Screen 4-1.

AUDIX Command Prompt Screen
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2. Atthe enter command: prompt, enter list configuration

The system displays the List Configuration Screen.

hessuille Active Alarms: M Logins: 1

LIST CONFIGURATION
Configuration Option Value
Audix Application ON
Dcs ON
Fax ON
High speed digital ports N/A
Low speed digital ports N/A
Max Number of IMAPI Sessions 6
Multilingual ON
SCSI Disk Mirroring N/A
TCPIP digital ports 1
Text-to-Speech Sessions 2
Trusted Seruvers 6
hours_of_speech 30
uoice_ports 8

Press [NextPagel, [PreuPage] or [Cancell]
enter command: list configuration

Screen 4-2. List Configuration Screen

3. Contact your Lucent Technologies representative if you need more than
the enabled number of ports or if you want to add TCP/IP networking.

Changing the Number of Administered
Remote Users

The number of administered remote users must be equal to or greater than the
total number of mailboxes on all remote systems with which this local system
networks.
To change the number of administered remote users:

1. Start at the AUDIX Command Prompt Screen.

2. Enter change system-parameters limits at the ent er command:
prompt.
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The system displays the System-Parameters Limits Screen.

Active Alarms: MmwA Logins: 3

change system-parameters limits
SYSTEM-PARAMETERS LIMITS

MESSAGE LIMITS
Hessage Lengths, Maximum (seconds): 1200 Minimum C(tenths of seconds): 10
Messages, Total In All Mailboxes: 50000 Awaiting Delivery: 5008

ADMINISTRATION LIMITS
Subscribers, Local:
Lists, Total Entries:

Administered Remote: 1000
Lists/Subscriber: 100 Recipients/List: 250

|enter command: change system-parameters limits

Screen 4-3. System-Parameters Limits Screen

3. Enter the number of remote users in the Admi ni st ered Renot e: field.
4. Press F3[Enter] to save the information in the system database.

The cursor returns to the command line, and the system displays the
following message:

Conmand Successful |y Conpl et ed.

5. Enter exit or another administrative command at the ent er conmand:
prompt.

Administering Networking Channels

You must enable the network channels before the local AUDIX system can
exchange voice messages over the digital network. Enabling the channels
creates a communication link between the ACCX card and the switch or between
the LAN card and the LAN and/or the wide area network (WAN).

To enable the network channels:

1. Start at the DEFINITY ONE main page from Internet Explorer or Netscape,
and select Administer System > AUDIX Networking > Administrative
Menu > Network Channel Administration.
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The system displays the Network Channel Administration Window.

l Network Channel Administration
Channel Type Channel Status Channel Configuration
© Enahle
1 TCP/P DISABLE & Disahle
& Enahle
2 TCP/P ENABLE £ Dicahle
Help | Save | | | Cancell | | |

Screen 4-4. Network Channel Administration Window

2. In the Channel Configuration column, click Enable for each channel.
3. Click Save.

The system takes a few seconds to change the hardware configuration.
When the process finishes, the system displays a confirmation message.

Changing Local Machine Information

You can change local machine information on the Machine Profile Screen for the
Local Machine and on the Local Machine Administration Window.

=>» NOTE:
If you change the local machine profile, contact all remote network
administrators and inform them of the changes.

Changing the Local Machine Profile

To update the machine profile:
1. Start at the AUDIX Command Prompt Screen.

2. Enter change machine at the ent er command: prompt.
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The system displays the Machine Profile Screen for the Local Machine,

Page 1.
Active Alarms: HMmwA Logins: 2
change machine Page 1 of 2
MACHINE PROFILE
Machine Name: drmidi® Type: local Location: local
Ugiced Name? n Extension Length: 3
Uoice ID: O Default Community: 1
ADDRESS RANGES
Prefix Start Ext. End Ext. Warnings
36000 37999

OW~NoOOUNEFEWwN —

|enter command: change machine

Screen 4-5. Local Machine Profile Screen, Page 1

3. Complete the fields on this screen using the information from the table
below.

=>» NOTE:
The Machi ne Name, Type, Locati on, Ext ensi on Lengt h, and
Voi ce | Dfields are display only and cannot be changed except via
the web page.

Table 4-2. Field Definitions; Local Machine Profile Screen, Page 1

Field Valid Input Procedure/Description

Machine Name Display only Displays the Machine Name for the local
machine. This value comes from the network
settings in Windows NT.

Machine Type Display only Displays | ocal .

Location Display only Displays | ocal .

Voiced Name? y =yes The Voice Name field contains an n until you
n =no record a name for the machine. This field

automatically changes to y when you record a
name for the machine.
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Table 4-2. Field Definitions; Local Machine Profile Screen, Page 1

Field

Valid Input

Procedure/Description

Extension Length

an integer, 3
through 10

Enter the length of extensions on the local
system. The value you enter must match the
extension length in your dial plan.

Voice ID

Display only

Displays a system-assigned identifier that you
must use to identify the machine if you decide to
record machine names.

Default Community

an integer, 1
through 15

If you have administered your system to use
community sending restrictions, enter the default
community number for your user population.

Prefix

Oto 21
alphanumeric
characters

Prefixes can be used on the local machine, but
they limit the functionality and are not
recommended. For a detailed discussion of the
use and implications of prefixes, see the AUDIX
Fax Administration documentation.

Start Ext.

a 3-digit to 10-digit
string

Enter the starting extensions for the ranges of
telephone numbers used on the local system.
(Designate a block of switch extensions that can
be used at the local system when assigning
users.)

For example, if your system uses extensions
between 2000 and 3000, enter 2000 in the
Start Ext. field.

Up to 10 different ranges can be specified to
pinpoint the exact set of extension blocks used
by the local system. The length of the start and
end extension must agree with the

Ext ensi on Lengt h field. For a 5-digit
extension, the default is 00000 to 99999.

End Ext.

a 3-digit to 10-digit
string

Enter the ending extensions for the ranges of
telephone numbers used on the local system.

For example, if your system uses extensions
between 2000 and 3000, enter 3000 in the End
Ext . field.

Warnings

Display only

This field displays a warning when a duplication
or overlap of an extension range for another
machine is being assigned.

4. When you have finished entering information on this screen, press F7
[NextPage].
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The system displays Machine Profile Screen for the Local Machine, Page
2.

Active Alarms: MmwA Logins: 2
change machine Page 2 of 2
MACHINE PROFILE
Allow Automatic Full Updates? y
Updates: In? y Out? y

Network Turnaround? y

|enter command: change machine

Screen 4-6. Local Machine Profile Screen, Page 2

5. Complete the fields on this screen using the information provided in the
following table.

Table 4-3. Field Definitions; Local Machine Profile Screen, Page 2

Field Valid Input Description
Allow Automatic y =yes If you enter y, the local AUDIX system automatically requests
Full Updates n =no full updates from remote systems.

If you enter n, the local AUDIX system does not automatically
request full updates from remote systems.

Updates: y =yes If you enter y, this local AUDIX system will accept updated
In? n =no user database information from any remote machine (the
Updat es | n field must also be set to y on the remote
Machine Profile screen setup on the local AUDIX system for
each remote machine).

If you enter n, the local AUDIX system will not accept updates
from any remote machine regardless of the entry on the
remote Machine Profile screen. Set this field to y only after
testing the network end-to-end during initial administration.
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Table 4-3. Field Definitions; Local Machine Profile Screen, Page 2
Field Valid Input Description
Updates: y =yes If you enter y, updates to user database information for local
Oout? n =no users are sent to a remote machine (the Updat es Qut

field must also be set to y on the remote Machine Profile
screen set up on the local AUDIX system for each remote
machine).

If you enter n, updates will not be sent to any remote machine
regardless of the entry for this field on the remote Machine
Profile screen. Set this field to yes only after testing the
network end-to-end during initial administration.

Network y =yes To disable this feature system-wide, enter n on the local
Turnaround n=no Machine Profile screen.

To enable the feature, enter y on the local Machine Profile
screen and on the appropriate remote Machine Profile
screens on this local system.

If enabled, a network connection that originated from this
local AUDIX system is allowed to turn around after the local
AUDIX system has sent all of its network data to any remote
machine. The remote machine may then return update
information, voice mail, and status on the same connection.

6. When you finish updating the local machine information, press F3 [Enter] tO
save the information in the system database.

The cursor returns to the command line, and the system displays the
following message:

Conmand Successful | y Conpl et ed.

7. Enter exit or another administrative command at the ent er conmand:
prompt.
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Completing the Local Machine Administration

Window

To view the local machine information:

1. Start at the DEFINITY ONE home page from the web browser and select
Administer System > AUDIX Networking > Administrative Menu >
Local Machine Administration

The system displays the Local Machine Administration Window.

r

Local Machine Administration

Local Machine Name

drryon1 BERIIECT TCPAP

Type

IP
Address

135.9.181.44

|Password ||denver1

Help |

Change Cancel

Screen 4-7. Local Machine Administration

2. Change the password if necessary.

You cannot change the value in any fields except the Passwor d field. To
change other values, see[‘Changing the Local Machine Profile”|on page

4-6.

3. Click Save.

The system updates the information and displays a confirmation
message.

Adding a Remote Machine

If you want users on the local machine to be able to exchange messages with
AUDIX users on another machine, you must provide information to the local
machine about the remote machine.

=>» NOTE:

The AUDIX system accepts only one local machine. Do not attempt
to add a second local machine. Use the instructions in this section
only to add remote machines.
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Completing the Digital Network Machine
Administration Window (via Web Browser)

To enter information for connecting to the remote machine:

1. Start at the DEFINITY ONE home page and select Administer System >
AUDIX Networking > Administrative Menu > Remote Machine
Administration > Digital Machine Administration

2. On the Digital Machine Administration screen, click Add New Machine.

The system displays the Digital Machine Administration window.

Digital Machine Administration

Machine Connection
Name f type TCPIIP
| IP Address | | |

Message Transmission Schedule (hh:mm, 00:00 - 23:59)

1.8tart| [ End[ [ Interval [
2. Start| [ End[ [ Interval [
3.start| | [ End[ [ Interval [
Send .
Multimedia | [ves ~] M.I?Ch;"e [INTUITY 4.0 or Later =]
Messages ? yP
| Password | f |

Help | Add | Change | Deletel Cancel | Rename | |

Screen 4-8. Digital Machine Administration window

3. Complete the fields in this window using the information provided in the
Field Definitions; Digital Network Machine Administration table.
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Table 4-4. Field Definitions; Digital Network Machine Administration

Field Valid Input Procedure/Description

Machine 1to 10 Enter the unique name of the remote machine.

Name alphanume.rlc Each remote machine must have a unique name, not only
characters; see from other remote machines, but from all machines on the
guidelines atright | hoork, including fax call delivery machines and the local

AUDIX.

TCP/IP Numeric address The IP address of the remote machine.

Address string in the format
nnn.nnn.nnn.nnn

Message 24-hour clock time Start Ti me — Enter the starting time for a message

Trans- in the format transmission period to the remote system, such as 00:01 for

mission hh:mm 1 minute after midnight.

Schedule End Ti me — Enter the ending time for a message

transmission period to the remote system, such as 23:59 for
1 minute before midnight.

I nt er val — Enter the interval at which the local AUDIX
system will call this remote system, such as 00:05 for every 5
minutes. The AUDIX system checks the queue at this interval
and calls the remote system if something is in the queue for
this remote system.

It is recommended that you stagger start times and intervals
for each remote system so the local AUDIX system is not
trying to call all remote systems at the same time.

Password 5-digit to 10-digit Enter the password exactly as it is administered on the
alphanumeric remote system.
characters

Send yes Select yes if the remote machine will accept multimedia

Multimedia no messages (such as fax and text messages).

Messages? Select no if the remote machine will not accept multimedia

messages.

Machine See description at Enter the machine type.

Type right

To see a list of valid machine types, click the dropdown arrow
and select the appropriate machine type from the available
types.

4. When you finish entering information for a remote machine, click Save.

The system adds the information and displays a confirmation message.

5. Add another remote machine if needed.
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Completing the Machine Profile Screen for the
Remote Machine (via AUDIX)

Use the Machine Profile screen to enter networking information required for each
remote machine, such as address ranges and remote update information.

To enter networking information on the Machine Profile Screen:

=>» NOTE:
The Digital Network Machine Administration window must be completed for a remote
machine before completing the Machine Profile screen for that machine.

1. Start at the AUDIX Command Prompt Screen.

2. Enter change machine remote_machine_name at the ent er conmand:
prompt.

The system displays the Machine Profile Screen for a Remote Machine,
Page 1.

Active Alarms: MmwA Logins: 2

change machine drbigl0
MACHINE PROFILE

Machine Name: drbigl® Type: VEX Location: remote-digital
Voiced Name? n Extension Length: 5
Uoice ID: 1 Default Community: 1
ADDRESS RANGES
Prefix Start Ext. End Ext. Warnings
53000 56999

DWW ~NOOU EZWwWhN —

|enter command: change machine drbigl0

Screen 4-9. Remote Machine Profile Screen, Page 1

=>» NOTE:
If you do not know the names of the remote machines, enter list
machines at the ent er conmmand: prompt. The system displays a
list of all machines administered on the system.

3. Complete the fields in this window using the information provided in the
Field Definitions; Remote Machine Profile Screen, Page 1 table.

=—>» NOTE:
The Machi ne Nane, Type, Locat i on, and Voi ce | Dfields are
display only and cannot be changed.
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Table 4-5. Field Definitions; Remote Machine Profile Screen, Page 1

Field Valid Input Description

Machine Name Display only Displays the machine name for this remote machine
entered on the Digital Network Machine Administration
window.

Type Display only Displays the machine type for this remote machine
entered on the Digital Network Machine Administration
window.

Location Display only Displays the location r enot e- di gi t al .

Voiced Name? y =yes The Voice Name field contains an n until you record a

n =no name for the machine. This field automatically changes
to y when you record a name for the machine.

Extension Length Aninteger from3 | Enter the length of extensions on the local system. The

to 10 value you enter must match the extension length in your
dial plan.

Voice ID Display only Displays a system-assigned identifier that you must use
to identify the machine if you decide to record machine
names.

Default Community | Anintegerfrom1 | If you have administered your system to use community

to 15 sending restrictions, enter the default community
number for your user population.




DEFINITY ONE Communications System Release 1.0 Issue 1
Installation and Upgrades 555-233-109 December 1999

4 AUDIX Digital Networking

4-16
Table 4-5. Field Definitions; Remote Machine Profile Screen, Page 1
Field Valid Input Description
Prefix Oto21 Enter the prefix digits. A user enters the prefix before
alphanumeric the remote user’s extension when addressing voice
characters messages. To simplify this task, use a short, descriptive

prefix. The total length of the prefix plus the extension
must not exceed 25 characters. The system uses the
prefix only to identify users. It is not used for dialing out,
so it does not need to match an area code or office
code. The following are examples of possible prefixes:

n No prefix — The prefix is required only when one
or more of the remote users share the same
extension numbers as the local users (the
extension ranges of the two systems overlap). If
there are no overlapping extension numbers, a
prefix is not needed.

n Public network access code — When addressing
a message to a remote user, the local user enters
the remote user's number as if placing a call to
that user.

n Location code — This method simplifies
addressing messages by requiring only an
alphanumeric code in front of the extension
number. Location codes are shorter and often
easier to remember.

Start Ext. A 3-digit Enter the starting extensions for the ranges of telephone
to10-digit string numbers used on the local system. (Designate a block
of switch extensions that can be used at the local
system when assigning users.)

For example, if your system uses extensions between
2000 and 3000, enter 2000 in the St art Ext . field.

Up to 10 different ranges can be specified to pinpoint
the exact set of extension blocks used by the local
system. The length of the start and end extension must
agree with the Ext ensi on Lengt h field. For a
5-digit extension, the default is 00000 to 99999.

End Ext. A 3-digit Enter the ending extensions for the ranges of telephone
to10-digit string numbers used on the local system.

For example, if your system uses extensions between
2000 and 3000, enter 3000 in the End Ext . field.

Warnings Display only This field displays a warning when a duplication or
overlap of an extension range for another machine is
being assigned.
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4. Press F7 [NextPage].

The system displays Machine Profile Screen for a Remote Machine, Page

Active Alarms: MmwA Logins: 2

MACHINE PROFILE
Send to Non-Administered Recipients? y
Updates: In? y Out? y

Network Turnaround? y

pnter command: change machine drbigl@

5. Complete the fields in this window using the information provided in the
Field Definitions; Remote Machine Profile Screen, Page 2 table.

Table 4-6. Field Definitions; Remote Machine Profile Screen, Page 2

Field Valid Input Description

Send to Non- y=yes Enter y if the system will attempt to deliver messages to

Administered n =no non-administered remote recipients.

Recipients? Enter n if messages cannot be sent to nonadministered
recipients.

Updates: y=yes Enter y if the local system will accept updated database

In? n =no information from the remote system (the Updat es

Qut field must also be set to y on the local Machine
Profile screen).

Set to y only after testing the network end-to-end during
initial administration.

Updates: y=yes Enter y if the local system will send updated database

Out? n =no information to the remote system (the Updates In
field must also be set to y on the local Machine Profile
screen).

Set to y only after testing the network end-to-end during
initial administration.
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Table 4-6. Field Definitions; Remote Machine Profile Screen, Page 2

Field Valid Input Description
Network y=yes If you are conducting an acceptance test, enter n.
Turnaround n=no

After the acceptance tests, enter y if a network
connection that originated from this remote system is
allowed to turn around after the remote system has sent
all of its network data to the local system.

The local system may then return update information,
voice mail, and status on the same connection. This
feature reduces toll charges and increases the efficiency
of the system in networks with more than 10 machines.

The Networ k Tur naround field must be settoy
on the local Machine Profile screen for this feature to
work between the local system and the remote system.

6. Press F3[Enter] to save the information.

The cursor returns to the command line, and the system displays the
following message:

Conmand Successful | y Conpl et ed.
7. Press F3[Cancel] to return to the command line.

8. Enter exit or another administrative command at the ent er conmand:
prompt.

Performing a Full Remote Update

If you have the system set to perform automatic daily updates, you only need to
perform the full remote update to update the system after making changes to
remote machine connections or to verify changes of data you just entered.
To update the remote user information immediately:

1. Start at the AUDIX Command Prompt Screen.

2. Enter get remote update machine_name at the ent er comrand:
prompt, where machine_name is the name of the remote machine.

The system displays the Remote Update Request confirmation screen.
3. Press F3 [Enter] to continue.

The cursor returns to the command line, and the system displays the
following message:

Conmand Successful | y Conpl et ed.

4. Enter exit or another administrative command at the ent er conmand:
prompt.
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Resetting Automatic Deletion of
Nonadministered

Remote Users

To conserve server space by automatically deleting nonadministered remote

users:
1.
2.

Start at the AUDIX Command Prompt Screen.

Enter change system-parameters features at the ent er conmand:
prompt.

The system displays the System-Parameters Features, Page 1 screen.

Press F7 [NextPage] three times to display the System-Parameters Features,
Page 4 screen.

Inthe Days without Activity: field,typethe number of days. Type
0 if you do not want to automatically delete nonadministered remote
subscribers.

Inthe Even If on a Mailing List? field, type n to retain information
for nonadministered remote subscribers that are on a subscriber’s mailing
list.

Press F3 [Enter] to save the changes.

The cursor returns to the command line, and the system displays the
following message:

Conmand Successful | y Conpl et ed.

Enter exit or another administrative command at the ent er comrand:
prompt.

Viewing Remote Extensions

To verify that remote subscriber information was updated in the local machine
database, view the remote extensions:

1.
2.

Start at the AUDIX Command Prompt Screen.

Enter list remote-extensions machine_name at the ent er command:
prompt, where the machine_name is the local machine of the remote
subscribers.

The system displays the List Remote Extensions screen.

3. Press F7 [NextPage] to display additional pages of the list.

Press F1 [Cancel] to return the cursor to the command line.

5. Enter exit or another administrative command at the ent er conmmand:

prompt.
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Update and Repair Procedures

This chapter provides the tasks needed to upgrade and repair the DEFINITY
ONE system.

This chapter is organized as follows:

=« [‘Update Software” on page 5-1|
=« [“Replace the TN795 Circuit Pack” on page 5-3|

= [|“Replace the Hard Disk” on page 5-4|
= [|“‘Replace the PCMCIA Flash Disk (Hot Pluggable)” on page 5-5|

=« [|“Access Diskeeper Software to Defragment the Disk” on page 5-5|

Update Software

This procedure is used to upgrade a new version of software. All Lucent
applications must be stopped during an upgrade.

The DEFINITY and AUDIX translations and the NT registry must be saved and
backed up before starting. Use[*Perform Immediate Backup (Web)|on page
C-21 to get the translations to the network drive or to the flashdisk.

=>» NOTE:
The serial number of the TN795 circuit pack is stamped on the circuit
pack and is stored electronically in the firmware. The electronic
version is checked by the software during an installation.

Two special control files must be present on the system before it will provide
service. One of these files is a password file containing passwords and ASG keys
for the login IDs used by Services. The second file is a license file that is used to
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control which application will run and which features these applications will
provide. Both of these files are encrypted and both files are specific to a
particular serial number of the processor board. During installation, these two
files are received together in an “install” file that is used by the installconfig
command during system setup.

1.
2.
3.

© ©® N ©°

10.

11.

12.
13.

14.

15.

16.

17.

18.

19.

Click Network Neighborhood.
Share the laptop CDROM drive.

Connect the laptop computer using the procedure,|“Connect the Laptop|
[Computer to DEFINITY ONE”|on page C-2 in Appendix C, Miscellaneous
Procedures.

Telnet to the LAC in a console bash session using the procedure, ['Via a|
[Telnet Session”| on page 2-8 in Chapter 2, Connectivity, and bring up a
bash shell.

At the prompt, type shutdown Audix to shut down AUDIX before backing
up AUDIX. Wait for the bash prompt to return; this will take about 3
minutes.

Use the d1stat command to check the status of the AUDIX shutdown.
After AUDIX is shut down, type exit.
From the LAC prompt, type DEFINITY. Use the NTT terminal type.

From the DEFINITY command line, type save translations to save
DEFINITY translations.

After the save of DEFINITY translations is complete, save and back up all
translations by following the appropriate backup procedure under
[‘Perform Immediate Backup (Web)”|on page C-21 in Appendix C.

Start a pcANYWHERE session using the procedure, [‘'Via p)cANYWHERE”|
on page 2-13 in Chapter 2, Connectivity and Access to DEFINITY ONE.

You receive the DEFINITY ONE desktop.

Click on Start: Run: bash to bring up a console bash shell on the DEFINITY
ONE.

In the console bash, type shutdown all to stop any running system
applications.

In the console bash, use the d1stat command to check the status of the
shut down.

Map the CD-ROM from the laptop to DEFINITY ONE using the procedure,
[‘Map DEFINITY ONE to the Laptop Computer's CD-ROM Drive”|on page
C-13 in Appendix C, Miscellaneous Procedures.

Click Start on the NT desktop and start a command prompt.

Click Run and type f:\setup, where f is the drive letter that refers to the
CD-ROM. Click OK.

When prompted to overwrite customer data, click No.



DEFINITY ONE Communications System Release 1.0 Issue 1

Installation and Upgrades 555-233-109 December 1999
5 Update and Repair Procedures
Replace the TN795 Circuit Pack 5-3
20. If prompted to overwrite a read-only file, click Yes.

21.
22.

23.

The install process takes approximately 20 minutes.
When the installation completes, click Finish.

Manually reboot the system by pressing the shutdown button on the
TN795. When the shutdown LED is steadily lit, power cycle. Wait 5-8
minutes for the system to come back up.

Check for dial tone.

=>» NOTE:
Install a new license file (installconfig) if the processor board has
been changed or the software is upgraded to a major new release,
following the procedure, [‘Obtaining a License File”|on page 3-3 in
Chapter 3, Installation Procedures. Do not reboot until the
installconfig procedure is complete.

Replace the TN795 Circuit Pack

=—>» NOTE:

o~ N

Anytime the TN795 circuit pack is changed out, either for repair or
upgrade, a new license file must be obtained and the installconfig process
must be used (DEFINITY and INTUITY AUDIX will not start if the license file
does not have the correct TN795 serial number).

Shut down the system. (Refer to the procedure,[*Shut Down”]on page
C-44 in Appendix C, Miscellaneous Procedures.)

Remove the TN795 circuit pack.
Remove the hard disk from the failed TN795 circuit pack.
Insert the hard disk onto the new TN795 circuit pack.

Boot the system.

Follow the procedures to install a new license file, including running the setip
command. See the procedure,|“Obtaining a License File"|on page 3-3 in Chapter
3, System Initialization, for more details.

=> NOTE:

The system will boot but the DEFINITY One applications will not start
running because the serial number on the disk does not match the serial
number on the board.

Because the hard disk is reused, the system has the old password file that
was on the system before the board failed. You must obtain the
appropriate password from the TSO to log in.
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Replace the Hard Disk
1. Shut down the system. (See the procedure,[*Shut Down”]Jon page C-44 in

Appendix C, Miscellaneous Procedures.)

2. Remove the TN795 circuit pack

3. Remove the failed hard disk from the TN795 circuit pack

10.

11.

Insert the new hard disk onto the board, making sure to use the
appropriate hard disk for the given circuit pack and software release.

The disk comes pre-loaded with all the necessary DEFINITY ONE
software; however, the DEFINITY ONE applications will not run until you
install the new license file. See step 9.

. Once the system has rebooted, connect the services laptop computer to

DEFINITY ONE using the procedure, [‘Connect the Laptop Computer tg
[DEFINITY ONE”|on page C-2 in Appendix C, Miscellaneous Procedures.

. Telnet to the LAC using the procedure, [‘Via a Telnet Session”|on page 2-8

in Chapter 2, Connectivity and Access to DEFINITY ONE.
Log in and run a bash session.

The browser will prompt for a login and password. Because the new hard
disk does not have a password file, the system reverts back to the factory
default login of lucent3.

Execute swversion and verify that the load of software on the hard drive
matches that on the customer’s CD. If it is not, follow the procedure,
[‘Update Software”|on page 5-1.

Bring up your favorite browser on the laptop and load the DEFINITY ONE
Home Page. See the procedure, [Via a Web Browser Session”|on page
2-10 in Chapter 2, Connectivity and Access to DEFINITY ONE, for
information about how to start a web browser.

Navigate the browser to the backup and restore screens.

The browser will prompt for a login and password. Because the new hard
disk does not have a password file, the system reverts back to the factory
default login of lucent3.

Follow the steps for restoring the customer’s data. The customer may have
backed up to their local network or the PCMCIA flash disk.

If the customer backed up to the PCMCIA flash disk, then restoring will
restore whatever was backed up last. If the registry was backed up, then
the restore will update LAN information allowing DEFINITY ONE to be seen
from the customer’s network.

If the customer backed up to the local network or failed to back up the
registry, then you need to run setip with the cust option to re-establish
DEFINITY ONE on the customer’s network.
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12. After restoring, follow the procedures to install a new license file, including
running the setip command. See the procedure, [ Obtaining a License]
[Eile” on page 3-3 in Chapter 3, System Initialization, for more details.

After installing the license file, the system restarts and all applications
load.

13. The logins and passwords will have been updated by the installconfig
command.

14. Note that the NT logins of vm, sa, browse, and NTadmin will be reset to
their factory defaults. Tell the customer to reset these passwords and
re-install any other NT accounts they may have created.

=>» NOTE:
The DEFINITY-specific customer logins should still work as they
were restored with the restore done earlier.

15. Ifitis necessary, upgrade the software on the disk by following the steps

in the procedure, [‘Update Software”|on page 5-1. If an upgrade is

necessary, upgrade the software before installing the new license file.

Replace the PCMCIA Flash Disk
(Hot Pluggable)

1. Verify that disk in not in use (check LED on front panel).
2. Unplug old disk and insert new disk.

3. Run translation backup to verify health.

Access Diskeeper Software to
Defragment the Disk

Diskeeper software is a program that automatically defragments the disk. The C
drive is defragmented once every Sunday at 3:00 a.m., and the D drive twice
every day between 2:00 a.m. and 4:00 a.m.

Change the Default Times on Diskeeper
These times may be changed. To manually defragment the disk, set up a
schedule, or view a help file, a control GUI is available. Access this GUI by:

1. From the DEFINITY ONE desktop, click Start > Programs > Executive
Software > Diskeeper.

You receive the Diskeeper Menu and can re-administer the program.
2. Select Set It and Forget It.

3. Select Partition Scheduler.
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4. The Select Set It and Forget It - Partition Scheduling window appears.
5. Set new times for automatic defragging; this will change the default times.
6. Click Start.
7. Click Close.
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Hardware Additions

This chapter provides the tasks required to install some equipment associated
with upgrading an existing DEFINITY ONE system.

For more information about installing adjuncts and peripheral devices, refer to
DEFINITY Enterprise Communications Server Release 7 Installation for Adjuncts
and Peripherals, 555-230-125.
This chapter is organized as follows:

» [‘Add Circuit Packs” on page 6-2|

« [‘Add CO, FX, WATS, and PCOL” on page 6-2|

« [‘Add DID Trunks” on page 6-3|

» [‘Add Tie Trunks” on page 6-4|

» [‘Add DS1 Tie and OPS” on page 6-6|

=« [“Add Speech Synthesis” on page 6-6|

=« [“Add Code Calling Access” on page 6-6|
« [*Add Pooled Modem” on page 6-7)

=« [“Multiple Integrated Recorded Announcement” on page 6-9|
« [|“Add ISDN-PRI” on page 6-10|
« [“Add IP Trunk” on page 6-12]
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Add Circuit Packs

When installing additional features or equipment, it may be necessary to install
additional circuit packs. To see a list of allowable circuit packs, see Chapter 1,
“Install and Cable the Cabinet,” [‘Allowable and Non-Allowable Circuit Packs”|on
page 1-24. This is a general procedure to use when adding features or
equipment that require adding circuit packs.

1.

A

o

Log onto the system and answer y to the Suppress Alarm Origination
question during login.

Install the circuit pack into the carrier.
Type change circuit-pack.
Verify the circuit pack appears in the listing.

If the circuit pack code is not present, type the code manually in the
proper slot.

Type test board long command to test the board.

Log off the system after the addition (and any required administration) is
complete.

For information about administering circuit packs and other equipment, refer to
DEFINITY Enterprise Communications Server Release 7 Administrator's Guide,
555-233-502.

Add CO, FX, WATS, and PCOL

Requirements

Each Central Office (CO), Foreign Exchange (FX), Personal Central Office Line
(PCOL), or Wide Area Telecommunications Service (WATS) trunk connects to 1
port of either an 8-port TN747B or to 1 of several CO trunk circuit packs.
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Installation

1. Determine the port assignment of the trunk from Trunk Group form.

EXAMPLE: | Port Number 3 A 07 01
Cabinet Carrier Slot | Circuit
(Port Network) (or Compact
Modular
Cabinet)

2. Install a TN747B or a CO Trunk circuit pack in the assigned carrier slot (if
an additional circuit pack is required).

3. Administer the forms listed under CO, FX, WATS, or PCOL Trunk Group in
DEFINITY Enterprise Communications Server Release 7 Administrator’'s
Guide, 555-233-502.

Add DID Trunks

Requirements

Each Direct Inward Dial (DID) trunk connects to 1 port DID Trunk circuit pack or
to 1 port of an assortment of DID trunk circuit packs.

Installation

1. Determine the port assignment of the trunk from Trunk Group form.

EXAMPLE: | Port Number 1 A 07 01
Cabinet Carrier Slot | Circuit
(Port Network) (or Compact
Modular
Cabinet)

2. Install a DID Trunk circuit pack in assigned carrier slot (if an additional
circuit pack is required).

3. Administer forms listed under “DID Trunk Group” in DEFINITY Enterprise
Communications Server Release 7 Administrator's Guide, 555-233-502.
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Add Tie Trunks
Requirements

Each tie trunk connects to 1 port of a 4-port tie trunk circuit pack or to an
assortment of international tie trunk circuit packs.

Installation
1. Determine the port assignment of the trunk from Trunk Group form.
EXAMPLE: | Port Number 3 A 02 01
Cabinet Carrier Slot | Circuit
(Port Network) (or Compact
Modular
Cabinet)

2. Install tie trunk or an international tie trunk circuit pack in assigned carrier
slot (if an additional circuit pack is required).

3. For customer-owned (not leased) tie-trunk facilities (such as campus
environments), tie trunk circuit packs provide signaling capabilities
beyond those specified by the industry-wide E&M standard. Use [Figure]

and Table 6-1{to choose the preferred signaling format, set switches
on the circuit pack, and administer the port.

4. Administer forms listed under “Tie Trunk Group” in the DEFINITY
Enterprise Communications Server Release 7 Administrator’s Guide,
555-233-502.
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UNPROT
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PROT PORT 4 PORT 3 PORT 2 PORT 1
E&M E&M E&M E&M
758183 RBP 050896
Figure 6-1. Tie Trunk Circuit Packs (Component Side)
Table 6-1. Tie Trunk Option-Switch Settings and Administration
E&M/SMPLX | Prot/Unprot | Administered
Installation Situation Preferred Signaling Format | Switch Switch Port
Circumstance | To System Far-End
Collocated DEFINITY E&M Type 1 | E&M Type 1 | E&M Unprotected | Type 1l
Compatible Standard Compatible
Inter-Building DEFINITY Protected Protected E&M Protected Type 1
Type 1 Type 1
Compatible Standard Compatible
Plus
Protection
Unit
Collocated Net Integrated | E&M Type 1 | Any PBX E&M Unprotected | Type 1l
Standard
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Add DS1 Tie and OPS

The TN2313 DS1 Tie Trunk and TN767B (or later) DS1 Interface circuit packs
provide connections to a 1.544 Mbps DS1 facility (T1) as 24 independent
64 kbps trunks.

The TN2313 DS1 Tie Trunk, TN767B (or later) DS1 Interface, and TN464C (or

later) DS1 Interface circuit packs provide connections to a 2.048 Mbps DS1
facility (E1) as 32 independent 64 kbps trunks.

Service Interruption

1. Since the addition of DSL1 tie-trunk service may require a service
interruption, notify the customer in advance as to when the addition will
occur.

Add Speech Synthesis

The TN725B Speech Synthesizer circuit pack is required when the Voice
Message Retrieval, Automatic Wakeup, or Do Not Disturb features are activated.
The TN725B circuit pack does not require administration.

1. Determine the port assignment of the Speech Synthesizer circuit pack
being added.

2. Install the TN725B Speech Synthesizer circuit pack in the designated
carrier slot.

Add Code Calling Access

The tones for the Code Calling feature are generated by the TN2182/B
Tone-Clock circuit pack in the port networks.

1. Install a TN763B/C/D Auxiliary Trunk circuit pack or a TN457 Speech
Synthesizer circuit pack and connect for Loudspeaker Paging. The Code
Calling Access feature shares the same ports as Loudspeaker Paging. An
Auxiliary Trunk circuit pack provides 4 ports for Loudspeaker Paging and
Code Calling Access.

2. Administer the form listed under “Code Calling Access” in DEFINITY
Enterprise Communications Server Release 7 Administrator's Guide,
555-233-502.
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Add Pooled Modem

Modem Pooling supports two types of conversion resources: “integrated” and
“combined.”

The integrated type requires a TN758 Pooled Modem circuit pack for each two
conversion resources provided.

The combined type requires a port on a digital Line circuit pack and a port on
either an 8-port or 16-port analog line circuit pack for each conversion resource
provided.

1.

4.

Determine the port assignment of the circuit packs to be added (if
required).

Install the appropriate circuit packs in assigned carrier slot (if required).
For Paradyne 3800 Series modems:
a. Type AT&F&D2&S4\D3S2=128x7V2S7=60S85=1 and press Enter.
b. Type ATY0S10=100S78=2MOEO\N1&W and press Enter.

For other types of modems, refer to the vendor’s documentation.

Settings for Modem Connected to Data Module

e e N < =
o o ~M W N P O

© 0o N o gk w DR

Type add data-module next and press Enter.

Type pdm in the Type field.

Type x in the Por t field.

Type dte in the Connect ed t o field and press Enter.
Type add station next and press Enter.

Type 2500 in the Type field.

Type x in the Por t field.

Type n in the Test s field and press Enter.

Type add modem-pool next and press Enter.

Type combined in the G- oup Type field.

. Type5inthe Hol d Ti me (m n) field.

. Type two-way in the Di r ect i on field.

. Type 9600 in the Speed field.

. Type Full in the Dupl ex field.

. Type async in the Synchr oni zat i on field.

. Type the port pair assignments in the Anal og and Di gi t al fields and

press Enter.
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Settings for Modem Connected to the Data
Terminal Equipment (DTE)

1. Type add station next and press Enter.
2. Type 2500 in the Type field.

3. Type the port assignment in the Por t field and press Enter.

Table 6-2. 7400A Options — Attention Control Modems

Set Option Display | Option Setting
Set 300 Speed? 300 Note 1
Set 1200 Speed? 1200 Note 1
Set 2400 Speed? 2400 Note 1
Set 4800 Speed? 4800 Note 1
Set 9600 Speed? 9600 Note 1
Set 19200 Speed? 19200 Note 1
Set AT Control? AT ON
Set Cl Lead? Cl Note 2
Set CI2 Lead? ClI2 Note 2
Set CH Lead CH Note 2
Set CH2 Lead? CH2 Note 2
SetLL Lead? LL Note 2
Set REMOTE Loop? REMLOOP Grant
Set RL Lead? RL Note 2
Set SIGLS Disc? SIGLSDISC | ON
Set TM Lead? ™ Note 2

=>» NOTE:

1. Set speed to match remote modem. At least one speed must be

set ON.

=>» NOTE:

2. Set to match remote modem.
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Multiple Integrated Recorded
Announcement

TN750C Announcement Circuit Pack

The TN750C circuit pack contains on-board flash memory that provides internal
backup of announcements. Thus, the TN750C circuit pack does not need the
save and restore processes.

The TN750C circuit pack can replace a TN750 or TN750B. The difference in
operation is that the TN750C automatically restores and reports the availability of
announcements from its own internal flash memory in 5 minutes, rather than the
40 minutes for the TN750 or TN750B.

If a circuit pack already has announcements in its flash memory, the yellow LED
flashes as the announcements copy to the voice RAM.

Add TN750C Circuit Packs
1. Insert the TN750C into a vacant slot in a carrier.

2. Administer new announcements to that TN750C slot by executing the
change announcements <location> command.

3. Record the announcements, as described in DEFINITY Enterprise
Communications Server Release 7 Administrator's Guide, 555-233-502.

4. Wait until the announcements copy from voice RAM to the on-board flash
memory (the yellow LED on the TN750C starts and then stops flashing).
This takes about 10 minutes.

Move a Single Announcement to Another
Announcement Circuit Pack

1. Enter the change announcements command to change the circuit pack
locations of a particular announcement. (You may also change the
compression rate at this time.)

2. Re-record the announcement, as described in DEFINITY Enterprise
Communications Server Release 7 Administrator's Guide, 555-233-502.



DEFINITY ONE Communications System Release 1.0 Issue 1

Installation and Upgrades 555-233-109 December 1999
6 Hardware Additions

Add ISDN-PRI 6-10
Add ISDN-PRI

T1 (North American)

1. Use a TN767F or TN767E (or later version) circuit pack to set up an ISDN
PRI trunk. Make sure that the dip switch on the board is set for 24
channels. If you are using Facility Associated Signaling (FAS), 23
channels are available to be used as trunk group members. Channel 24
must be used to create a sighaling group for the trunk groups. If you are
using Non Facility Associated Signaling (NFAS), it is possible to use all 24
channels for trunk group members in some instances.

2. To create a PRI trunk, do the following:
a. Enter ADD DS1 (board location) at the SAT terminal session.
b. Enter the required information on the DS1 form.

c. Create a signaling group using the ADD SIG NEXT command. If
you are using FAS signaling, use the 24th channel on your DS1
board as the D-channel for your signaling group. If you are using
NFAS signaling, enter N in the associated signaling field. List the
trunk board location in the Trunk Board field.

d. Create a trunk group by using the ADD TRUNK NEXT command:

1. Fill in the required information on the Trunk Group Form
pages.

2. Fillin the port locations of the trunk members on the Trunk
Group Member page.

3. Enter the correct signaling group number.

E1 (International)

1. Use a TN464F circuit pack. Make sure the dip switch on the board is set
for 30 channels (E-1). If you are using. If you are using Facility Associated
Signaling (FAS), 29 channels are available to be used as trunk group
members. Channel 16 must be used to create a sighaling group for the
trunk groups. If you are using Non Facility Associated Signaling (NFAS), it
is possible to use all 30 channels for trunk group members in some
instances.

2. To create a trunk group, do the following:

a. Determine the slot assighment of the circuit packs that will be
added.

b. Install the DSL1 interface circuit pack in the assigned carrier slot.
c. Enter ADD DS1 (board location) at the SAT terminal session.

d. Enter the required information on the DS1 form.
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e. Create a signaling group using the ADD SIG NEXT command. If
you are using FAS signaling, use the 16th channel on your DS1
board as the D-channel for your signaling group. If you are using
NFAS signaling, enter N in the associated signaling field. List the
trunk board location in the Trunk Board field.

f. Create a trunk group by using the ADD TRUNK NEXT command:

1. Fill in the required information on the Trunk Group Form
pages.

2. Fillin the port locations of the trunk members on the Trunk
Group Member page.

3. Enter the correct signaling group number.

Add Circuit Packs

1. Determine the slot assignment of the circuit packs to be added.

2. Install the DS1 Interface circuit pack in the assigned carrier slot.

Install Cables

1. Install cables from the cabinet to the MDF as required.

Enter Added Translations

1. Administer the forms listed under “Integrated Services Digital Network —
Primary Rate Interface” in DEFINITY Enterprise Communications Server
Release 7 Administrator's Guide, 555-233-502.

Resolve Alarms

1. Examine the alarm log. Resolve any alarms that may exist using DEFINITY
ONE Communications System Release 1.0 Maintenance, 555-233-111.

Save Translations

1. Enter save translation and press Enter. This instructs the system to take all
translation information in memory and write it to the translation cards.

2. Update backup cards, if necessary.
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Add IP Trunk

The DEFINITY IP Trunk lets you integrate LAN applications into your DEFINITY
communications network. It is implemented using the TN802B MAPD which is a
Windows NT server residing on a circuit pack inside the DEFINITY ONE.
Installing the DEFINITY IP Trunk involves the following steps:

1.

Prepare for Installation

2. Check your Shipment
3.
4

. Connect the IP Trunk Server to Your Local Area Network

Connect the Modem (Optional)

Prepare for Installation

Have the following ready before your shipment arrives on site.

Three adjoining, unoccupied slots in the DEFINITY ECS

The IP-trunk circuit pack occupies only one slot, but it needs the two slots
to its left for clearance.

A 10/100 BaseT Ethernet connection into your local area network

A valid, unused IP address on your network that can be assigned to the IP
Trunk server

A technician’s laptop computer

A mouse, keyboard, and VGA monitor with Windows NT loaded for use
during the installation of the server

An analog telephone line reserved for the IP-trunk diagnostic modem

A valid international telephone number reserved for the IP-trunk diagnostic
modem

Symantec pcANYWHERE software

This third-party application lets Lucent support personnel control the
MAPD processor remotely, via the modem, during maintenance and
troubleshooting.

AC power outlets for the modem and monitor

Check your Shipment

When your DEFINITY IP Trunk order arrives at your site, check the contents.

1.

Before you open the shipping carton, inspect it for damage. If the box is
damaged, do not open it. Inform the shipping company, and ask for
instructions on filing a claim.
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2. If the box is undamaged, check the contents against the packing slip.
Check the condition of each component, and note any damage or
shortages on the packing slip. The carton should contain the following for
each IP Trunk ordered:

=« TN802B MAPD circuit pack
» US Robotics Sportster 56K external modem

The modem lets Lucent support personnel remotely maintain and
troubleshoot your system.

» TN802B external cable assembly

The TN802B external cable assembly is a bundle of cables with an
amphenol connector at the end of the bundle and various PC-type
connectors (VGA, USB, mouse, keyboard, Ethernet, modem, and
COM2) at the ends of the individual cables. See Figure 6-2. It
should be labeled at the point where the bundle enters the
amphenol connector.

chdfocto AWF 122398

Figure Notes

1. To P1 on cabinet backplane 5. To mouse

2. To VGA monitor 6. To Ethernet

3. To USB (not used) 7. To modem (optional)
4. To keyboard 8. To COM2 (not used)

Figure 6-2. TNB802B External Cable Assembly
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Install the TN802B MAPD

The TN802B circuit pack is hot-swappable, so you do not need to power down
the carrier.

1. Make sure that there is room to install the TN802B circuit pack. To
accommodate the width of the circuit pack, you must have at least 3
adjacent slots free. (If you can put the TN802B circuit pack in slot 7, you
must have 2 adjacent slots.)

2. Insert the TN802B circuit pack in the rightmost of the three slots you
reserved for IP trunking.

3. Connect the P1 amphenol connector on the TN802B external cable
connector to the leftmost backplane connector looking from the rear (of
the 3 slots required for the TN802B).

Connect the Modem (Optional)

The modem lets Lucent technicians service and troubleshoot your system
remotely.

1. Connect the RS232 port of the modem to the MODEM cable of the
TN802B external cable assembly.

2. Connect an analog telephone line to the leftmost analog-line port on the
modem.

3. Make sure that the modem’s DIP switches are set as indicated in
Figure 6-3.
4. Plug the modem into an AC power outlet.

Wi el G

\ [

modfrobo KLC 121198

Figure Notes
1. Connect analog line here. 3. Connect MODEM connector here.

2. DIP switch 5 must be up.

Figure 6-3. [External Modem Connections
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Connect the IP Trunk Server to Your
Local Area Network

Connect the Ethernet Cable

1.

Connect the network cable to the ethernet connector on the TN802B
external cable assembly.

Connect a Monitor

You need a VGA monitor to log onto the Windows NT Server and to configure the
network software.

1.

Attach a VGA monitor to the VGA cable of the TN802B external cable
assembly.

. Attach the keyboard to the KEYBOARD cable of the TN802B external

cable assembly.

Attach the mouse to the MOUSE cable of the TN802B external cable
assembly.

Plug the monitor into an AC power receptacle, and turn it on.

Log onto the IP Trunk Server

Log onto the IP Trunk server as follows.

1. Press the CTRL, ALT, and DELETE keys simultaneously.
2. Type administrator in the User Nane field.

3.
4

. After logging on for the first time, change the administrator password and,

Leave the Passwor d field blank, and click OK.

if desired, the user name, to ensure security. See your Windows NT Server
documentation for details.

Assign a Server Name and Domain Name

Windows NT Server identifies servers using a server name plus a domain name
that locates the named server in a particular part of the network. The TN802B is
shipped with a generic server name and a generic domain name. You should
assign replacement names that are meaningful within your network.

1.

o~ N

Click My Computer from the Windows NT desktop.
Click Control Panel in the My Computer window.
Click Network in the Control Panel window.

Click Identification, then Change.

Type the new name in the Conput er Nane box.
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6. Type the name you chose for the IP-trunk domain in the Domain box.
7. Click OK > OK.

8.
9

Click Close.

. When prompted, choose one of the following options:

» If you have not administered IP addresses, click No.

» If you have administered IP addresses, restart Windows NT so that
the new names take effect.

Check Network Services

When the server restarts, make sure that the required network services have
started correctly.

1.

SRR S

6.

7.

Click My Computer from the Windows NT desktop.
Click Control Panel in the My Computer window.
Click Network in the Control Panel window.
Click Services in the Network window.
Make sure that the following services are listed:
« Computer Browser
» Microsoft Internet Information Server 2.0 needed
= NetBIOS Interface
» RPC Configuration
= Server
» Workstation

Click Protocols, and examine the Network Protocols. TCP/IP should be
the only protocol listed.

Click OK.

Assign an IP Address

R e o

Click My Computer from the Windows NT desktop.
Click Control Panel in the My Computer window.
Click Network in the Control Panel window.

Click Protocols in the Network window.

Click TCP/IP Protocol from the list.

Click Properties in the Network window.
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Microsoft TCP/IP Properties HEA

IPAddress |DNS | WINS Address | Pouting|

An IP address can be automatically assigned to this netwark card by a
DHCPF server. Ifyour network does not hawe a DHCF server. ask your
network administratar for an address, and then type itinthe space
el

1] Intel 82

ed 10/100 Ethernet PCl Adapter

" Ohbtain an IP address from a DHCF server

% Specify an IP address

|P Address: | o . 0. 0 .a@ %
Subnet Mask: | 255 . 255 . 255 . O
Default Gatewey: | o, o. 0.0

Advanced... |

Cancel |

o |

ERplY |

7. Click Specify an IP address.
8. Type a valid IP address for the IP Trunk server in the | P Addr ess: field.
9. Type the appropriate subnet mask in the Subnet Mask: field.

10. If you use gateways, type the IP address of the default gateway for the IP
Trunk server in the Def aul t Gat eway: field.

11. Click OK.

12. If Windows NT responds with the “At least one of the adapter cards has an
empty primary WINS address. Do you want to continue?” message, click
Yes.

13. Click Bindings to make the changes.

NetBIOS Interface, Server, and Workstation should now be enabled. If any
are disabled (marked a red circle with a line through it), review the
network-configuration steps above for omissions or errors.

14. Click Close.

15. Restart your computer.
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Test the Connection to the LAN

You test IP connections by pinging the IP trunk server and pinging a known
computer connected to your network.

1. In the Windows task bar, click Start > Programs > Command Prompt.

2. Atthe command prompt, type ping nnn.nnn.nnn.nnn (where
nnn.nnn.nnn.nnn is the IP address of the IP trunk server).

» If everything is configured correctly, the system replies with the
following:

Reply from nnn.nnn.nnn.nnn: bytes=32 time<##ms TTL=###

» If you receive no reply, verify the IP-address information and check
the connectivity including the cabling.

3. At the command prompt, type ping nnn.nnn.nnn.nnn (where
nnn.nnn.nnn.nnn refers to the IP address of another computer on the
network).

» If you have connectivity, the system replies with the following:
Reply from nnn.nnn.nnn.nnn: bytes=32 time<##ms TTL=###

» If you receive no reply, verify the IP-address information and check
the connectivity including the cabling. Consult your IP-network
administrator.

4. Type exit and press Enter.

Test the Modem
1. Check for dial tone.

Set up Network-Trust Relationships
After all DEFINITY IP Trunk servers are in their own domain, establish trust

relationships between domains to allow for remote administration. To establish
trust relationships, refer to your Windows NT Server 4.0 documentation.

Administer the IP Trunk

The TN802 circuit pack is now installed in the DEFINITY carrier and connected to
the IP network. You can now use the Configuration Manager software
(pre-installed on the TN802 hard disk) and DEFINITY ECS switch administration
software to prepare the IP Trunk for use. Refer to the DEFINITY ECS Release 7
Administrator's Guide for more information.
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DEFINITY Site Administration

(DSA)

This chapter provides information about DSA, the system management tool that
is integrated into the platform itself. See|‘Download DSA”on page 3-24 in
“System Initialization.”

This chapter is organized as follows:

[‘Interactions with Switches and Voicemail Systems” on page 7-2|

[“What You Can Do with DSA” on page 7-3|

[‘Components of DSA” on page 7-4]
[‘'How DSA Works” on page 7-6|
[‘DSA Help” on page 7-7|

[‘Configure DSA” on page 7-7|
— [“Adding DEFINITY ONE Switch Administration item” on page 7-8|

— [‘Adding DEFINITY ONE Voice Mail Administration item” on page|
7-15

As previously stated, the DEFINITY ONE applications are pre-loaded on the
hardware platform. The actual set up of customer translations are administered
through a common system management tool, DSA, which is integrated into the
platform itself.

DSA is an all-purpose telecommunications management tool aimed at small- to
mid-sized companies, such as small businesses, motels, and branch offices of
larger companies.
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Interactions with Switches and
Voicemail Systems

DSA is a Windows 95/98 and NT application and is not client-server based. This
means it communicates directly with switches and AUDIX systems via one of the
following:

Through a direct hardware connection within a DEFINITY ONE computer

Through a direct hardware connection (a cable running from the COM port
on the PC to the switch

Over a network

With a modem or data module

When you use DEFINITY ONE as it is shipped to you, you will connect to switches
and voicemail systems through the direct hardware connection in the DEFINITY
ONE computer. To optimize the efficiency of DEFINITY ONE and DSA, and
because administrators may not want to work directly on the DEFINITY ONE
computer, it is recommended that you install DSA software on a separate
computer and connect to the switch in any of the other three ways listed above.

If you choose to install DSA on a separate computer, the computer you install it
on must fulfill the following requirements:

Windows 95/98 configuration:

Processor: 486/Pentium

RAM: 16MB/32 MB

Available Disk Space: 100 MB minimum

CD-ROM

Printer port: Standard PC printer port or network connection

Available Serial Ports: One free serial port or network connection is
required for a connection to the switch

TCP/IP Network: Optional, depending on configuration

Display: SVGA with minimum screen resolution of 800 x 600

Windows NT configuration:

Processor: Pentium

RAM: 64 MB

Available Disk Space: 100 MB minimum
CD-ROM

Printer port: Standard PC printer port or network connection
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Available Serial Ports: One free serial port or network connection is
required for a connection to the switch

TCP/IP Network: Optional, depending on configuration

Display: SVGA with minimum screen resolution of 800 x 600

What You Can Do with DSA

You can use DSA to perform any type of switch administration activities (except
for the “monitor” commands). Switch administration activities include:

Adding phones to the system, including identifying which extensions or
ports are available

Scheduling activities to run at a later date and time
Scheduling activities to run repeatedly

Assigning telephone feature buttons

Creating or modifying coverage paths

Adding or modifying hunt groups

Administering pickup groups

Administering bridged appearances

Resolving and monitoring alarms

Changing a user’s personal information, such as the name, set type,
location, etc.

Moving or removing agents or stations

Determining how well/whether a station is operating
Testing stations or trunks

Setting up vectors

Performing AUDIX administration activities, including setting up a
voicemail account for a new phone

Setting up a voicemail account is part of the DSA User Administration wizard. For
all other AUDIX tasks, administrators must use DSA's terminal emulation feature
to open an AUDIX terminal emulation window.
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You can also perform specific DSA administration activities. These activities will
help you set up DSA to communicate with switches and AUDIXes, organize
telecommunications data, and specify how you want DSA to work. These
activities include:

= Setting up direct, modem/data module, and network connections between
DSA and switches or AUDIX systems

=« Entering DSA-specific data, such as time-out intervals, number of times to
retry tasks, and other system options

= Using the history, schedule, and connection viewers to track the status of
administration tasks

=« Organizing systems and task shortcuts in the browser tree

Components of DSA

DSA provides a central window that allows access to switches and AUDIX
systems. The pictures below show the main DSA screen.

I DEFINITY Site Adminizstration

File Edit Miew Toolz *indow Help

[ 5] @ s -

Start GEDI

Advanced
Add System
o Tasks IDE Tree |
x| Severity | DatesTime | System | D escription -]
r ﬂ Info 37221999 33527 .. dnastd remove station 502
6 Infa 34221999 3:35:24 .. dnastd remove station 501 i
ﬂ Info 3/22/1999 33410 .. dnastd change station 503
Binfa 3/22/19993:34:09 .. dnastd change station 502
l? Lk 4797 4 000 2.94.00 A ke P % _'_'I
4 | »
AN A [ BB, vigory A scease Cormection Sthm
Fieady s

Figure 7-1. DSA Window with Tasks Pane and Status Viewer or History Pane
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I DEFINITY Site Administration

File Edit “iew Toolz

“window Help

EI é{:llﬁlxl @I%l @I Idnastrd j
—i-|=

#-{E] Button Labels

& cobber
EE dnastrd

{7 Folder
H-_] Groups
e Netwark

H-{_] Station
H-{_] Status
B Swstem
E]---E dragon

[ guestworks
..... opus

N —

EH_] Abbreviated Di
-] Call Center
-] Coverage

[
[
B+ Parameters
[
[

¥ Tasks %8 Tree I—

|

| [ ate/Time

| Syztem | Mame

=l State

¥ Failed
¥ Aborted

4

¥ Complete
¥ Complete

W lnbe

AR 0001047472

4/14/1333 225351 ..
4/14/13331:353:02 ..
4/14/13331:2229
4/13/133312:00:01...

dnastrd
dnastrd
dnastrd
dnastrd

A mrbed

Mew Call Accounting
Mew Call Accounting
Add Bridoed Appearance

add sta ne
P P N N [ [ )

| Recumence ﬂ
Once, at 4/14/1933 2:59:51 PM
Once, at 4/14/1939 1:39:02 PM
Once. at 4/14/13991:22:29 PM
Once, at 44131939 12:00:01 AM

Mlamm =k A 5000 1047472 Akd

Lo

T ET I

Hetory Y, acheule

Cometion Bahm

Feady

| I

Figure 7-2. DSA Window with Tree Pane and Status Viewer or Schedule Pane

As a default setting, the left-pane shows the task wizards that DSA offers for
performing frequent tasks. Users can use task wizards to create common tasks
and schedule those tasks to run on the system and/or save the tasks to the DSA
browser tree. Users can create the following tasks with the task pane:

= Start GEDI- Any administration activity that can be accomplished with the
Graphically Enhanced DEFINITY interface (GEDI), and includes almost all
DEFINITY administration

= User Administration- Adding phones, removing phones, and changing a
phone user’'s name in DEFINITY and AUDIX

= Find and Replace- changing, finding, or removing something across an

entire switch

= Import Data- Copy and paste data from a spreadsheet to a grid in DSA

= Export Data- Save switch data to an external file

= Use Template- Add objects, such as a phone, to a switch, using an

existing template

= Create New Template- Create a template to use when adding objects to

the switch
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» Add Bridged Appearance- Create a bridged call appearance on a phone

» Generate Call Accounting- Select call accounting data and save it as an
external file

» Browse Dial Ranges- View the dialing ranges specified by a switch’s dial
plan

» Find Unused Extension- Search a switch for the next available extension
after a specified extension

» Browse Unused Ports- View a list of unused ports on a switch.
» Browse Stations- View a selected or complete list of stations on a switch

= Monitor Trunks- Tell DSA to periodically check for out-of-service trunks and
notify the user

»« Start Emulation- Access a switch or AUDIX via terminal emulation
» Add Switch- Set up a connection from DSA to a DEFINITY switch

» Add Voice Mail System- Set up a connection from DSA to an AUDIX
system

» Print Button Labels
Clicking the Tree tab on the left-pane displays the DSA browser tree. This tree is
a Windows Explorer-like view of all of the switches and AUDIX systems

connected to DSA, the tasks a user has created, and the button label templates.
Users can:

» Expand nodes in the tree

= Move items

» Cut, copy, or delete items

» Add or paste items to the tree
» Rename items

» Change an item’s properties

= Connect to a switch

How DSA Works

In DSA, any switch or AUDIX administration activity you perform is called a task.
When you use DSA to perform a switch or AUDIX administration task, you enter
the task into DSA and then tell DSA when to run the task. For example, if you want
to add a phone to the system for a new employee, you create a task in DSA that
adds the phone (and, optionally, the associated voicemail account), and then
you tell DSA whether you want to add the new phone immediately or at a later
time.
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When the task runs, DSA connects to the appropriate switch or AUDIX, runs the
task, and displays feedback about the task in the schedule tab. Depending on
the instructions from the user, DSA will either disconnect from the switch or make
the connection idle when it is finished running the task.

DSA Help

DSA provides the following information to help administrators:

» Guided tour. The guided tour orients users to the DSA interface, explains
what the different areas of the DSA screens are for, and orients users to
what DSA is and how to get started. Users can launch the Guided Tour by
choosing Guided Tour from the Help menu.

» Online Help with Demonstrations. The online help system tells how to
administer DSA, how to perform basic switch administration and
troubleshooting, and how to connect to an AUDIX. Many topics include a
Show Me button. When a user clicks Show Me, a short animated
demonstration of the task plays. To open the help system, choose
Contents from the Help menu.

= Show Me demonstrations. Users can launch a list of Show Me
demonstrations by choosing Show Me from the Help menu.

= Connection support. Clicking Help on a connection error message will
launch a series of troubleshooting screens to walk users through solving
common connection problems.

Configure DSA

When DSA is initially installed on a client machine, it will need to be configured to
communicate with both the switch application (DEFINITY) as well as the voice
mail applications (AUDIX) on the DEFINITY ONE platform.

The first time you run DSA it will ask you if you want to create a new entry for the
Switch If you answer yes to creating a new switch, DSA will pop up a window
titled Switch Properties. Once you have filled this out and applied it, DSA will ask
you if you want to create a new entry for a voice mail application. If you say yes
to this, DSA will pop up a screen titled Voice Mail System Properties. Once you
fill this out and apply it, you will have configured both your Switch access and
your voice mail access through DSA to DEFINITY ONE.

If you want to create a new entry for a different system, you may do so as follows.
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Adding DEFINITY ONE Switch Administration
item

For a new Switch configuration item click on file > new > Switch. A screen similar
to the one below will appear.

Switch Properties

™ Login manually to system

Login name; I

% Password: I
Pazsward [again]: I

™ Aoeess Security Gateway [A5G]

Secret kew I

— Connections

Type | [Dial/Host | Port | [evice

Add... | F'ropgrties...l Hemoye |

1]4 I Cancel | Help |

1. Enter a name in the System name field. If you are a technician configuring
DSA on your laptop, use a generic name, as you will be able to use this
connection item for all DEFINITY ONE machines connected over the
PCMCIA physical connection.

2. Enter a login name and Password.

For Lucent Personnel enter one of the dxxxx logins (dinit, dinads, dcraft)
depending on the level of access desired along with the appropriate
password. The password will be unique for each DEFINITY ONE system.

For non-lucent personnel, enter your valid DEFINITY login with its
appropriate password. See[‘Enable DEFINITY Logins”|on page 3-6.
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Log in to DEFINITY with ASG enabled

If the system is ASG-enabled, then clickthe |l ogin manual ly to system
check box. When you try to initiate a connection, an emulator screen will pop up,
prompting for login.

Log in as dxxxx. You will be issued a challenge; respond correctly.

Manual Login ;

Enker your login and pazsword or challenge responze at the prompts. YWhen pou have
entered the login and passward [or rezponze). press "Continue'’.

MOTE: Press "Continue'" at the "'Temminal Type'' prompt.
If you have already selected a terminal type, press "Cancel” and try again.

Login: dcraft
Challenge: 764-28585 Product ID:7000000000

Fesponse: |

Cantinue [F7] i Cancel ! Help i

If you respond successfully, you will start to see data scroll by. The system will
ask for terminal type; do NOT enter a terminal type. Simply click on the Continue
button at the bottom of the screen as in the screen below.

Manual Login x|

Enter vour login ahd pazsword or challenge response at the prompts, *hen pou have
entered the login and pazsword [or responze), press ""Continue'.

MOTE: Presz "Continue’" at the "'Terminal Tope" prompt.
If you have already zelected a terminal type, press "Cancel' and try again.

Login: dcraft

Challenge: 76d-2885 Product ID:7000000000
Fesponzse: 0941427

c[l:24r[1:1H[OT

Login:

Pazzsword:

Systen: G3cEsve Software Version: G3¥7c.01.0.439.0[B
Terminal Type (513, 715, 4410, 4425, VT2zZ0, NTT, SUNT): [513]

Continue [F7) i Cancel Help
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Once you have populated the fields on the Switch Properties page, the
screen should look similar to the one below.

Switch Properties

= System

g’:a | Systempane |DEFINITY ONE -Swich

[™ Login manually to system

Login name: Idinads

(%" Passward: I,mm—
Password (again) I‘-‘-“‘-‘“‘

" Access Secunty Gateway [ASG]

Secret key: I

i~ Connection

Tupe | Dial/Host | Port | Device

Add.. | Propgrties...l Hemaye |

0K | Cancel | Help |
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3. Click on the Add button at the bottom of the screen.This is used to add a
physical connection mechanism from the client machine to the DEFINITY
ONE. Clicking on the Add button will pop up a screen similar to the one
below.

Connection Properties

General | Advanced |

~Details

=

irect zenial port connection

Fart: fcam "l

¥ € Modem or data module connection

Device: I :J

Patt fcom1 =

Fhone Mumber: I

Edipan | (e |

Ok I Cancel | Apply | Help |

=>» NOTE:
Regardless of the physical connection used, i.e., local
monitor/keyboard/mouse, PCMCIA, RAS modem or customer LAN, THE
CONNECTION TYPE IS ALWAYS A NETWORK CONNECTION.

=>» NOTE:
By default the Modem or data module connection radio button is
highlighted. Be sure to click on the network connection radio button.

4. Host: For the host address, enter the IP address that is commensurate
with the physical connection mechanism used to connect to the DEFINITY
ONE. See[‘Installer's Connectivity Quick Reference Tear-Out Sheet’|on
page H-1.

5. Port: For the port number, ALWAYS use port 23.
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6. Click on the Apply followed by OK. This will dismiss the Connection

Properties page and put you back at the Switch Properties page, similar to
the one below.

Switch Properties

~ System
iDEFINITY OME - Switch
HE] Swztemn name:
= Login
I Login manually to system
Login name: Idinads
& Password; I’““"“‘“
Pazsword [again]: I ”””””””
' Access Securty Gateway [455)
Secret kew ;
r— Connections
Tupe | Dial/Host | Part | Device |
W Network 19211136 23
Eroperties.., | Hemowe |
0K | Cancel | Help |

=>» NOTE:

For a Switch (DEFINITY) connection, add two identical connection entries
by repeating steps 3,4,5 and 6. This will allow you to use the wizards.
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After having created the second Network connection item, your Switch
Properties screen should look similar to the one below.
Switch Properties

~ System

{gr | Systemname:  [DEFINITY DNE - Suitch

™ Login manually to system

Loginname:  [dinads
% Password: I,mm—
Pazzword [again): ixxxxx,m

 Access Secuity Gateway [A55]

Secret ke I

— Connections

Type | Dhal/Host | Fort | Device
W Metwork 19211136 23
W Metwork 19211136 23

Eraperties,., | Bemove I

Ok, | Caricel | Help |

7. Click on the ok button to complete the addition of the Switch item.
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By clicking on the Tree tab on the DSA window, you can see the newly
added DEFINITY ONE Switch Administration item. The screen will look
similar to the one below.

& DEFINITY Site Administration
File Edit iew Took window Help

| 5E=lax] (4|2 @] [oernimy one -swich ]
sl |

lﬁ workspace

#1-[2) DEFINITY OME - Switch

¥ Tasks U Tree I

x| Severity I Date/Time I Syztem I Description
A B info 09/01/1999 2.02:21...  estonia change system-parameters cdr E
ﬂ Info 0340141993 2.02:07...  estonia change system-parameters cdr _'
o Info 09/0141999 201:52...  estonia change system-parameters cdr
it 09/01/1999 201:%7...  estoria chsys cdr 3
4 | g
[ B History A Schedule f, Connection Status i
M

Ready
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For a new Voice Mail Administration item, click on file > new > Voice Mail System.
A screen similar to the one below will appear.

Voice Mail System Properties

r S}'Stclll

[
&

Svatem name;

m Logiu 1

™ Login manually to spstem

Login narne:

% Password:

Password [again];

—
—

g Apoess Security Gateway [A5G)

Secret key: i
~ Connection:
Type I Dial/Host | Port I Device
Add.. | Eraperties... | Hemowve |
0F | Cancel | Help |

1. Enter a name in the System name field. For technicians that are
configuring DSA on their laptops, use a generic name, as you will be able
to use this connection item for all DEFINITY ONE machines connected
over the PCMCIA physical connection.

2. Enter a login name and Password.

For Lucent Personnel enter one of the axxxx logins (atsc or acraft)
depending on the level of access desired along with the appropriate

password.

For non-lucent personnel enter one of the valid AUDIX Customer logins

(sa, vm, or browse) along with the appropriate password.
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Log in to AUDIX with ASG enabled

If the system is ASG-enabled, then you must click the | ogi n manual ly to
syst emcheck box. When you try to initiate a connection, an emulator screen will
pop up, prompting for login.

Log in as axxxx. You will be issued a challenge to which you must respond
correctly.

The system will ask for terminal type; do NOT enter a terminal type. Simply click
on the Continue button at the bottom of the screen.

M anual Login i

Enter vour login and pazsword or challenge responze at the prompts. %hen you have
entered the login and password [or responge]. press 'Continue".

MOTE: Press "Continue" at the "'Terminal Type'' prompt.
If you have already selected & terminal twpe, press "Cancel'’ and by again.

Login: acraft
Challenge: &654-1610 Product ID:7000000000
Fesponse: 4651915

TUnknown Terminal Type 'cygwin'
TERM=[at38e]?

Continue [F7) i Cancel Help
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Once you have populated the fields on the Voice Mail System Properties
page, the screen should look similar to the one below.

Yoice Mail Spztem Properties

~Syztem

g'-tll | Systemrname [DEFINITY ONE - Audi

™ Login manuslly o system

Login narme: |acrafl

(% Pasaword: Im—
Password (again); |1—

" Access Security Gateway [455)

Secret key: I

— Conrections

Tupe I Ciial/Host I Part I Device I

Add... | F'mpglties...l Eemoye |

Ok I Cancel | Help |
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3. Click on the Add button at the bottom of the screen. This is used to add a
physical connection mechanism from the client machine to the DEFINITY
ONE. Clicking on the Add button will pop up a screen similar to the one

below.
Connection Properties
Genaral |Advanced|
— Details
=
=
: Hust: I
Eort: I
™ Direct zerial port connection
Part: | I =
¥ = Modem or data module connection
Device: i :J
Fart cam [7]
Phone Mumber: !
Edipers. | | EdtDeviess. |
Qk. I Cancel | Apply | Help |
=—>» NOTE:

Regardless of the physical connection used i.e., Local
monitor/keyboard/mouse, PCMCIA, RAS modem or customer LAN, THE
CONNECTION TYPE IS ALWAYS A NETWORK CONNECTION.

=>» NOTE:
By default the Modem or data module connection radio button is
highlighted be sure to click on the network connection radio button.

4. Host: For the host address, enter the IP address that is commensurate
with the physical connection mechanism used to connect to the DEFINITY
ONE. See|Chapter H,]“Installer's Connectivity Quick Reference Tear-Out
Sheet”.

5. Port: For the port number, ALWAYS use port 23.
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6. Click on Apply followed by OK, this will dismiss the Connection Properties

page and put you back at the Voice Mail Properties page, similar to the
one below.

Voice Mail System Properties

— Sustem

g@ | Systemname:|DEFINTY ONE - Auds

~ Login

[ Login manually to spstem

Login hame: |acraft

5 Password: I—
Password (again): IW—

" Access Security Gateway [85G]

Secret keyw I

-~ Connection:

Type | Dial/Host | Port | Dievice
T Metwork 19211136 23

Flopertics.., | Hemawe |

Ok | Cancel | Help |

7. Click on the OK button to complete the addition of the Voice Mail System
Administration item.
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By clicking on the Tree tab on the DSA window you can see the newly
added DEFINITY ONE Switch Administration item. The screen will look
similar to the one below.

&' DEFINITY Site Administration
Eile Edt Yiew Took Window Help

= Bl @I%] )] [oerNTy ONE -Swich =]

“‘.‘f( Tasks i Tres I

x| Severiy | D ate/Time | Syztem | Deseription
o ﬂ Infa 03/01/41993 202:21...  estonia change system-parameters cdr
ﬂ Infa 03/01/41993 20207...  estonia change system-parameters cdr
ﬂ Infa 03/01/41993 201:52...  estonia change system-parameters cdr
ﬂ Infa 03/01/41993 201:37...  estonia chsps cdr
| | |
Ml 4| blbll\ HishnryA Schedule )\ Conneciion Statuz [
Ready MU 4

Starting a Switch Administration Session

To Launch a GEDI session:
1. Click on the tree tab of the DSA window

2. Right click on the newly created Switch Item (DEFINITY ONE - Switch in
our example)

3. Click on General
4. Click on Start GEDI

While the connection is being established, a screen similar to the one
below will be displayed.

Connecting

Setting up connection, pleaze wait....
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Once the connection has completed, a screen similar to the one below will
display.

& DEFINITY Site Administration - [DEFINITY ONE - Switch GEDI]

@ File Edit Wiew Toolz ‘Window Help _iﬁ'i_X__j

|&2] ] [2|&]| @] [oermTy onE -Swich =] |
=zl =l |

_:j send[rtn]i help [f5) Ecancel[esc]i eh

ﬁ Workzpace

Button Labels
DEFINITY OME - Audix
DEFINITY OME - Switch

|»

This system is restricted to authorized users
for legitimate business purposes. Unauthorized
access is a criminal vielation of the law.

Copyright (c) 1992 - Lucent Technologies
Unpublished & Mot for Publication
All Rights Reserved

- « | :IJ
“ Tasks 18 Tree i

Fieady

To Launch an emulation session:
1. Click on the tree tab of the DSA window

2. Right click on the newly created Switch Item (DEFINITY ONE - Switch in
our example)

Click on Advanced

4. Click on either 4410 Emulation or 513 Emulation
While the connection is being established, a screen similar to the one
below will be displayed.

Connecting

Sething up connechon, pleaze wait. .
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Once the connection has completed, a screen similar to the one below will
display.

Q‘ DEFINITY Site Administration - [DEFINITY OME - Switch Emulation]

e=l =] g [4|&| @ [oermiTyone -swich =] |
2| x| cancel i i i i help i i i

@ wiorkspace
~{E] Button Labels
) DEFIMITY ONE - Audix
] DEFIMITY OME - Switch

This system is restricted to authorized users
for legitimate business purposes. Unauthorized
access is a criminal violation of the law.

Copyright {c) 1992 - Lucent Technologies
Unpublished & Hot for Publication
All Rights Reserved

¥%, Tasks U8 Tree i

Feady

Starting a Voice Mail Administration Session
1. Click on the tree tab of the DSA window

2. Right click on the newly created Voice Mail System Item (DEFINITY ONE -
AUDIX in our example)

3. Click on either 4410 Emulation or 513 Emulation

While the connection is being established, a screen similar to the one
below will be displayed.

Connecting

—

Setting up conhection, pleaze wait...
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Once the connection has completed, a screen similar to the one below will
display.

Q‘ DEFIMITY Site Administration - [DEFIMITY ONE - Audix Emulation]

. [ |
&2|x| B| A& @) [oernTy oNE - swich =] |
=]
=
|2 Workspace i Alarms: none
Button Labels
DEFINITY ONE - Audi
DEFINITY ONE - Switch

enter clearfld help choices restpage | prevpage

refresh

cancel

enter command:

¥ Tasks P8 Tree ; 7 5

Ready [ [NOM | 4
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Message Manager Installation

This chapter provides the tasks required to install Message Manager.

This chapter is organized as follows:

[“Introduction” on page 8-1|

« [‘Pre-Installation Considerations” on page 8-2|

[‘Installation to a Client PC” on page 8-8|

Introduction

Lucent Technologies INTUITY Message Manager is a tool for handling multimedia
messages through the convenience of a personal computer (PC).

Message Manager allows you to access the AUDIX messaging system visually
through a local area network (LAN) connection. The AUDIX system is referred to
as the "AUDIX server" when it connects to a LAN.

This chapter describes the process for installing client copies of Message
Manager on the PCs of individual AUDIX users.

Standard Features

This Windows-based application provides the following features:

» Visual display of your AUDIX mailbox, with the ability to play voice
messages, view faxes and text messages, and launch or export file
attachments, through a simple graphic interface
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» A Personal Address Book for storing addresses and important information
on your PC, independent of the AUDIX server

» Personal folders for sorting and storing messages on your PC,
independent of the AUDIX server

» Soundcard support for playing and recording messages and greetings on
your PC, depending on availability of soundcard, speakers, and
microphone.

» Remote, off-site access to your messages through a high-speed modem
and TCP/IP (PPP) access to your LAN, depending on hardware availability

» The ability to receive, create, and send text messages and attached files

» Fax messaging, depending on the release and configuration of your
AUDIX server. Users can receive, forward, delete, print, or create fax
messages.

Related Documentation

The following information is available:

» To prepare your AUDIX system for Message Manager, refer to the
Message Manager section of the AUDIX electronic documentation.

= You can provide a Quick Reference Card to your users. Use the Guide
Builder program to create a customized guide that describes the features
and use of AUDIX and Message Manager.

» When Message Manager users select About Your System... from the Help
menu, they are viewing the custom.txt file. As the system administrator,
you can revise the custom.txt file to include any information you think will
be useful to your subscribers. See|‘Updating Your Site-Specific|

[nformation”]on page 8-17.

Pre-Installation Considerations

This section describes Message Manager Release 4.5 installation prerequisites
and the installation choices for setting up and running Message Manager.

PC Requirements

Verify you have the following minimum hardware and software:
= One of the following compatible operating systems:
— Windows NT Version 3.51, with Service Pack 5
— Windows NT Version 4.0
— Windows 95
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Minimum of a 486, 66 MHz PC with 16 Mbytes of RAM and 19 Mbytes of
available hard disk storage (assuming a Personal Address Book with 400
entries). Exceptions:

— The tutorial requires an additional 10 Mbytes of disk storage.

— Your operating system may recommend additional RAM for better
performance (for example, 32 Mbytes of RAM for Windows NT).

VGA or higher monitor (color recommended)
LAN interface card

Windows Sockets (WINSOCK.DLL) access to TCP/IP (either through a
NetWare Loadable Module or TCP/IP protocol stack)

Recommended: Mouse supported by Microsoft Windows

For remote access: Microsoft Windows-compatible soundcard with
speakers and a microphone

Optional: Speakerphone, telephone headset, or a Microsoft
Windows-compatible soundcard with speakers, microphone, or a
computer headset for hands-free operation

Installation Prerequisites

Before you install Message Manager, make sure your PC and LAN are ready to
support Message Manager as follows:

On your PC, log into the network and bring up Microsoft Windows.

Get a server name or TCP/IP address of a machine in your network from
your LAN administrator, then run the ping program from a DOS prompt in
Windows ("ping" the address or name). A ping from the DOS shell without
Windows running is not a good test. Ask your LAN administrator how to
access or use this utility if you need help.

If the ping fails or the system hangs, install Message Manager and click
on the Message Manager Help icon in the Message Manager program
group. Search for "General Troubleshooting” for additional options.

If you install a shared copy of Message Manager for users to run on the
LAN and copy Message Manager software to a LAN server for easy
distribution, the executable Message Manager software and the copy of
the software CD must be in different directories.

For Windows NT, you must have administrative privileges or be logged in
as Administrator to successfully install the fax package.
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Operating System Considerations

The Message Manager Setup program automatically tailors Message Manager to
work with the operating system installed on your PC. Operating system
considerations include:

» Message Manager Release 4.5 runs as a 32-bit application on Windows
95 and Windows NT (NT version 3.51 requires Service Pack 5).

» Message Manager Release 4.5 cannot run on Windows 3.1, 3.11, or NT
3.51 that lacks Service Pack 5. To run Message Manager on a 16-bit
system, obtain Message Manager Release 4.3.

» If you change operating systems, you must reinstall Message Manager.
Also, if your PC is set up to run multiple operating systems (such as
Windows NT and Windows 95), Message Manager must be installed
separately for each operating system.

Select Installation Type

Several methods of installation and operation are available for Message
Manager. As you are completing the install process, you will need to designate
what type of installation you want for your site.

» Single User Install. You can install a copy of Message Manager on each
user’s PC using either of the following distribution methods:

— Share or copy the CD that was included in your installation
package.

— Download compressed Message Manager files from the DEFINITY
Office browser interface or your intranet.

» Copy from LAN Server. You can install a copy of Message Manager on
your PC by accessing the software through a LAN file server. This method
allows administrators to easily distribute Message Manager through a LAN
rather than passing around the CD or downloading compressed files. See
[‘Installing Message Manager from a LAN Server”on page 8-14.

» Run from LAN Server. All users on a LAN server share a single copy of
Message Manager. Because the Message Manager software exists only
on the LAN file server, it can be easily updated by the LAN administrator.
See|[Installing and Accessing a Shared Copy of Message Manager”|on

page 8-10.

» Automated Installation. You can start an automatic installation to load
users’ computers with an entire set of application software, including
Message Manager, as defined by your company. This method allows
administrators to easily distribute a uniform set of user software to all
computers. See|‘Using the Automated Installation Process”|on page 8-15.
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Advantages and disadvantages of installation and operation choices

Install Method

Advantages

Disadvantages

Single userinstall
froma CD

Fast load for users with slow
LAN connection (remote
access).

Administrator cannot
password-protect the CD.

Requires CD distribution at
each update

Single user install
via browser
download

Users can install the
software themselves.

Stand alone executable that
only requires temporary
LAN access during install.

Increases network traffic
during installation

LAN distribution

Fast load for users with LAN
connection.

Secure — directory can be
password-protected.

No CD to manage.

Users easily updated if
software changes.

Requires disk space on
LAN server

Increases network traffic
during installation

Shared copy on
LAN

Saves disk space on user’s
computers.

Secure — software can be
password-protected.

No diskettes to manage

Users easily updated if
software changes

Requires disk space on
LAN server

Can greatly increase
network traffic

May have much slower
execution speed,
depending on LAN
performance

Automated
installation

Simplest install for users
Administrator resources
required only initially

Fast load for users with slow
LAN connection (remote
access)

System administrator must
custom-build, load and
distribute installation media.

Requires software media
distribution at each update
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Upgrade Considerations

If you're upgrading from an earlier release of Message Manager to Release 4.5,
you'll be able to choose whether you want to replace your existing version of
Message Manager or keep two versions of Message Manager installed on the
same PC.

Before Installation

Make a backup copy of the following directories and their contents:
»  Workbench (Workbnch)
» Personal Folders (default names are PF1, PF2, PF3, PF4, and PF5)
» Address Book (PBOOK.MDB)

During Installation

» Close all Windows programs, including your current version of Message
Manager.

» To save a copy of your current Message Manager software, select a new
directory name and program group when you install Release 4.5

= When you install the Message Manager "basic" software, it removes any
Message Manager fax print drivers from the computer. Also, although you
can have two releases of Message Manager on the computer, you can
only have one set of fax print drivers.

» After you install the basic software, install (or reinstall) the fax software that
corresponds with the Message Manager release you will use for faxing.

After Installation

= The first time you open Message Manager Release 4.5, you'll be asked to
choose whether to convert your existing workbench and personal folders
to the new release.

— If you convert them, the messages in them can no longer be
accessed by earlier releases of Message Manager.

— If you do not convert your personal folders, you must set up new
personal folders in Release 4.5 under the main screen File menu.
To later convert a personal folder, select the folder as one of your
Release 4.5 personal folders.
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» If you choose to keep a previous version of Message Manager, Release
4.5 uses the Address Book, Personal folders, and Workbench files located
in the directory that was established with the previous version of Message
Manager. To protect your files from accidental deletion, use File Manager
or Explorer to copy the following directories and files into the directory
where you install Release 4.5:

— PF1, PF2, PF3, PF4, and PF5 (and their contents). Then select Set
Personal Folder Properties from the File menu to set each new file
location.

— Workbench (and its contents). Then use Select Workbench
Directory from the File menu to set the new file location.

— PBOOK.MDB. To set the new location, open the Personal Address
Book, select Open from the File menu, browse to the new location,
and select PBOOK.MDB.

» The installation process provides several shortcut icons in the Message
Manager Windows program group and Start menu. The following icons
are valid for Message Manager Release 4.5:

— Fax Cover Page Wizard
— Help - US English

— Message Manager

— Personal Address Book

— ReadMe

Uninstalling Message Manager

Previous versions of Message Manager stay on your system until you replace or
remove them. The way that you uninstall Message Manager depends on which
release of Message Manager you wish to remove:

» Toremove Message Manager Release 4.3 or earlier, you can overwrite the
files by loading Message Manager 4.5 into the same directory, or you can
delete the Message Manager directory and files. See[‘Upgrade]
[Considerations”|on page 8-6.

» Toremove Message Manager Release 4.5 or later, you can remove the
application by running unwise.exe from the Message Manager directory.
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Installation to a Client PC

During the installation process, you will have to designate the following:
= Which installation type to perform

» Which parts of the application to install (basic and/or fax packages). For
Windows NT, you must be logged in as Administrator to successfully
install the fax package.

=  Whether users will run Message Manager from their PCs or share a copy
from the LAN. See[“Select Installation Type”|on page 8-4.

=  Whether to back up files (in the case of upgrades and reinstalls)

Single User Installation Process

The default method of installation is from a CD or intranet site to a single PC. The
installation table in this chapter assumes that you are installing to a single PC.
Other install and operation methods (install from a LAN, run shared copy from a
LAN, and automated install) are described in subsequent sections.

1. Perform one of the following:
— Obtain the Installation CD.

— From the DEFINITY Office browser page or an intranet site
designated by your system administrator, download the Message
Manager software file to a temporary directory on the PC. Use File
Explorer to double-click the downloaded file to decompress it.

— Navigate to a LAN directory designated by your system
administrator.

2. Run setup.exe.

3. Complete the steps listed in the ffollowing table|to install Message

Manager Release 4.5.
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Table 8-2. Single User Install Screens

Screen Name Notes

Welcome

License File

Tell Me About... Included on your Message Manager CD are the following

information tools:
» Install description
= User Overview/Tutorial

=« Documentation

Select Installation Type

The following installation choices are described in
[Installation Type”]on page 8-4:

» Single User Install (Continue with the instructions in this
table.)

» Shared Installation (Go to[‘Installing and Accessing al

Shared Copy of Message Manager”|on page 8-10.)

» Copy for LAN Installation (Go to["Installing Message|
[Manager from a LAN Server”’|on page 8-14.)

» Automated Installation is available, although it is not a
selection on the Installation Type screen. (Go to
Automated Installation Process”|on page 8-15.)

Important! message

You should close any open software applications. For
Windows NT, you must have administrative privileges or be
logged in as Administrator to successfully install the fax
package.

Select Destination
Directory

If you want to load the program in a directory other than the
default, browse to the directory of your choice. If you want to
create a new directory, type the path for the new directory in
the Select Destination Directory dialog box.

Backup Replaced
Files

Backed up files are saved in the Backup directory. Personal
Folders, Workbench, and Address Book files are not
automatically backed up; see|‘Upgrade Considerations”|on

page 8-6.

Select Components

For a complete installation, select Message Manager and FAX.
To add fax to a previous installation, just select FAX.

Continued onlnext page



DEFINITY ONE Communications System Release 1.0 Issue 1
Installation and Upgrades 555-233-109 December 1999

8 Message Manager Installation

Installation to a Client PC

8-10

Table 8-2. Single User Install Screens — Continued

Screen Name

Notes

Enter FAX Information

If you selected FAX on the Select Components screen, you
may enter the Server ID and Extension. The information
determines which AUDIX mailbox opens when the user
creates a fax. You can select Options/Preferences in Message
Manager to add or update this information at a later time.

Ready to Install,

Installation Status
Indicator

When you click Next on the Ready to Install screen, you'll see
the Status Indicator and a listing of the installed files.

hints.txt

The hints.txt screen contains a description of each program
group icon.

Installation Complete,

Restart dialog box

The newly installed Message Manager will take effect when
you restart the computer.

Continued onlnext page

4. Restart Windows to complete the installation process.

Installing and Accessing a Shared Copy of

Message Manager

For this method of installation, the system administrator installs a single, shared
executable copy of the software on a LAN server, customizes certain files, then
installs (or notifies users to install) Message Manager to individual PCs. When
users install Message Manager to individual PCs, a minimal set of files are
loaded, including msg_magr.ini, Personal Folders, and the Message Manager
print driver if the fax package is installed.

When a user double clicks the Message Manager icon, the application is loaded
from the server to the client computer’'s RAM. The user can leave Message
Manager running throughout the day without affecting other users.

1. Run setup.exe.

2. Complete the steps listed in the[following table]to install Message
Manager Release 4.5 on the LAN server.
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Table 8-3. Shared Installation Setup.exe Screens
Screen Name Notes
Welcome
License File
Tell Me Abouit... Included on your Message Manager CD are the

following information tools:
» Install description
= User Overview/Tutorial

= Documentation

Select Installation Type

Select Shared Installation. Installation choices are
described in[‘Select Installation Type|on page 8-4.

Important! message

You should close any open software applications.
For Windows NT, you must have administrative
privileges or be logged in as Administrator to
successfully install the fax package.

Select Destination
Directory

Designate or create the directory on your LAN
server that will contain the Message Manager
software. If you want to load the program in a
directory other than the default, browse to the
directory of your choice. If you want to create a new
directory, type the path for the new directory in the
Select Destination Directory dialog box.

Backup Replaced
Files

Backed up files are saved in the Backup directory.
Personal Folders, Workbench, and Address Book
files are not automatically backed up; see
[‘Upgrade Considerations”|on page 8-6.

Select Components

For a complete installation, select Message
Manager and FAX. To add fax to a previous
installation, just select FAX.

Enter FAX Information

For Shared Installations, you should leave these
fields blank. The information determines which
AUDIX mailbox opens when the user creates a fax.
You can select Options/Preferences in Message
Manager to add or update this information at a later
time.

Continued on|next page
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Table 8-3. Shared Installation Setup.exe Screens — Continued

Screen Name Notes
Ready to Install, When you click Next on the Ready to Install screen,
. you'll see the Status Indicator and a listing of the
Installation Status ; ,
) installed files.
Indicator
hints.txt The hints.txt screen contains a description of each

program group icon.

Installation Complete, The newly installed Message Manager will take
effect when you restart the computer.

Restart dialog box

3. Customize any of the following text files to suit the needs of your users:

» custom.txt is the file that Message Manager users see when they
select About Your System... from the Message Manager Help
menu. See|“Updating Your Site-Specific Information”|on page 8-17.

» hints.txt contains a description of each program group icon.

4. Install (or instruct your users to install) the necessary user files and print
driver to each individual PC by navigating over the LAN to the shared
directory (created during the LAN server install above) and running the
SH_Setup.exe program. The following table includes a description of the
SH_Setup.exe install process.

Table 8-4. Shared Installation SH_Setup.exe Screens

Screen Name Notes
Welcome
License File
Important! message You should close any open software applications.

For Windows NT, you must have administrative
privileges or be logged in as Administrator to
successfully install the fax package.

Continued onlnext page
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Table 8-4. Shared Installation SH_Setup.exe Screens — Continued

Screen Name

Notes

Select Destination
Directory

A minimal set of files must be loaded on the client
PC. If you want to load the program in a directory
other than the default, browse to the directory of
your choice. If you want to create a new directory,
type the path for the new directory in the Select
Destination Directory dialog box.

Backup Replaced
Files,

Select Backup
Directory

If you want to back up the replaced system files,
you can accept the default directory or browse to
the directory of your choice. If you want to create a
new directory, type the path of the new directory in
the Select Destination Directory dialog box Personal
Folders, Workbench, and Address Book files are

not automatically backed up; see[‘Upgrade]

[Considerations”{on page 8-6.

Select Components

For a complete installation, select Message
Manager and FAX. To add fax to a previous
installation, just select FAX.

Enter FAX Information

If you selected FAX on the Select Components
screen, you may enter the Server ID and Extension.
The information determines which AUDIX mailbox
opens when the user creates a fax. You can select
Options/Preferences in Message Manager to add or
update this information at a later time.

Ready to Install,

Installation Status
Indicator

When you click Next on the Ready to Install screen,
you'll see the Status Indicator and a listing of the
installed files.

hints.txt

The hints.txt screen contains a description of each
program group icon.

5. Restart Windows to complete the installation process.
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Installing Message Manager from a LAN Server

For this method of installation, the system administrator copies and
decompresses the software from the CD to a LAN server, customizes certain
files, then installs (or notifies users to install) Message Manager Release 4.5 to

individual PCs.

1. Run setup.exe.

2. Complete the steps listed in the following table to copy and decompress

the installation files.

Table 8-5. Copy for LAN Installation Screens

Screen Name Notes

Welcome

License File

Tell Me Abouit... Included on your Message Manager CD are the

following information tools:
» Install description
= User Overview/Tutorial

= Documentation

Select Installation Type

Select Copy for LAN Installation. Installation
choices are described in|‘Select Installation Type”]|

on page 8-4.

Select Destination
Directory

Browse to or type the path for the directory in the
Select Destination Directory dialog box.

Ready to Install,

Installation Status
Indicator

When you click Next on the Ready to Install screen,
you'll see the Status Indicator and a listing of the
installed files.

hints.txt

The hints.txt screen contains a description of each
program group icon.

3. Customize any of the following text files to suit the needs of your users:

» custom.txt is the file that Message Manager users see when they
select About Your System... from the Message Manager Help

menu. See|“Updating Your Site-Specific Information”|on page 8-17.

» docs.txt describes the electronic user documents and is viewable
during the install process.

» hints.txt contains a description of each program group icon.
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» install.txt describes the install choices and is viewable during the
install process.

» readme.txt contains late-breaking information about Message
Manager Release 4.5 and is viewable at the end of the Single User
Install process.

» tutorial.txt describes the computer-based Overview tutorial and is
viewable during the install process.

4. Install (or instruct your users to install) the application to each individual
PC by navigating over the LAN to the shared directory and performing the
[‘Single User Installation Process”|on page 8-8.

Using the Automated Installation Process

For this method of installation, the system administrator updates the silent.txt
(template) file and installs the software over the LAN to users’ computers.

1. Copy the silent.txt text from the Message Manager Release 4.5 CD to your
computer. The file contains the following text:

rem This is the Prototype Silent Install Settings File

rem This file is used to create a Silent Installation of
rem Message Manager version 4.5

rem To use this settings file, invoke the installation

rem as follows:

rem

rem <path>\Setup.EXE /M=<path2>\Silent. TXT

rem

rem Where <path> is the location of the Setup.EXE installation
rem executable

rem and <path2> is the location of the Silent.TXT file being
rem used

rem Following are the Variables and values required for
rem installation. Spelling and Capitalization are
rem CRITICAL!

rem Following line is required - do not change
SILENT=1

rem Following line is required - do not change
INSTALLTYPE=A

rem Following line is required - do not change
LANGUAGES=A
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rem Following is for "What to Install”

rem

rem use A for Basic, B for FAX, AB for both
COMPONENTS=AB

rem Following is used only for FAX install

rem

rem Provide the values for the FAX Server and Extension
rem Spelling is critical

rem

rem if left blank, install will use the previous values

rem from the msg_magr.INI file (if present)

FAXSERVER=

FAXEXTENSION=

rem Following is for Installation Location

rem

rem Directory location for Installation

rem

rem Example - MAINDIR=C:\MSG_MGR

rem Example - MAINDIR=C:\Program Files\Lucent\Message Manager
MAINDIR=C:\Program Files\Lucent\Message Manager

rem Following is for Backup of replaced files during

rem installation

rem

rem Use A for True, B for False

DOBACKUP=A

rem Following is for backup directory

rem If backup is not selected, file name is not used
BACKUP=C:\Program Files\Lucent\Message Manager\backup

rem Following is the Name of the Program Manager Group
rem for Message Manager installation.

rem Spelling is critical

GROUP=Message Manager

rem Following is the re-boot flag

rem Windows must be re-booted before using Message Manager
rem Setting this flag will cause the install to query the

rem user about the reboot

rem Clearing this flag will not reboot, and will not ask

rem the user

rem Use S for System Reboot (recommended), W for Windows
rem reboot, and nothing for no reboot.

RESTART=S

rem End of silent install parameters
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2. Customize your copy of silent.txt to specify the following:
» COMPONENTS
» FAXSERVER
» FAXEXTENSION
= MAINDIR
« DOBACKUP

3. Follow the instructions in silent.txt to invoke the automatic installation
process.

Updating Your Site-Specific Information

Message Manager Release 4 and later allows users or administrators to update a
custom file with site-specific information such as the AUDIX server ID, prefixes,
text-addressing format, feature-access codes, and help numbers. Users access
the custom file by selecting About Your System from the Help menu on the
Message Manager main screen.
To update the default custom file or supply your own quick-reference file:

1. Access the directory where you installed Message Manager Release 4.5.

2. Locate the default custom.txt file template automatically provided with
Message Manager. To update this file:

» Open the custom.txt file using any ASCII text editor.
» Follow the instructions in the template and save the file.

3. To install your own custom file of a different type (such as .doc or .hlp):
» Move or rename the default custom.txt file template.

» Put your custom file in the same directory as the executable
Message Manager msg_mgr.exe file. Your file must be named
custom.

» If you use a file type other than .txt, you must have a computer
application associated with that extension, or the custom file will not
run.
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Updating the custom file varies according to your installation setup:

Users who share a copy of Message Manager on a LAN server all access
the same custom file, either the default template or the system
administrator’s version. If the administrator later updates the custom file,
all users automatically access the new version the next time they run
Message Manager.

Users who install their own copy of Message Manager on a PC from a LAN
server initially get the custom file (either the default or the administrator’s
version) from the server. If this file is later updated, users must manually
copy it from the server or reinstall Message Manager.

Users who install Message Manager by CD must update their custom files
independently. The administrator may provide a modified custom file for
users to copy into their application directory after installation (distributed
on diskette, as an attached file, or through a LAN server). If you do this,
include directions for users to rename or remove the old or default
custom.txt file.
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Troubleshooting

This chapter provides troubleshooting information specific to the installation
process. This information will include problems that:

» are new and have never been worked through before
» can happen after new installation
» can happen after installation when installation has worked and something

goes wrong

This chapter is organized as follows:

« [‘Install Wizard Error Messages” on page 9-1f

« [‘Platform Troubleshooting Commands” on page 9-5|

« [‘Modem Setup and Administration” on page 9-6

Install Wizard Error Messages

The following are error messages that could occur while using the DEFINITY
ONE installation wizard.
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Error Message

Possible Explanation/Remedy

Unable to set the registry
default root to HKEY _
LOCAL_MACHINE

The registry key HKEY_LOCAL_MACHINE is
not accessible from the install wizard. Make
sure that the registry key is accessible.

DEFINITY ONE is still
running. Please shut it down.
Then start the install again.

The install wizard cannot execute while
DEFINITY ONE is running. The following
command, shutdown all, shuts down all the
applications related to DEFINITY ONE.
Execute this command and after it
completes, rerun the install wizard.

Unable to shut the
CornerStone logger down.
Please shut it down manually
and restart the install
program.

Execute
C:\\LucentSoftware\CornerStone\mtce\bi
n\csShutdownlog.exe. Then execute the
command
C:\\LucentSoftware\CornerStone\bin\cslo
g_server.exe -UnregServer. This should
shut down the CornerStone logger. Then
rerun the install wizard.

Unable to register the
following files XXXX,yyyy,......

This indicates that the install program is
unable to self register the mentioned files.
Register the DLLs manually using the
command regsvr32.

Unable to Reboot machine.
Please reboot now.

This indicates that the install wizard tried to
reboot the machine, but was not successful
for some reason. It tried to reboot the
machine because some of the files were not
installed properly (they might be in use). The
installer must manually push the shutdown
button on the front of the TN795 and power
cycle.

Unable to set xxxx:yyyy from
[ ffff].

This indicates that install wizard had trouble
reading the key yyyy from section xxxx in the
ini file ffff. Check the following things:

= The ini file ffff should be in the same
directory as Setup.exe (install wizard).

= The ini file ffff should have read
permissions.

= The ini file ffff has the section xxxx and a
value for the key yyyy.

Unable to determine screen
resolution.

Escalate.
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Error Message

Possible Explanation/Remedy

Screen resolution must be at
least 640x480.

The install wizard requires that the screen
resolution be at least 640x480.

Unable to determine the Escalate.
operating system.
Unable to determine the Escalate.

operating system version.

Operating system must be
Window NT 4.0.

This indicates that the underlying OS is not
Windows NT 4.0.

You must have administrator
privileges to run this
program.

This indicates that the installer doesn’t have
administrative privileges.

Unable to get the free disk
space on X drive.

Escalate.

Not enough space on X drive
for new install. Space
required is Y.

There isn’t enough space on X drive for a
new installation. Free up some space and
make sure that there is at least Y MB space
on drive X.

Not enough space on X drive
for an upgrade. Space

There isn’t enough space on X drive for an
upgrade. Free up some space and make

required is Y. sure that there is at least Y MB space on
drive X.

Unable to parse path. Escalate.

Unable to remove last slash Escalate.

from path.

Unable to get current path. Escalate.

Unable to create [ XXXX]. Escalate.

A target directory could not
be created.

Make sure that the path is syntactically
correct and you have access rights to the
target drive.

Unable to allocate the
memory required to
complete the copy file
process.

Terminate as many running applications as
possible to free memory.

Not enough disk space on
the target drive to copy the
files.

Free disk space on the target drive.

Unable to open the input file.

Make sure the source file is a valid filename,
and that the source file as well as the target
directory exist.
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Error Message Possible Explanation/Remedy
Unable to copy the Escalate.

requested file.

Target file is read-only. Remove the read-only attribute from the
target file and try again.

A self-registering file did not  Escalate.
register successfully.

Unknown error. Escalate.
Unable to copy file [ X]. Escalate.
Unable to get directory Escalate.
name.

Unable to parse directory. Escalate.
Unable to create Substring Escalate.
section list.

Unable to open file X. Escalate.

Unable to merge [ X] intothe  Escalate.
Registry.

The following are warnings that may be generated by the installconfig wizard.
Attempt to manually resolve these. They are not significant errors. Make notes in
the log book and continue.

» Unable to get the AUDIX extension length.

=« Unable to add DSA shortcut to Start Menu.

» Unable to reset AUDIX extension length to xxxx.

» Unable to get file size.

» Unable to get the product version from the last install.

» Unable to create directory.
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Platform Troubleshooting Commands

The following commands may be useful in troubleshooting.

alarmorig turns on alarm origination from the GAM (INADS)

alarmstat gives global alarm (GAM, DEFINITY, AUDIX) status
(for technician/TSC)

cleargamalarm clears alarms after analysis (for technician/TSC)

dlstat displays status of all application groups running on
the system

environment displays temperature and voltage levels on the TN795
board

ftpserv installs patches and license files (INADS)

gamalarmstat displays GAM alarms (for technician/TSC)

installconfig installs license file (INADS)

lucent help list all commands

0SS sets telephone numbers for outgoing INADS calls

reboot reboots system (for technician/TSC)

restartcause displays the restart causes for system (for
technician/TSC)

serialnumber displays the serial number (for technician/TSC)

setip displays network parameters

shutdown shuts down the system or applications

See[‘bash Commands’|on page G-1 for more information on commands. More
detailed strategic analysis of each command is located in the DEFINITY ONE
Maintenance Manual.
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Modem Setup and Administration

To check settings and test the external modem, refer to the following procedures:

[“Configure Modem” on page 9-6|
[“Verify INADS Modem Settings” on page 9-6|

[“Verify External Modem Option Settings” on page 9-6|

[‘Configure a Different External Modem” on page 9-7|

« [|‘Test the External Modem” on page 9-9|

Configure Modem

=>» NOTE:
The modem (U.S. Robotics Model) is preconfigured and should work
correctly.

Verify INADS Modem Settings
No External Modem Installed
If there is no External Modem connected to INADS, that is, there is no Alarm
Origination to INADS, follow this procedure.

1. Enter display system-parameters maintenance and press Enter.

2. Verify that the Alarm Origination Activated to OSS Numbers field is setto n
and press Enter.

3. Verify that Cleared Alarm Notification and Restart Notification are set to n.

External Modem Installed
1. Enter display system-parameters maintenance and press Enter.

2. Verify that the Alarm Origination Activated to OSS Numbers field is setto y
and press Enter.

3. Verify that the Cleared Alarm Notification and Restart Notification fields are
settoy.

Verify External Modem Option Settings

1. Follow the procedure Start a pcANYWHERE Client Session from the
Laptop Computer to connect to pcANYWHERE.

2. Click Start > Settings > Control Panel.
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3. Double click Modems.

10.
11.

12.
13.

You receive a Modem Properties screen that should show the US
Robotics 336K FAX Ext modem.

Click Next.

You receive another Modem Properties screen.

. Verify that the port the modem is attached to is COM1.

Click Next.
You receive another Modem Properties screen.

Right click Properties.

. You receive the Properties screen.

Verify that the defaults for speed and speaker volume are set.
Click Connection.

Verify that Databits is 8, Parity is none, and Stop bits is 1.
Click Advanced.

You receive the Advanced Connection Settings screen.
Verify that the defaults are set.

Click OK > Close.

Configure a Different External Modem

=>» NOTE:

This procedure is only necessary if you choose not to use the modem
shipped with the system.

Follow the procedure Start a pcANYWHERE Client Session from the
Laptop Computer to connect to pcANYWHERE.

2. Click Start > Settings > Control Panel.

Double click Modems.
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You receive the Modem Properties screen.

Install New Modem

windows MT will now try to detect your modem.  Before
continuing, you should:

1. If the modem iz attached to your
computer, make sure it is turned on.

2. Quit any programs that may be using the
modern.

Click Mext when you are ready to continue.

™ Don't detect my modem; | will select it from a list]

< Back I Mest » I Cancel |

4. Put a check by Don't detect my modem. | will select it from a list
5. Click Next.

You receive an Install New Modem screen.
6. Click Add.

You receive another Install New Modem screen.

7. Click on the manufacturer (3COM Corp) and the model (US Robotics
336K FAX Ext).

8. Click Next.
9. Highlight the port the modem is attached to (COM1).
10. Click Next.

You receive the Modem Setup screen that tells you that you need to
restart the modem before you can use it.

11. Click Finish > OK.

You receive another Install New Modem screen that tells you that your
modem has been set up successfully. Then you receive the Modem
Properties screen.

Once the modem is installed, it needs to be configured.
12. Right click Properties .

You receive the Properties screen.
13. Click OK to accept the defaults for speed and speaker volume.
14. Click the Connection tab.

15. Click OK to accept the defaults For Data bits (8), Parity (none), Stop bits
(1), and Call Preference.

16. Click the Advanced button.

You receive the Advanced Connection Settings  screen.
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17. Click OK to accept the defaults.
18. Click OK > Close.
You receive the Modem Properties screen.
19. Click Close.
You receive the message “Dial-up Networking needs to be configured
because the list of installed modems has changed. Would you like to do
this now?”
20. Click Yes.
21. You receive the Remote Access Setup screen that confirms that the

modem is configured.

Test the External Modem

1.

At the SAT session, type change system parameters maintenance, and
press Enter or Submit.

Make sure that the Test Remote Access Port? field is set to y.

. Type test pr-maintenance and press Enter or Submit.

. Verify that test 230 passes.

See DEFINITY Enterprise Communications System R7 Administration for
Network Connectivity (555-233-501) for more information.
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Security and Copy Protection

This chapter provides information about security and software copy protection.

This chapter is organized as follows:

[‘Security Checklist” on page 10-1|

[‘Software Copy Protection Mechanisms” on page 10-2|

Security Checklist

The Lucent provided applications shall satisfy the requirements contained in the
Security Standards Checklist, Compas ID 52302, when loaded on DEFINITY ONE
to the same extent that they do presently. The Windows NT operating system will
not be modified. All available options and features within the Windows NT
operating system shall be activated in such a way as to meet or exceed the
requirements of the Security Standards Checklist. However, there may be
instances where the Windows NT operating system does not support specific
requirements of the check list. Discovered cases of feature outage in Windows NT
shall be documented and a policy written to address each one which shall include
a request to Microsoft for a Windows NT enhancement.
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Software Copy Protection Mechanisms

This section provides information about software copy protection mechanisms for
installation, repair, and upgrade procedures as they relate to the TSC/COE

The opportunity to copy the software from one machine to another is more of an
issue with DEFINITY ONE’s Windows NT platform running the three primary
applications (DEFINITY, AUDIX, and DSA) than it would be on a proprietary
system.

The objective of security measures is to add a level of impedance (time, money,
expertise, etc.) in the process to discourage people from copying something for
which they do not have permission. It is always possible for someone to break into
a system to which they have physical access. There are two types of software
protection in the DEFINITY ONE environment: feature protection and copy
protection.

Feature Protection

Feature protection protects specific feature capabilities or capacities within an
application. It controls what capabilities are provided by the application once it is
allowed to run. For example, DEFINITY has a feature called Translation copy
protection and supports a “customer options” administration form to tailor
DEFINITY operation to a specific customer.

Copy Protection

Copy protection attempts to prevent the copying of software from one machine to
another for the purpose of providing service on the second machine without
paying Lucent for the privilege. It attempts to prevent an application from running
at all.

A special mechanism in association with the license file on DEFINITY ONE
prevents the software from running on other systems.
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Cable Pinouts

This appendix provides TN760D Tie Trunk and TN464E/F option settings,
connector and cable diagrams, and pinout charts.

This chapter is organized as follows:

« [“TN760E Tie Trunk Option Settings” on page A-1|
« [“TN464F Option Settings” on page A-4]

»« [‘Connector and Cable Diagrams —Pinout Charts” on page A-6|

TN760E Tie Trunk Option Settings

The TN760E Tie Trunk circuit pack interfaces between 4 tie trunks and the TDM
bus. Two tip and ring pairs form a 4-wire analog transmission line. An Eand M
pair are DC signaling leads used for call setup. The E-lead receives signals from
the tie trunk and the M-lead transmits signals to the tie trunk.

To choose the preferred signaling format|(Table A-1land |Tab|e A-2),|set the

switches on the TN760D and administer the port using [Figure A-1|and ffable A-3]
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Table A-1. Signaling Formats for TN760E
Mode Type
E&M Type | Standard (unprotected)
E&M Type | Compatible (unprotected)
Protected Type | Compatible, Type | Standard
Simplex Type V
E&M Type V
E&M Type V Revised
Table A-2. Signaling Type Summary
Signaling Type Transmit (M-Lead) Receive (E-Lead)
On-Hook Off-Hook On-Hook Off-Hook
Type | Standard ground battery openllbattery ground
Type | Compatible openllbattery ground ground openllbattery
Type V openllbattery ground open ground
Type V Reversed ground open ground open
1. Anopen circuit is preferred instead of battery voltage.
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UNPROT
H n H n SMPLX SMPLX SMPLX SMPLX
4 3 2 1 o o o o o o o o
PROT E PORT 4 E PORT 3 E PORT 2 E PORT 1
E&M E&M E&M E&M
758183 RBP 050896
Figure A-1. TN760D Tie Trunk Circuit Pack (Component Side)
Table A-3. TN760E Option Switch Settings and Administration
E&M/SMPLX | Prot/Unprot | Administered
Installation Situation Preferred Signaling Format | Switch Switch Port
Circumstance | To System Far-End
Collocated DEFINITY E&M Type 1 | E&M Type 1l | E&M Unprotected | Type 1
Compatible Standard Compatible
Inter-Building DEFINITY Protected Protected E&M Protected Type 1
Type 1 Type 1
Compatible Standard Compatible
Plus
Protection
Unit
Collocated Net E&M Type 1 | Any PBX E&M Unprotected | Type 1l
Integrated
Standard
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TN464F Option Settings

The TN464E/F DS1/E1 Interface - T1/E1 circuit pack interfaces between a 24- or
32-channel Central Office/ISDN or tie trunk and the TDM bus.

Set the switches on the circuit pack to select bit rate and impedance match. See
Table A-4 and [Figure A-2]If the top switch setting is set to 32 Channel, then you
need set the lower switch setting to either 120 Ohm or 75 Ohm.

Table A-4. Option Switch Settings on TN464F

120 Ohms Twisted pair

75 Ohms Coaxial requiring 888B adapter
32 Channel | 2.048 Mbps
24 Channel | 1.544 Mbps
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Figure Notes
1. TN464F 3. 24/32 Channel Selector (24CH

2. Option Switch shown)
4. 75/120 Ohm Selector (120 Ohm
shown)

Figure A-2. TN464E/F Option Settings
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Connector and Cable Diagrams —

Pinout Charts
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See Table A-5 for typical lead designations. The circuit packs and auxiliary
equipment are classified as shown in the following tables.

Table A-5. Lead and Color Designations

Cross-Connect Amphenol
Pin Color Pin Backplane Pin
1 W-BL 26 102
2 BL-W 01 002
3 W-O 27 103
4 Oo-W 02 003
5 W-G 28 104
6 G-W 03 004
7 W-BR 29 105
8 BR-W 04 005
9 W-SL 30 106
10 SL-W 05 006
11 R-BL 31 107
12 BL-R 06 007
13 R-O 32 108
14 O-R 07 008
15 R-G 33 109
16 G-R 08 009
17 R-BR 34 110
18 BR-R 09 010
19 R-SL 35 111
20 SL-R 10 011
21 BK-BL 36 112
22 BL-BK 11 012
23 BK-O 37 113
24 O-BK 12 013

Continued onlnext page
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Table A-5. Lead and Color Designations — Continued

Cross-Connect Amphenol
Pin Color Pin Backplane Pin
25 BK-G 38 302
26 G-BK 13 202
27 BK-BR 39 303
28 BR-BK 14 203
29 BK-SL 40 304
30 SL-BK 15 204
31 Y-BL 41 305
32 BL-Y 16 205
33 Y-O 42 306
34 Oo-Y 17 206
35 Y-G 43 307
36 G-Y 18 207
37 Y-BR 44 308
38 BR-Y 19 208
39 Y-SL 45 309
40 SL-Y 20 209
41 V-BL 46 310
42 BL-V 21 210
43 V-O 47 311
44 Oo-V 22 211
45 V-G 48 312
46 G-V 23 212
47 V-BR 49 313
48 BR-V 24 213
49 V-SL 50 300
50 SL-V 25 200

Issue 1
December 1999

A-7
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Processor External Cable Pinout
Table A-6 shows the pinout for the Processor External Cable.
Table A-6. Processor External Cable Pinout
Processor
(P1)
(Amphenol AUX | Modem
Signal Name Connector) g1 (P2) Mouse | Keyboard | USB | VGA | Ethernet
ACCA48A 12 19
AP1 (alarm in) 2 26
AP2 (alarm in) 27 27
EXTALMA 48
EXTALMB 23
XFER48 38 36
GROUND 25 1
MOD-CTS 21 5
MOD-DCD 46 8
MOD-DSR 8 6
MOD-DTR 7 20
MOD-GRD 20 1&7
MOD-RTS 34 4
MOD-RXD 33 3
MOD-TXD 45 2
MOUSE-DAT 18 1
MOUSE-GRD 31 3
MOUSE-VCC 6 4
MOUSE-CLK 5 5
KYBD-DAT 30 1
KYBD-GRD 17 3
KYBD-VCC 16 4
KYBD-CLK 29 5
USB-vCC 15 1
USB-DAT- 40 2

Continued onnext page
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Processor
(P1)
(Amphenol AUX | Modem
Signal Name Connector) gD (P2) Mouse | Keyboard | USB | VGA | Ethernet
USB-DAT+ 42 3
GRD 41 4
VGA-RED 49 1
VGA-GREEN 47 2
VGA-BLUE 23
GRD 10 5
GRD 48 6
GRD 46 7
GRD 24 8
VGA-PWR 35 9
GRD 36 10
VGA-HSYNC 37 13
VGA-VSYNC 11 14
ETH-RD+ 44 3
ETH-RD- 19 6
ETH-TD+ 32 1
ETH-TD- 7 2
RX- 28
TX+ 13
TX- 14
RX+ 39
NC —
NC —_
GROUND 50
NC —
— 43
NC —

Continued onnext page
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Table A-6. Processor External Cable Pinout — Continued
Processor
(P1)
(Amphenol AUX | Modem
Signal Name Connector) Jo (P2) Mouse Keyboard | USB | VGA | Ethernet
NC —
NC —
— 1
=>» NOTE:

Table A-7. Port Circuit Pack Lead Designations

AUXis a 50-pin receptacle, Modem is a 25-pin D-sub plug, Mouse is a
6-pin miniature DIN receptacle, Keyboard is a 6-pin miniature DIN
receptacle, USB is a type A receptacle, VGA is a 15-pin D-sub receptacle,
and Ethernet is an 8-pin jack.

TN742/B
TN747B
TN753 TN760/B TN793
Cross- TN769 TN760C TN763 TN767B TN746/B TN2793
Connect | TN2147 TN754 | TN760D TN763B TN464E TN2183 TN2224/B
Pin TN465 TN726 | TN2209 TN762/B | TN763C TN735 TN2207 TN2215 TN2214
1 T1 T.1 T.1 T.1 T1 C5 T.1 T1
2 R.1 R.1 R.1 R.1 R.1 R.1 R.1
3 TXT.1 T1.1 TXT.1 Sz.1 BT.1 C_ENAB T.2 T.2
4 TXR.1 R1.1 TXR.1 Sz1.1 BR.1 R.2 R.2
5 PXT.1 El PXT.1 S1 LT.1 C_SYNC* T.3 T.3
6 PXR.1 M.1 PXR.1 S1.1 LR.1 R.3 R.3
7 T.2 T.2 T.2 T.2 T.2 C2D-DATA T.4 T.4
8 R.2 R.2 R.2 R.2 R.2 RDATA* R.4 R.4
9 TXT.2 T1.2 TXT.2 Sz.2 BT.2 TDATA* T.5
10 TXR.2 R1.2 TXR.2 S71.2 BR.2 TRSYSNC R.5
11 PXT.2 E.2 PXT.2 S.2 LT.2 GRD T.6
12 PXR.2 M.2 PXR.2 S1.2 LR.2 SCLK* R.6
13 T.3 T.3 T.3 T.3 T.3 T.7
14 R.3 R.3 R.3 R.3 R.3 R.7
15 TXT.3 T1.3 TXT.3 SZ.3 BT.3 T.8
16 TXR.3 R1.3 TXR.3 S71.3 BR.3 PAHER* R.8
17 PXT.3 E.3 PXT.3 S.3 LT.3 T.5 T.9
18 PXR.3 M.3 PXR.3 S1.3 LR.3 C_48v R.5 R.9
19 T4 T.4 T.4 T.4 T.4 T.6 T.10
20 R.4 R.4 R.4 R.4 R.4 R.6 R.10

Continued on|next page
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Table A-7. Port Circuit Pack Lead Designations — Continued

TN742/B

TN747B

TN753 TN760/B TN793
Cross- TN769 TN760C TN763 TN767B TN746/B TN2793
Connect | TN2147 TN754 | TN760D TN763B TN464E TN2183 TN2224/B
Pin TN465 TN726 | TN2209 TN762/B | TN763C TN735 TN2207 TN2215 TN2214
21 TXT.4 T1.4 TXT.4 Sz.4 BT.4 C_P2SCLK T.7 T.11
22 TXR.4 R1.4 TXR.4 SZ1.4 BR.4 LI (RX) R.7 R.11
23 PXT.4 E.4 PXT.4 S.4 LT.4 LO* (TX) T.8 T.12
24 PXR.4 M.4 PX4.4 S1.4 LR.4 LBACK1 R.8 R.12
25 T.5 T.5 T.5 T.5 T.5 GND T.9 T.13
26 R.5 R.5 R.5 R.5 R.5 C_5v R.9 R.13
27 TXT.5 T1.5 TXT.5 SZ.5 BT.5 T.10 T.14
28 TXR.5 R1.5 TXR.5 SZ1.5 BR.5 R.10 R.14
29 PXT.5 E.5 PXT.5 S5 LT.5 T.11 T.15
30 PXR.5 M.5 PXR.5 S1.5 LR.5 C_RST R.11 R.15
31 T.6 T.6 T.6 T.6 T.6 T.12 T.16
32 R.6 R.6 R.6 R.6 R.6 R.12 R.16
33 TXT.6 T1.6 TXT.6 SZ.6 BT.6 RDATA T.17
34 TXR.6 R1.6 TXR.6 S71.6 BR.6 TDATA R.17
35 PXT.6 E.6 PXT.6 S.6 LT.6 TRSYNC T.18
36 PXR.6 M.6 PXR.6 S1.6 LR.6 GRD R.18
37 T.7 T.7 T.7 T.7 T.7 SCLK T.19
38 R.7 R.7 R.7 R.7 R.7 R.19
39 TXT.7 T1.7 TXT.7 Sz.7 BT.7 T.20
40 TXR.7 R1.7 TXR.7 Sz1.7 BR.7 R.20
41 PXT.7 E7 PXT.7 S.7 LT.7 GRD T.13 T.21
42 PXR.7 M.7 PXR.7 S1.7 LR.7 R.13 R.21
43 T.8 T.8 T.8 T.8 T.8 C_PRES* T.14 T.22
44 R.8 R.8 R.8 R.8 R.8 R.14 R.22
45 TXT.8 T1.8 TXT.8 SZ.8 BT.8 T.15 T.23
46 TXR.8 R1.8 TXR.8 S71.8 BR.8 DC2_DATA R.15 R.23
a7 PXT.8 E.8 PXT.8 S.8 LT.8 LI* (RX) T.16 T.24
48 PXR.8 M.8 PXR.8 S1.8 LR.8 LO (TX) R.16 R.24
49 GRD GRD GRD GRD GRD GRD LBACK2 GRD GRD
50 GRD GRD GRD GRD GRD GRD GRD GRD GRD

* Denotes high side of line.
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Table A-8. DSI1 Interface Cable H600-307 (and C6C)
50-Pin 15-Pin

Pin Color Designation | Pin Color Designation

02 W-BL

03 BL-W

47 W-G LI (High) 11 W-G LI (High)

22 G-W LI 03 G-W LI

48 W-BR LO 09 W-BR LO

23 BR-W LO (High) 01 BR-W LO (High)

49 W-SL LOOP2 06 W-SL LOOP2

24 SL-W LOOP1 05 SL-W LOOP1

All other pins are empty.

Table A-9 shows the pinouts for the TN2185 ISDN-BRI 4-wire S Interface.

Table A-9. TN2185 ISDN-BRI — 4-Wire S Interface Pinout

Port | Signal | Cross-ConnectPin | Color | AmphenolPin | Backplane Pin
1 TXT.1 1 W-BL 26 102
TXR.1 2 BL-W 01 002
PXT.1 3 W-O 27 103
PXR.1 4 Oo-W 02 003
2 TXT.2 5 W-G 28 104
TXR.2 6 G-W 03 004
PXT.2 7 W-BR 29 105
PXR.2 8 BR-W 04 005
3 TXT.3 9 W-SL 30 106
TXR.3 10 SL-W 05 006
PXT.3 11 R-BL 31 107
PXR.3 12 BL-R 06 007
4 TXT.4 13 R-O 32 108
TXR.4 14 O-R 07 008
PXT.4 15 R-G 33 109

Continued onlnext page
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Table A-9. TN2185 ISDN-BRI — 4-Wire S Interface Pinout — Continued

Port | Signal | Cross-ConnectPin | Color | Amphenol Pin | Backplane Pin
PXR.4 16 G-R 08 009
5 TXT.5 17 R-BR 34 110
TXR.5 18 BR-R 09 010
PXT.5 19 R-SL 35 111
PXR.5 20 SL-R 10 011
6 TXT.6 21 BK-BL 36 112
TXR.6 22 BL-BK 11 012
PXT.6 23 BK-O 37 113
PXR.6 24 O-BK 12 013
7 TXT.7 25 BK-G 38 302
TXR.7 26 G-BK 13 202
PXT.7 27 BK-BR 39 303
PXR.7 28 BR-BK 14 203
8 TXT.8 29 BK-SL 40 304
TXR.8 30 SL-BK 15 204
PXT.8 31 Y-BL 41 305
PXR.8 32 BL-Y 16 205

Table A-10 shows the pinout for the TN793 and TN2793 24-Port Analog Line
circuit pack.

Table A-10. TN793 Analog Line Circuit Pack Pinout

Cross-Connect
Port | Signal Pin Color | AmphenolPin | Backplane Pin
1 T.1 1 W-BL 26 102
R.1 2 BL-W 01 002
2 T.2 3 W-O 27 103
R.2 4 o-w 02 003
3 T.3 5 W-G 28 104
R.3 6 G-wW 03 004

Continued on|next page



DEFINITY ONE Communications System Release 1.0 Issue 1

Installation and Upgrades 555-233-109 December 1999
A Cable Pinouts
Connector and Cable Diagrams —Pinout Charts A-14

Table A-10. TN793 Analog Line Circuit Pack Pinout — Continued

Cross-Connect
Port | Signal Pin Color | AmphenolPin | Backplane Pin
4 T4 7 W-BR 29 105
R.4 8 BR-W 04 005
5 T5 9 W-SL 30 106
R.5 10 SL-wW 05 006
6 T.6 11 R-BL 31 107
R.6 12 BL-R 06 007
7 T.7 13 R-O 32 108
R.7 14 O-R 07 008
8 T.8 15 R-G 33 109
R.8 16 G-R 08 009
9 T.9 17 R-BR 34 110
R.9 18 BR-R 09 010
10 T.10 19 R-SL 35 111
R.10 20 SL-R 10 011
11 T.11 21 BK-BL 36 112
R.11 22 BL-BK 11 012
12 T.12 23 BK-O 37 113
R.12 24 O-BK 12 013
13 T.13 25 BK-G 38 302
R.13 26 G-BK 13 202
14 T.14 27 BK-BR 39 303
R.14 28 BR-BK 14 203
15 T.15 29 BK-SL 40 304
R.15 30 SL-BK 15 204
16 T.16 31 Y-BL 41 305
R.16 32 BL-Y 16 205
17 T.17 33 Y-O 42 306
R.17 34 O-Y 17 206

Continued on|next page
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Table A-10. TN793 Analog Line Circuit Pack Pinout — Continued
Cross-Connect
Port | Signal Pin Color | AmphenolPin | Backplane Pin

18 T.18 35 Y-G 43 307

R.18 36 G-Y 18 207

19 T.19 37 Y-BR 44 308

R.19 38 BR-Y 19 208

20 T.20 39 Y-SL 45 309

R.20 40 SL-Y 20 209

21 T.21 41 V-BL 46 310

R.21 42 BL-V 21 210

22 T.22 43 V-O 47 311

R.22 44 O-v 22 211

23 T.23 45 V-G 48 312

R.23 46 G-V 23 212

24 T.24 47 V-BR 49 313

R.24 48 BR-V 24 213

25 49 V/SL 50 314

50 50 SL/V 25 214
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Set Up and Use of
Customer Logins

This chapter provides information about the setup and use of customer logins.

This chapter is organized as follows:

1. ["Windows NT Logins for the Customer” on page B-2|

« ['NT Login Types for the Customer” on page B-3|

« [‘Enabling Windows NT Customer Logins” on page B-7]

2. ['DEFINITY Logins for the Customer” on page B-§

3. [“Installing and Setting Up DSA on Your Workstation” on page B-§

« [‘Installing DSA” on page B-§|

[‘Confiquring DSA” on page B-9

4. |“Downloading Message Manager” on page B-9|
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Windows NT Logins for the Customer

When DEFINITY ONE ships from the factory, several Windows NT login groups
and associated logins are pre-installed for customer use. See Table B-1.

The login IDs in the last two columns of Table B-1 are for customer use. These
logins have default passwords when the system ships and should be changed
by the customer or the installation technician during installation. The following
information describes how these logins are used and how they should be
administered.

Table B-1. Windows NT Logins

Windows NT
Login Group Logins for Customer Use
Default

User Name Password

Administrators NTadmin NTadminl

Guest - disabled | -- --

lucent -- --

officeadmin 1

officeuser 2

Power Users -- --

Users browse browsel
vm browsel
sa browsel

1. To be administered
2. To be administered

A warRNING:

The logins in the Lucent group of Table B-1 are for the exclusive use of
Lucent Technologies Services personnel. These logins are established and
updated automatically by Lucent software. DO NOT ALTER THESE LOGINS
IN ANY MANNER. To do so may render the system unserviceable and may
require a partial or complete reinstallation of the software by Lucent
personnel.
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NT Login Types for the Customer

Administrator Login

AUDIX Logins

=—>» NOTE:

NTadmin

This is a standard Windows NT administrator account. It is used to allow
the customer to administer network parameters and similar functions.

browse

This login is used in the Voice Messaging application on the DEFINITY
ONE system. Also see the INTUITY AUDIX documentation or[Table B-2|for a
list of commands accessible to this login. When the system ships, this
login is disabled. It must be enabled and a password must be chosen
before it can be used.

vm

This login is used in the Voice Messaging application on the DEFINITY
ONE system. Also see the INTUITY AUDIX documentation or[Table B-2|for a
list of commands accessible to this login. When the system ships, this
login is disabled. It must be enabled and a password must be chosen
before it can be used.

sa

This login is used in the Voice Messaging application on the DEFINITY
ONE system. It has full customer administration privileges. Also see the
INTUITY AUDIX documentation or[Table B-2] for a list of commands
accessible to this login. When the system ships, this login is disabled. It
must be enabled and a password must be chosen before it can be used.

On a stand-alone INTUITY AUDIX system, the login “sa” normally produces a menu.
This feature is not supported on DEFINITY ONE. All logins result in a Forms Screen

interface.

=—>» NOTE:

See|Table B-2|for the different privileges for the three AUDIX logins - sa, vm, browse.

Customer Web Access Logins

The following login groups are used for web access.

Officeadmin

This is a login group that has no login IDs installed when the DEFINITY
ONE system leaves the factory. It is used to facilitate access via the
DEFINITY ONE web interface. Members in this group have selected
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administrative privileges in the system via the web interface. The NTadmin
account may be used to establish an account in this group. Generally, an
account in the Offieceadmin group is used to download DSA from the
DEFINITY One Web page.

« Officeuser

This is a login group that has no login IDs installed when the DEFINITY
ONE system leaves the factory. It is used to facilitate download of client
software such as Message Manager. Members of this group have no
access other than for client download. The NTadmin account may be used
to establish an account in this group. Generally, an account in the
Officeuser group is use to download Message Manger from the DEFINITY
One Web page.

= anonymous

The anonymous login is established for very limited access via the
DEFINITY ONE web interface. This login can be used to load a software
patch on to DEFINITY One. Details are shown in[Table B-3.

See|Table B-2|for the privileges of the three Web access logins.
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Login
Command sa vm browse
add [ U
audit O] O
change O] O
copy W
display O 0 U
exit O O U
get O i
help O O U
list O O U
logoff O O 0
print O O i
remove O U
reset ]
test 0 O i
toggle O O 0
trace O O i
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Table B-3 details the use of login groups for web access.

Table B-3. Web Access Rights/Officeadmin and Officeuser Access

Directory use Login Group |Permissions
c:\LucentWeb\Public DEFINITY ONE Home anonymous read
Pag e officeuser read
officeadmin read
administrators full control
lucent full control
c:\LucentWeb\admin\audix\html | AUDIX networking HTML |anonymous none
pages officeuser none
officeadmin read
administrators full control
lucent full control
c:\LucentWeb\admin\audix\cgi |AUDIX networking cgi anonymous none
scripts officeuser none
officeadmin execute
administrators full control
lucent full control
c:\LucentWeb\admin\user\html |Pages for non anonymous none
administrator users e.g. |officeuser read
download officeadmin full control
administrators read
lucent full control
c:\LucentWeb\admin\user\cgi  |cgi scripts for non anonymous none
administrator users. e.g. |officeuser execute
download officeadmin execute
administrators full control
lucent full control
c:\LucentWeb\ad min\html Platform HTML pages anonymous none
officeuser none
officeadmin read
administrators read
lucent full control
c:\LucentWeb\admin\cgi platform cgi scripts anonymous none
officeuser none
officeadmin execute
administrators execute
lucent full control
c:\LucentWeb\Ad minAll\html Restricted html pages. anonymous none
e.g. activate officeuser none
pcANYWHERE officeadmin none
administrators full control
lucent full control
c:\LucentWeb\AdminAll\cgi Restricted html pages. anonymous none
e.g. activate officeuser none
pcANYWHERE officeadmin none
administrators full control
lucent full control
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Enabling Windows NT Customer Logins

Enabling customer logins can only be done by an Administrator.

Activate pcANYWHERE

1.

2.
3.

On a workstation connected to the DEFINITY ONE LAN, bring up a web
browser and bring up the DEFINITY ONE web page. Click Administer
System on this web page and then login as NTadmin using the default
password NTadminl. On the administration page click Activate
pcANYWHERE.

A pcANYWHERE client must be installed on the workstation. This client
may be purchased from a local supplier or Symantec Corporation and
installed on the workstation. Alternately, a JAVA client may be downloaded
from the DEFINITY ONE administration page. This is the same page where
the pcANYWHERE host is activated in step 1.

Activate the pcANYWHERE client on the workstation.
Login to the DEFINITY ONE system, again using the NTadmin account.

Setup Login Accounts

1.

Start the NT user manager on the DEFINITY One desktop (Start >
Programs > Administrative Tools > User Manager)

2. Change the password for the NTadmin account.

3. Activate and set passwords for the browse, vm, and sa accounts.

Create three Windows NT accounts in the Officeadmin group for three
application administrators. These accounts can be used to download DSA
software. The NTadmin account can also be used for this purpose, but, in
general it should be used for NT administration only. The account names
can be chosen as desired. For this example they are called D1luserl,
Dluser2, and D1luser3.

Create one Windows NT account in the Officeuser group to allow
download of the INTUITY Message Manager Software. The NTadmin
account can also be used for this purpose, but, in general, it should be
used for NT administration only. The account name can be chosen as
desired. For this example it is called D1WEB.

Disconnect from pcANYWHERE.
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In addition to the logins that are maintained in the Windows operating system,
there are customer level logins within the DEFINITY application, but which do
NOT appear as Windows logins. Table B-4 shows these logins. The default
password should be changed by the customer during installation. Refer to
[‘Enable Customer Logins’|on page 3-5 for the details of setting up the DEFINITY

customer logins.

Table B-4. DEFINITY Customer Logins

DEFINITY
Customer Logins | Comments

Default
Password

deftyl This is the customer level “super user”
login within the DEFINITY application. Its
use should be restricted to the system
administrator. This login can be used to
create additional DEFINITY logins within
DEFINITY. See the DEFINITY command
add login.

Installing and Setting Up DSA on Your
Workstation

Installing DSA

Downloading DSA can only be done by an Administrator.

The steps required to obtain the DEFINITY Site Administration (DSA) software

from the DEFINITY ONE system are as follows:

1. On a workstation where DSA is to be installed, bring up a web browser
and bring up the DEFINITY ONE web page. Click Administer System on
this web page and then login as NTadmin using the appropriate
password. On the administration page, click Download Software.

2. On the resulting Web page, click on the selection to download DSA.
Select an appropriate directory on your workstation to save the self
extracting file that will be downloaded. This file can be placed in any temp

directory, as desired.
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3. When the download completes, close all applications on your workstation,

locate the file that was downloaded, and double click it to start executing.

Follow the screen prompts to install DSA on your workstation. DSA will
install an icon on your desktop.

Configuring DSA

See[‘Configure DSA”lon page 7-7 for instructions on how to configure DSA.

When prompted for logins use your customer logins where appropriate - vm, sa,
or browse for AUDIX and deftyl or other DEFINITY customer accounts for
DEFINITY.

Downloading Message Manager

The steps required to obtain the INTUITY Message Manager software from the
DEFINITY ONE system are as follows:

1.

On the desktop where Message Manager is to be installed, activate your
favorite browser and bring up the home page for the DEFINITY ONE
system.

The name or IP address of the DEFINITY ONE system must be obtained
from the administrator of the customer’s network where DEFINITY ONE is
installed.

2. On the DEFINITY ONE home page, click User Services.

. When prompted for a user ID, type DIWEB and use the password

supplied by your system administrator.

Holders of more privileged accounts may also use their IDs, for example,
NTADMIN, Dluserl, etc.

Click Download Message Manager.

This will down load a self-extracting file to your desktop.

. When the download is complete, exit all applications on your desktop and

double click the file that was downloaded.

Follow the prompts to complete the installation. See|“Installing Message]
[Manager from a LAN Server”[on page 8-14.
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Miscellaneous Procedures

This appendix provides several procedures you will use in the installation
process. This appendix is organized as follows:

= Connectivity

— [“Connect the Laptop Computer to DEFINITY ONE” on page C-2|

“Verify the Connection from DEFINITY ONE to the Laptop|
Computer” on page C-1

— [“‘Restore the Laptop Settings” on page C-11|

page C-13|
= [|“Setting the Name of the Switch” on page C-15]

to the Laptop Computer's - rve  on

=« [“Connect to SAT Session via Telnet” on page C-16|

= Backup and Restore

— [“Perform Immediate Backup (Command Line)” on page C-18|

— [“Perform Immediate Backup (Web)” on page C-21|

— [“Perform Scheduled Backup (Command Line)” on page C-28|

— [“Perform Scheduled Backup (Web)” on page C-30|

— [“Perform Restore (Command Line)” on page C-35|
— [“Perform Restore (Web)” on page C-37|
— [“View Backup Results (Web)” on page C-40|

— ['View Contents of Backup Location (Web)” on page C-42|
« [*Shut Down” on page C-44]
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Connect the Laptop Computer to
DEFINITY ONE

This procedure describes a connection between a technician’s laptop computer
(hereafter in this procedure referred to as “laptop”) and a DEFINITY ONE system
via a PCMCIA ethernet card in the TN795 circuit pack within the DEFINITY ONE
system.

The following shows the equipment needed for the technician’s laptop computer.

Table C-1. Required Technician’s Laptop Equipment Checklist

Part Number Description Quantity
Laptop computer with PCMCIA network 1
interface card (NIC)

3CCFES575BT PCMCIA NIC with RJ45 connector for 1

(cabled version, DEFINITY ONE
has an RJ45 on
end of cable) or

3CXFE57B5T(X
jack)
Cable assembly to connect NICs: 1
« D8W cable
» RJ45 coupler (BRIA4P)
846943306 » RJ45 crossover cable (approx. 6
inches)
=>» NOTE:

Anytime that you change any information, be sure to record both the old
information and the new information.

The DEFINITY ONE system is configured at the factory to act as an endpoint of a
private LAN with a PC.

A WARNING:
You must use the “3COM Megahertz 10/100 LAN CardBus” PCMCIA
ethernet card. This card has either part number 3CCFE575BT or
3CXFE575BT, depending on the cable arrangements. Other types of cards
do not work. You must use a special crossover cable, comcode

846943306. See[Figure C-1]
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cydmlap KLC 051499 _<1ﬁ/
Figure Notes
1. Laptop computer 5. RJ45 crossover cable, (comcode
2. PCMCIA NIC 846943306)

6. PCMCIA NIC (3CXFE575BT shown)
7. RJ45 connector

3. D8W cable
4. RJ45 coupler (BRIA4P)

Figure C-1. Laptop Connectivity
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1. Make sure the power is off on the laptop and insert a PCMCIA ethernet

card into the laptop.

This ethernet card can be any brand or model desired. A card with 100
Megabit capability will provide faster response.

Insert a 3COM Megahertz 10/100 LAN CardBus Network Interface Card
into the PCMCIA slot of the DEFINITY ONE system to which the connection
will be made.

The DEFINITY ONE system will normally be powered up and running. It is
NOT necessary to power it down before inserting the PCMCIA disk card.

=>» NOTE:
If you will be performing backup procedures, insert a new PCMCIA
card in the free slot in the TN795 circuit pack. Do not unplug the
flash disk.

Using the RJ45 crossover cable (comcode 846943306), a RJ45 coupler
(BRIA4P) and a D8W cable, connect the 3COM card in the TN795 circuit
pack to the ethernet card in the laptop.

=>» NOTE:
The green LED on the 3COM Megahertz 10/100 LAN Card Bus PC
card plugged into the TN795 circuit pack of the DEFINITY ONE
system should be on, indicating physical connectivity. If one of the
LEDs is not lit, this indicates that there is an open circuit between the
laptop computer and DEFINITY ONE.

Power up the laptop and start Windows 95 or 98.

You receive the desktop window.

Right click Network Neighborhood to configure the network PCMCIA
interface to communicate to the DEFINITY ONE system.
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A menu similar to the following appears.

Open
Explore
Eind Computer...

b ap Metwark Drive. ..
Dizconnect Metwark Drive. .

Create Shaorkout
Rename

Froperties

=>» NOTE:
The following details are for a particular version of Windows 95. Your
system may have screens that are slightly different, depending on
the version of Windows. The top LED on the 3COM NIC indicates a
10-MHz connection speed and the bottom LED indicates a100-MHz
connection speed. If there is no light, this indicates an open
connection and a problem exists.

6. Click Properties.
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A screen similar to the following appears:

I Network EE I

Configuration I Identificatiunl Access EDntru:uI'

The fellowing hetwork components are installed:

i NetBEUI -> Dial-Up Adapter A
[ MNatBEL -» Metwork of Kircom CreditCard 101 00+M odern
W TCPAP <> DialUp Adapter

Y TCRAP > Mebwark of Zircom CreditCard 1074100+ adenn
~o File and printer zharing for Microzoft Metwork s

Add. Remove I Propertiez |

Frimary Metwork Logon:
IEIient for Microzoft Metworks j

File and Print Shating... |

Deseription

TERPAF iz the protocal you use to connect to the Intermet and
wide-area netwarks,

(]9 Cancel
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7. Click the ldentification tab.

A screen similar to the following appears:
Metwork

Configuration  |dentification l.i‘-.l:cess I:l:untrl:ull

EJ Windows uzes the following information to identify paur

s computer on the network. Pleaze type a name for thiz
computer, the warkgroup it will appear in, and a short
description of the computer.

Computer name: |teu:h'||

Wwhorkgroup: |$ervices

Cornpriter

Dezcrption: |SEWiEES laptop

Ok | Cancel

8. Record the Computer name and Workgroup entries. In the above screen
these are techl and services, respectively.

This information is needed for certain operations, such as software
installation.

=>» NOTE:
The technician’s laptop will be set up with the Computer name “CSE”
and the Workgroup “OEM.”
9. Do NOT click OK.

10. Click the Configuration tab.
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A screen similar to the following appears. The contents of this screen will
vary, depending on the configuration of the laptop. Select the entry
corresponding to the PCMCIA ethernet card inserted in step 1.

Metwork

Configuration l Identificatiun] Booess I:l:untrl:ull

The following network, components are installed:

B Client for Microsoft Metworks

88 2Com Etherlink II| PCMCIA (305894305898
&8 »ircom CreditCard Ethernet Adapter 104100
& TCP/IP -» 3Com Etherlink 111 PCMCIA [3C589/3C5898)
h’_ TCPAP -» Hircom CreditCard Ethernet Adapter 104100

| Add... Bemove | Properties |

Primary Metwaork Logon:
|Windaws Lagan ﬂ

File and Print Sharing... |

Description
TCF#P ig the protocol pou use to connect to the Intermet and
wide-area networks.

Ok Cancel

11. Click File and Print Sharing to make file and print sharing active.

12. A screen similar to the one following appears.

File and Print Sharing

[V | weant to be able to give others access bo my files.

[ | wart to be able to allow athers bo print b my printeds].

Cancel

Make sure that you have checked the line:

| want to be able to give others access to my files
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13. Click OK.

You return to the following screen:

Metwork |

Configuration | Identificatinnl Access I:Dntr-:ull

T he following netwaork, components are installed:

Client for Microzoft Metworks

S8 3Com Etherlink 11l PCMCIA [3C539/3C589E)
=8 ircom CreditCard Ethemet &dapter 104100
4 TCPAP - 3Cam Etherlink 11l PCMCIA [3C589/3C5896)
“_ TCPAP -» #ircom CreditCard Ethernet Adapter 104100

| Add... I Bemowve | Froperties |

Primary Metwark, Logon:
IWindDws Lagan j

Eile and Frint Sharing... |

Drescription

TCPAP is the protocol you use bo connect ta the [nternet and
wide-area network.s.

k. Cancel

— If the “Windows Logon” is not your Primary Network Logon, click the
pull-down menu for the Primary Network Logon and select Windows
Logon.

=—>» NOTE:

Before continuing, record the current settings on the Access Control tab.
This information will be needed to restore your laptop after you have
completed work with DEFINITY ONE.

14. Click Access Control and make sure that Share Level Access Control is
selected.

15. Click OK.

If a warning screen appears notifying you that all connections to shared
directories will be disabled, select Yes to have the connections restored
after a restart.
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16.

17.

18.

19.

20.

A screen appears asking if you want to restart your computer now. Select
No.

Right click on Network Neighborhood and select Properties to return to
the Network screen.

Select TCP/IP Xircom CreditCard Ethernet Adapter 10/100.
Click Properties.

A screen similar to the following appears. Click the IP Address tab.

TCP/IP Properties

Bindings ] bAdvanced ] DMS Configuration ]
Gateway ] w5 Configuration IP Address

An IP addregz can be automatically azsigned ko this compliter.
|f wour network, does not automatically azzian P addreszes, aszk
wour network, adminigtrator for an addrezz, and then tppe it in
the zpace below.

" Obtain an P address automatically

+ Specify an IP address:

IPéddess: (192,11 .13 . 5 |

SubnetMask: | 255 . 255 . 255 . 252 |

| k. | Cancel

Record each entry in every tab before proceeding.

You will need this information to restore your laptop to its current settings
once you have completed your work with the DEFINITY ONE system.

Make sure that Specify an IP address is selected. Type 192.11.13.5 as the
IP Address and 255.255.255.252 as the Subnet Mask.

Click on the DNS configuration tab. Click the Disable DNS radio button.
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21. Click on the WINS configuration tab. Click the Disable WINS Resolution
radio button.

22. Click on the Gateway tab. If a gateway is shown, record the gateway
number. Highlight the gateway and select Remove.

23. Click OK at this and any following windows.

A screen similar to the following appears:

I Syztem Settings Change ’
Irip 'ou muzt restart pour computer before the new zettings will take effect,
L -

Do you want to restart your computer now?

24. Click Yes to restart your computer.

25. When the laptop reboots, verify that your laptop is now connected to the
DEFINITY ONE system. See “Verify the Connection from DEFINITY ONE to
the Laptop Computer” on page C-11.

Verify the Connection from DEFINITY
ONE to the Laptop Computer

1. Onthe laptop computer, start a DOS shell by clicking Start > Programs >
MS-DOS.

2. In the resulting DOS window type ping 192.11.13.6 and press Enter.

A series of four responses similar to the following that indicates a
successful response should appear:

Reply from 192.11.13.6 bytes=32 tinme=1ms TTL=128
Reply from 192.11.13.6 bytes=32 tinme=1ms TTL=128
Reply from 192.11.13.6 bytes=32 tinme=1ms TTL=128
Reply from 192.11.13.6 bytes=32 tinme=1ms TTL=128

3. If you receive a timeout response, check cabling or review the previous
setup steps. Also verify that the LEDs on the front panel of the TN795
circuit pack indicate that DEFINITY ONE is operating normally.

Restore the Laptop Settings

This procedure will restore the settings on the technician’s laptop computer to
what they were prior to connecting to the DEFINITY ONE system.

1. Atthe laptop, right click on Network Neighborhood. Select Properties.
2. A dialogue box titled Network should appear.
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3. On the Configuration tab click on the File and Print Sharing button. Make

10.

11.

12.
13.

sure the “I want to be able to give others access to my files” is checked.

Click the pull-down menu for the Primary Network Logon, and select
Client for Microsoft Networks.

Click on the Identification tab, enter the Computer name and workgroup
that was recorded earlier.

Click on the Access Control tab, check the boxes as appropriate so that
this screen matches its earlier settings.

Click on the Configuration tab.

» If adialog box appears notifying you that the security provider
could not be found, click Yes.

» If adialog box called “Authenticator type” appears, select
Windows NT Domain, and click OK.

In the List Box titled “The following network components are installed”,
double-click on the component that was modified earlier. This should be
the TCP/IP Xircom CreditCard Ethernet Adapter 10/100.

. A screen titled TCP/IP Properties should appear.

Enter the original IP address and subnet mask recorded earlier.

Click on the DNS Configuration tab, enable DNS and enter the appropriate
information that was recorded earlier.

Click on the WINS Configuration tab, enable WINS and enter the
appropriate information that was recorded earlier.

If a gateway was used, be sure to click on the Gateway tab and enter the
appropriate information that was recorded earlier.

Click on OK to close this and any following dialog boxes.

A screen will appear asking if you want to restart your computer. Click Yes.

When the system re-boots it should be back to its original settings.
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Map DEFINITY ONE to the Laptop
Computer’s CD-ROM Drive

1. Onthe laptop, double click on My Computer. Right click the CDROM drive
icon.

2. Select Sharing from the pop-up menu, a screen similar to the one below

will appear:
01_0_031_0 [D:] Properties i

General  Sharing ;

= Mot Shared
= i

Share Marne: iCDHDM

Lomment; I
Access Type:

" Bead-Only

f« Full

" Depend: on Password

Passwords:

Re

QK ; Cancel l o 1

3. By default the Not Shared radio button will be checked. Be sure to click
on the Shared As radio button. Enter a Share Name and click on the Full
radio button beneath the Access Type section.

4. Clicking the Full radio button will enable the Full Access Password text
box at the bottom of the screen. Be sure to enter a password into this text
box.
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=>» NOTE:

This password will be needed when mapping the network drive from the
DEFINITY ONE back over to the laptop.

Password Confirmation I

Please reenter your passwords to canfirm they are comrect,
r~ Paszwaords: Cancel 1

' Read-Only Pazsword: ;

PR

[ Full &ccess Passwond: i

5. On the resulting screen, you may accept the drive letter indicated or
select a new one. In the Path field, enter \xxxxX\CDROM where xxxx is the
name of the laptop as recorded in a procedure earlier in this chapter.
CDROM is the Share Name that was used when the CD-ROM drive was
shared.

6. Leave the Connect As field blank, make sure to uncheck the Reconnect at
logon check box.

7. Clicking OK will result in the following dialogue box prompting for login
and password information.

8. Leave the Connect As field blank and enter the password used earlier
when the CD-ROM drive was shared.

9. Click OK

At this time DEFINITY ONE has a drive (E in our case) mapped back over to the
laptop’s CD-ROM drive.
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Setting the Name of the Switch

Setting the NT name

To set the machine name, in a bash shell, type setip name=machineName.
Please limit the machine name to 10 characters. Setip will allow you to enter
more characters, however AUDIX will only display the first 10 characters of the
machine name in its administration window.

Ex: setip name=mysite

After having set the machine name, the setip command will display the old
settings as well as the new settings.

The machine will need to be rebooted for the changes to take effect. To re-start
the machine, from a bash shell, run reboot nice.

Updating AUDIX Machine Name

Once NT reboots and the changes take effect, you will need to update AUDIX.
To do this, bring up the DEFINITY ONE web page using your favorite browser.
Click on the Administer System hot link to make the web page prompts you for
login and password. Use the lucent3 login with the new password supplied by
INADS.

Next click on the AUDIX Networking hot link. When that page loads, click on the
Administrative Menu hot link. Finally click on the Local Machine Administration
hot link to load the Local Machine Administration web page. Click the change
button in the middle of the page to make AUDIX re-populate its databases with
the current settings.

You can now exit the web pages. However, for this change to take effect, you will
need to stop and re-start AUDIX.

Re-starting AUDIX

Establish a telnet session to a bash shell on the DEFINITY ONE. At the shell
prompt, execute a shutdown AUDIX command. When it completes, execute a
start AUDIX. Once AUDIX is re-started, it will be aware of the new machine
name.
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Updating Definity Machine Name
When the system is up and running, bring up a definity SAT session, using either
telnet or DSA. Login as dinit (lucent1 will grant the same permissions) with the
appropriate password.
Do a change system-parameters features, go to the 4th page, and change the

switch name to match the NT and AUDIX switch hames already administered.

Connect to SAT Session via Telnet

This method of access to DEFINITY ONE is used primarily by technicians who
use one of the services logins. Bash commands can be used. This connection
type will be used to install the license file, register DEFINITY ONE to INADS, and
set up the IP address for DEFINITY ONE using the setip command. The SAT
monitor can be used to administer and debug DEFINITY ONE.

1. After you have been admitted to the DEFINITY ONE system, enter a
command to continue. See|“Via a Telnet Session”]on page 2-8.

I _.; Telnet - ‘Wni5s

Connect  Edit Teminal Help

Login: Tucent3
“hallenge: 183-%616
Response: 2697369
Enter Command:
[audix | bash | cmd | definity | help | exit]

Lac=i

2. In this example, the command entered was definity. The screen below
shows the initial DEFINITY SAT screen.

¥ Telnet - win95

Connect Edit Teminal Help

Login:
Password:

SystTem: G3Crav’y software version: G3vw7c.00.0.423.0

Terminal Type (513, 715, 4410, 4425, w220, NTT, SUNT): [513] wWTT]}

The screen shows login and password fields. You are automatically
logged in to the DEFINITY SAT session by the LAC.

3. Enter the terminal type.
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=>» NOTE:

Two new terminal types have been added: NTT and SUNT.

» Use NTT from a Windows platform.
» Use SUNT from a Sun Microsystems platform.

Once the terminal type has been entered, the following screen is
displayed:

¥ Telnet - 'Win95
Connect Edit Teminal Help

This system is restricted to authorized users
for legitimate business Eljur‘poses. Unauthorized
access s a criminal violation of the law.

Copyright (c) 1992 - Lucent Technologies
Unpublished & Mot for Publication
2411 rights reserved

Once you are logged in as user lucentl, lucent2, or lucent3, you have the ability
to exit the DEFINITY SAT session and start an AUDIX session without having to
re-authenticate again.

At this point, you may have administration activities to perform. You may have to
set or verify customer options. See|‘How DSA Works”|on page 7-6. See also
[‘Download DSA”|on page 3-24.

Perform Backup

Backup is a safety step in case of later problems. The following procedures
describe immediate and scheduled backup procedures from the command line
and from the web browser.

You should have put a new PCMCIA disk in the remaining free slot on the TN795
circuit pack if you will be backing up to this device. Otherwise obtain a network
location from the customer to which you can do the backup.
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Perform Immediate Backup (Command Line)
1. Do one of the following:

a. If you are Using a LAN resident PC that is not DEFINITY ONE and it
is connected to the same LAN as DEFINITY ONE, click Start > Run
from the Windows task bar. The Run dialog box displays:

Run !

E==ml - Type the name of a program, folder, or document, and
wiindows will oper it far wou.

Open: [telnet 155.132.113.101 =
¥ Funin Sepearate Memon Space

Ok, I Cancel Browsze. . |

1. Entertel net {DEFINITY ONE Nane, or |P
Addr ess}. Click OK.

2. A telnet session will open on your desktop. Enter your User
Name and Password at the prompts.

E Telnet - winds

Connect  Edit Teminagl  Help

Login: lucent3
Challenge: 523-6295
Response:
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Once the Lucent access control (LAC) process accepts your inputs, you
will be admitted into the DEFINITY ONE system.

¥ Telnet - Wwind5

Connect Edit Teminal Help

Login: Tucent3
Challenge: 183-9616
RESpONSE: 2697369
Enter Command:
Laudix | bash | cmd | definity | help | exit]

Lac =

3. Type bash and press Enter.

You receive your machine name and login ID as your
prompt.

OR:

b. If you are at a DEFINITY ONE desktop, log in to Windows NT.Click
Start > Run from the Windows task bar. The Run dialog box
displays.

Run !

Emml  Type the name of a program, folder, or document, and
Windows will aper it far pow.

Open: II:uasH j

¥ | Eunin Separate M emony Space

0k, I Cancel | Browsze. . |

1. Enter bash and click OK.
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2. A telnet session will open on your desktop. Enter your User
Name and Password at the prompts.

E Telnet - “wind5
Cornect Edit Teminal Help

Login: lucent3
Challenge: 523-629%
Response:

Once the LAC accepts your inputs, you will be admitted into the
ProductName system.

=>» NOTE:
Regardless of which way you logged in, proceed with the following
steps.

2. Type dlbackup <data-set> <destination> and press Enter.

The parameter to type for data-set indicates what is to be backed up. It
will be one or more of the following (separate multiple choices with a

space):
parameter meaning
deftran DEFINITY Translations
vmnamtran Voice Names and Translations
vmmsgtran Message Bodies and Translations
vmannounce Announcement Sets
vmnammsgtran Voice Names, Messages, and Translations
registry NT registry

The destination will be pcmcia or a directory name.

If you type a directory name, you must have mapped a network drive in
the F: drive. You can do this from Windows Explorer or by issuing a
command from the bash prompt. If you mapped a network drive, you need
to disconnect from it after completing this procedure.
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An example of how to type information to backup is:

LAC:> dlbackup deftran vmnamtran pcmcia

=>» NOTE:
When you start executing this command, you will experience a delay
of about 1 to 2 minutes because AUDIX Networking is shutting down
and performing audits on AUDIX databases. When the backup
procedure finishes, AUDIX Networking starts again.

Perform Immediate Backup (Web)
1. Type http://<IP address> in the address area of the web browser.
You receive the DEFINITY ONE Home page.

Lucent Technologles 6
Badl Labs Innewat'ons. -

DEFINITY ONE™ Communications System

The singie solution for
your smaii business needs.

Home

Administer
System DeriniTy OHE provides you with
a high functionality, cost
effective systerm enabling you to
meet your current business
challenges head an while
providing the infrastructure to
bridge you to future
opportunities.

User Services

2. Click Administer System.
You receive a screen similar to the following:

Username and Pazsword Required E3

Enter uzermame for august. dr. lucent. com at
auguzt. dr.lucent. com:

Uzer Mame: ||

Password: I

Ok I Cancel I

3. Type your login ID and password.

The login ID that you use must have the correct backup permissions. That
login ID must be a member of the Administrator's login group.
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You receive a Notice screen similar to the following:

Home

Administer
System

User Services

Download
Software

NOTICE:

By uze of this system, you accept the terms and condittons of the lcense
agreements for all third party software mcluded with this product. Fadure to
comply with these agreements could result in legal action by the third party

vendor(s).

Thiz product 15 designed for the use of authonized Lucent Technologies products
only. Tze of this system for any other third party applications 12 strictly probibited
annd will result in the nullification of Lucent Technologies warranty and post
warranty obligations.

Thiz system is restricted to authorized users for legitimate business purposes.

Tnauthorized access 15 a criminal wiolation of the law. Copyright (o) 1992 -
Lucent Technologies UTnpublished & Mot for Publication

[T Don't show this message again

Continue |

Lucent Technologles 6
BaellLabs Innowations

=l [ S YS—

4. Click Con

[Sy— T T e

tinue.

You receive the following screen:

Home

Administer

User Services

Download
Software

System Administration

o DEFINITY EC2 on Bosnia " The first two links will work only
o Tntuity AUDTE on Bosnia ' you have already matalled

o Default AUDTE Settings DEFINITY Site Adminisiration

o AUDI Metworlong OfL FOoUr Cotnputer.

System Maintenance Click on the

a Backup & Restore . Devwnload Saftwars link

a Shutdown or Restart Bosnia at the 1eft to install

Remote Control - polnywhere DEFINITY Site Administration.

o Start Host Service on Bosma
o otop Host Service on Bosnia
o start Java Client on your computer

Lucent Technologles 6
BaellLabs Innowations
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5. Click Backup & Restore.

You receive the following screen:

= Inme diate Backup u Last scheduled backup results u Bestore
o Scheduled Backup o Contents of backup location

Home

Administer

s ./

User Services

Download
Software

Lucent Technologles 6
BaellLabs Innowations

6. Click Immediate Backup.

You receive the following screen:

» Immediate Backup u Last scheduled backup results u Bestore

o Scheduled Backup o Contents of backup location
Home Choose items for immediate backup
Administer I Translations Warning: Before starting
Syste . this backup operation,

ystem € Translations, names and messages any previous hackup data
User Services € Translations and names from;;cmcz‘a will be
FFIEIERER € Translations and messages frases
' Translations

Download Backu
S 0 Announcements _pl

[T Registry

Destination: pcmcia 3 Change

Lucent Technologles 6
BaellLabs Innowations
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7. Specify what you want backed up (DEFINITY ECS Translations, INTUITY

Home

Administer

System

User Services

Download
Software

AUDIX information, and Windows NT Registry). You can back up this
information either to the pcmcia flashdisk or to a drive on your network

If you want to back up information to the pcmcia flashdisk (default
destination):

a. Check the boxes next to the items that you want to back up to your
flashcard. If you select DEFINITY Translations, AUDIX Translations
and Names, and Windows NT Registry, this information will all fit on
the flashcard in the following order:

— Windows Registry
— DEFINITY Translations
— AUDIX Translations and Names

If you select information other than the above information, some of
the information may not fit on the flashcard. It will be put on the
flashdisk in the following order:

— Windows NT Registry
— Translations
— Names
— Announcements
— Messages (these may not be backed up)
b. Click Backup.
You receive the following screen:

Tumediate Baclup u Last scheduled backup results u Bestore
Zcheduled Backup o Contents of backup location |

[Backing up these items into pcmeia
Translations
v Translations, names and messages
- Cancel backup |
Translations and names
Translations and messages

Translations |
Announcements

Eegistry

Click here to wiew backup progress.

Lucent Technologles @
BaellLabs Innowations -

You see Click here to view backup progress at the bottom of this
screen.
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Click on this message and you receive a new browser screen with
the current backup progress messages.

=>» NOTE:
You will experience a delay of about 1 to 2 minutes because
AUDIX Networking is shutting down and performing audits on
AUDIX databases. However, you will see the backup
progress on the screen during this delay. When the backup
procedure finishes, AUDIX Networking starts again.

If you want to back up to a drive on your network:

Home

Administer
System

User Services

Download
Software

Home

Administer
System

User Services

Download

Software

a. Click Change near the Destination label.

» Immediate Backup u Last scheduled backup results u Bestore
o Scheduled Backup o Contents of backup location

Choose items for immediate backup

[T Translations

Warning: Before starting
this baclkup operation,
any previous backup data
from Cf will be erased.

Backup |

' Translations, names and messages
' Translations and names

' Translations and messages

' Translations

' Announcements

[T Registry

Destination: C:f 3 Change

Lucent Technologles @
BaellLabs Innowations -

You receive the following screen:

oose destination folder for backup

=l Map Netwotk Drive Disconnect Met Diive

-3 bosnia, dr Jucent. com
000
=1 Dy

Lucent Technologles @
BaellLabs Innowations -
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You see any drives you have mounted. You will not see the E: drive
if the flashcard is not inserted.

=>» NOTE:
You can now choose one of the drives you have mounted or
you can mount one by clicking on Map Network Drive and
following the prompts.

b. Click on the actual drive letter — not on the icon to the left.

You will receive the following screen:

& DEFINITY ONE - A Explorer

o Irme diate Backup = Last scheduled backup results u Restore

a Scheduled Backup a Contents of backup location
Drive: [F: [=]

Computer Share name
Administer FPath: [ 1 |
System

Domain User Hame Password

% c t As:

User Services I | [ | I
o} __MepNetworkDrive |

Software .
-3 bulgaria2. dr lacent com

£y
B D
E-{1 Eif

You see that the destination is changed from the default destination
to the drive you selected.

c. Check the boxes next to what you want to be backed up to your
flashcard. If you select DEFINITY ECS Translations, AUDIX
Translations and Names, and Windows NT Registry, this information
will be put on the drive in the following order:

— Windows Registry
— DEFINITY Translations

— AUDIX Translations and Names
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If you select information other than the above information, it will be
put on the drive in the following order:

— Windows NT Registry
— Translations
— Names
— Announcements
— Messages
d. Click Backup.

You receive the following screen:

Tumediate Baclup u Last scheduled backup results u Bestore |
Zcheduled Backup o Contents of backup location |
|
TWhoyi o [Backing up these items into pcmeia
|
Translations

dminister

v Translations, names and messages
- Cancel backup |
Translations and names

User Services .
S AR L e Translations and messages

Translations |
Download |
e T RCIR Armouncements
Software

Eegistry

Click here to wiew backup progress.

Lucent Technologles @
BaellLabs Innowations -

You see Click here to view backup progress at the bottom of this
screen.

Click on this message and you receive a new browser screen with
the current backup progress messages.

=>» NOTE:
You will experience a delay of about 1 to 2 minutes because
AUDIX Networking is shutting down and performing audits on
AUDIX databases. However, you will see the backup
progress on the screen during this delay. When the backup
procedure finishes, AUDIX Networking starts again.
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Perform Scheduled Backup (Command Line)

1. Click Start > Run from the Windows task bar. The Run dialog box
displays.

Run !

E==l  Type the name of a program, folder, or document, and
YWindows will apen it far pou.

Open: Itelnet 185132113101 =]
¥ | Eun in Separate emon Space

] 4 I Cancel | Browse. .. |

2. Entertel net {DEFINITY ONE | P Address}. Click OK.

3. Atelnet session will open on your desktop. Enter your User Name and
Password at the prompts.

-E Telnet - win35

Cornect  Edit Temingl  Help

Login: lucent3
Challenge: 523-6295
Response:

Once the access control process (LAC) accepts your inputs, you will be
admitted into the ProductName system.

§ Telnet - win35

Cormect Edit Teminal Help

Login: lucent3
_hallenge: 183-9614
Response: 2097369
Enter Command:
Laudix | bash | cmd | definity | help | exit]

Lac=1




DEFINITY ONE Communications System Release 1.0 Issue 1
Installation and Upgrades 555-233-109 December 1999

C Miscellaneous Procedures
Perform Backup

C-29

4. Type bash and press Enter.

You receive your machine name and login ID as your prompt.

5. Type backupsource <data set> and press Enter.

The parameter to type for data-set indicates what is to be backed up. It
will be one or more of the following (separate multiple choices by a

space):

parameter meaning

deftran DEFINITY Translations

vmnamtran Voice Names and Translations

vmmsgtran Message Bodies and
Translations

vmannounce Announcement Sets

vmnammsgtran Voice Names, Messages, and
Translations

registry NT registry

6. Type backupparams <days> <time> <destination> and press Enter.

This indicates when to backup and where to put the information.

The parameter to type for <days> will be 1 through 7, 1 day or multiple
days (1 is for Sunday, 2 is for Monday, etc., and 7 is for Saturday). The
parameter to type for <time> will be in military time, for example, 14:03
(2digits:2digits). The parameter to type for <destination> will be pcmcia
or a directory name.

If you type a directory name, you must have mapped a network drive. You
can do this from Windows Explorer or by issuing a command from the
bash prompt. If you mapped a network drive, you need to disconnect from
it after completing this procedure.

7. Type autobackup -y and press Enter.

This signals to the system to perform the backup at the scheduled time
and creates a scheduled entry.
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Perform Scheduled Backup (Web)
1. Type http://<IP address> in the address area of the web browser.
You receive the DEFINITY ONE Home page.

Lucent Technologles 6
Badl Labs Innewat'ons. -

DEFINITY ONE™ Comymunications System

The singie solution for
your smaii business needs.

Home

Administer

DeFiniTy ONE provides you with
a high functionality, cost
effective system enabling you to
meet your current business
challenges head on while
praviding the infrastructure to
bridge you to future
opportunities.

.....

2. Click Administer System.
You receive the following screen:

Uszsername and Password Required

Enter uzermame far august. dr. lucent.com at
auguzt. dr.lucent. com:

Uger Mame: ||

Pazzword: I

Ok I Cancel I

3. Type your login ID and password and click OK.

The login ID that you use must have the correct backup permissions. You
must be a member of the Administrator’s login group.
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You receive a Notice screen similar to the following:

NOTICE:
By uze of this system, you accept the terms and condittons of the lcense
Home agreements for all third party software included with this product. Faiure to
comply with these agreements could result in legal action by the third party
Administer vendor(s).
System
Thiz product 15 designed for the use of authonized Lucent Technologies products
User Services only. Use of this system for any other third party applications is strictly prohubited
annd will result in the nullification of Lucent Technologies warranty and post
Download warranty obligations.

Software

Thiz system is restricted to authorized users for legitimate business purposes.

Tnauthorized access 15 a criminal wiolation of the law. Copyright (o) 1992 -
Lucent Technologies UTnpublished & Mot for Publication

[T Don't show this message again

Continue |

Lucent Technologles 6
BaellLabs Innowations

Al e e T T e

4. Click Continue.

You receive the following screen:

System Administration
o DEFINITY EC2 on Bosnia " The first two links will work only
o Tntuity AUDTE on Bosnia ' you have already matalled
Hirie = Default AUDEE Settings DEFINITY Site Administration
o AUDI Metworlong OfL FOoUr Cotnputer.
ST AR E System Maintenance Click on the
a Backup & Restore. . Devwnload Saftwars link
User Services o Shutdewn or Bestart Bosma at the 1eft to install
Remote Control - polnywhere DEFINITY Site Administration.
Download o Start Host Service on Bosma
Software o Stop Host Zervice on Bosnia

o start Java Client on your computer

Lucent Technologles 6
BaellLabs Innowations

5. Click Backup & Restore.
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You receive the following screen:

= Inme diate Backup u Last scheduled backup results u Bestore
o Scheduled Backup o Contents of backup location

Home

Administer
System

User Services

Download
Software

Lucent Technologles 6
BaellLabs Innowations

6. Click Scheduled Backup.

You receive the following screen:

= Inme diate Backup u Last scheduled backup results u Bestore
» Zcheduled Backup o Contents of backup location

Current backup schedule for bosma dr lucent com : Mo schedule yat
Will backup these items Every At

r |1:DD am 'l
[T Translations r
. O

User Services 0 Translations, names & messages r

€ Translations & names r
Download € Translations & messages r Clear Changes |
Software € Translations r

€ Announcements Submit Changes |

[T Registry

Destination: pcmcia 3 Change

Lucent Technologles 6
BaellLabs Innowations
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7. Specify what you want backed up (DEFINITY Translations, INTUITY AUDIX
information, and Windows NT Registry). Do one of the following:

a. If you want to back up information to the flashdisk (default
destination):

1. Check the boxes next to what you want to be backed up to

your flashcard. If you select DEFINITY Translations, AUDIX
Translations and Names, and Windows NT Registry, this
information will all fit on the flashcard in the following order:

— Windows Registry
— DEFINITY Translations
— AUDIX Translations

If you select information other than the above information,
some of the information may not fit on the flashcard. It will be
put on the flashdisk in the following order:

— Windows NT Registry
— Translations

— Names

— Announcements

— Messages

. Check the boxes next to the days and time you want to

schedule the backup. You can schedule any combination of
days at the same time.

. Click Submit Changes.

You receive confirmation of your request.
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b. If you want to back up to a drive on your network:

1. Click Change near the Destination label (shown in step 6 of
this procedure).

You receive the following screen:

=l Map Netwotk Drive

Dizconnect Net Drive
= | .
Home 3 bosnia dr lucent com

User Services

Download
Software

Lucent Technologles @
BaellLabs Innowations -

You see any drives you have mounted.

=>» NOTE:
You can now choose one of the drives you have mounted or
you can mount one by clicking on Map Network Drive.
1. Click on the actual drive letter — not the icon to the left.

You receive the following screen <update screen>:

|- Tmmediate Backup u Last scheduled backup results u Restore
Scheduled Backup u Contents of backup location

Home Choose items for immediate backup

Administer [T Translations

pisial [ Translations, names and messages
ey Seok 7 Translations and names By

[ Translations and messages
[T Translations

Download
[ Announcements

Software

[ Registry

Destination: A:/ 3 Change

You see that the destination is changed from the default
destination to the drive you selected.
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2. Check the boxes next to what you want to be backed up to
your flashcard. If you select DEFINITY Translations, AUDIX
Translations and Names, and Windows NT Registry, this
information will be put on the drive in the following order:

— Windows Registry
— DEFINITY Translations
— AUDIX Translations

If you select information other than the above information, it
will be put on the drive in the following order:

— Windows Registry
— Translations
— Names
— Announcements
— Messages

3. Click Submit Changes.

You receive confirmation of your request.

Perform Restore (Command Line)

1. Click Start > Run from the Windows task bar. The Run dialog box
displays.

Run ;

sml - Type the name of a program, folder, or document, and
“windows will open it far pou.

Open: Itelnet 155.132.119.101 |
¥ Fum it Separate emon Space

(0] I Cancel | Browsze. .. |

2. Entertel net {DEFINITY ONE | P Address}. Click OK.
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3. Atelnet session will open on your desktop. Enter your User Name and
Password at the prompts.

E Telnet - Win95

Connect  Edit Teminad Help

Login: lucent3
Challenge: 523-629%

Response:

Once the access control process (LAC) accepts your inputs, you will be
admitted into the ProductName system.

¥ Telnet - "Wind5

Connect Edit Teminal Help

Login: Tucents
challenge: 183-9616
Response: 2697389
Enter Command:

Laudix | bash | cmd | definity | help | exit]

Lac=1

4. Type dlrestore <destination> <data-set> and press Enter.

The parameter to type for data-set indicates what is to be backed up. It
will be one or more of the following (separate multiple choices by a

space):
parameter meaning
deftran DEFINITY Translations
vmnamtran Voice Names and Translations
vmmsgtran Message Bodies and Translations
vmannounce Announcement Sets
vmnammsgtran Voice Names, Messages, and Translations
registry NT registry
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The destination will be pcmcia or a directory name.

If you type a directory name, you must have mapped a network drive. You
can do this from Windows Explorer or by issuing a command from the
bash prompt. If you mapped a network drive, you need to disconnect from
it after completing this procedure.

Make sure that the data-set information corresponds with the contents of
the media (flashcard or network drive). Otherwise, nothing will be restored.

Perform Restore (Web)

1. Type http://<IP address> in the address area of the web browser.

You receive the DEFINITY Home page.

Lucent Technologles 6
Badl Labs Innewat'ons. -

DEFINITY ONE™ Comymunications System

The singie solution for
your smaii business needs.

Home

Administer

DeFiniTy ONE provides you with
A - a high functionality, cost
User Services J ' " Y effactive system enabling you to
h d meet your current business
challenges head on while
praviding the infrastructure to
bridge you to future
opportunities.

2. Click Administer System.

You receive a screen similar to the following:

Uszsername and Password Required

Enter uzermame far august. dr. lucent.com at
auguzt. dr.lucent. com:

Uger Mame: ||

Pazzword: I

Ok I Cancel
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3. Type your login ID and password.

The login ID that you use must have the correct backup permissions. You
must be a member of the Administrator’s login group.

=>» NOTE:
You need to be a member of the Administrator's login group to
restore some AUDIX files.

You receive the following screen:

System Administration

= DEFIMITY ECS on Bosnia - The first two hnks will work only

= Intuity AUDIY on Bosnia if wou hawve already mstalled
e « Diefault AUDLX Settings DEFINITY Site Adwministration
T = AUDEE MNetworking on Four computer.
IS ter System Maintenance Click on the

2 Backup & Restore. Download Software link
T ek = Shutdown or Restart Bosta at the 16ft to install

Remote Control - pcinywhere DEFINITY Site Administration
Download u Start Host Service on Bosnia
Software = Stop Host Service on Bosnia

= Start Java Client on your computer

4. Click Backup & Restore
You receive the following screen:
Ltnediate Backup m Last scheduled backup results = Restore

Scheduled Backup = Contents of backup location
Home

Administer

System

User Services

Download
Software

5. Click Restore .
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You receive the following screen:

Inmediate Backup w Last scheduled backup results v Restors
u Scheduled Backup u Contents of backup location

Choose items to restore

[T Translations
[ Translations, names and messages Clear Fields
[ Translations and names
[T Translations and messages Submit
[ Translations
I Anncuncements
T Registry
Source: pomeia q}m‘g;

You now have to specify what you want restored (DEFINITY translations,
INTUITY AUDIX information, and Windows NT Registry). The information
you choose has to be on the backup disk or drive (everything you click

must be in the backup file). Otherwise, nothing will be restored.

A restore process cannot be scheduled.

A WARNING:
Before you complete the restore process, it will shut down your
applications. After the restore completes, AUDIX will remain shut
down, so you will need to start AUDIX again manually or reboot the
entire operating system. It is recommended that you reboot after a
restore procedure.

6. Click Restore.
You receive confirmation of your request.
You see “Click here to see restore progress” at the bottom of this screen.

Click on this message and you receive a new browser screen with the
current restore progress messages.
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View Backup Results (Web)
1. Go to the DEFINITY Home page:

Lucent Technologles @
Bail Labe Innewat ot

DEFINITY ONE™ Covrymiiiicalions System
The single soiution for
your smaii business needs.

Home

Administer
System

DeFinTy ONE provides you with
a high functionality, cost
effective systerm enabling you to
meet your current business
challenges head an while
providing the infrastructure to
bridge you to future
opportunities.

User Services

2. Click Administer System.
You receive a screen similar to the following:

Username and Pazsword Required E3

Enter uzermame for august. dr. lucent. com at
auguzt. dr.lucent. com:

Uzer Mame: ||

Password: I

Ok I Cancel I

3. Type your login ID and password.

The login ID that you use must have the correct backup permissions. You
must be a member of the Officeadmin login group.

You receive the following screen:

System Administration
u DEFINITY BCS on Bosnia . The first two links will work only
o Intuity AUDLL on Bosnia if you have already mstalled
Home = Default AUDIX Settings DEFINITY Site Administration
LA o AUDIE Networking on your computer
Administer 0
r System Maintenance Click on the
i u Backup & Restore. ) Deownload Saftware link
User Servicas u Shutdown or Bestart Bosnia at the 1eft to install

Remote Control - poinywhere DEFINITY Site Adminisiration.

Dovwnload a Start Host Service on Bosnia
Software 2 Stop Host Service on Bosnia
o Start Java Client on your computer
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Immedate Backup m Last scheduled backup results = RBestore
Scheduled Backup = Contents of backup location

Home

Administer

8

User Services

Download

5. Click Last scheduled backup results.

You receive the following screen:

Immediate Backup ; e u Restore
Scheduled Backup = Contents of backup location
Home Results of last scheduled backup
Administer [[tems hacked up File Size Destination
8 n
SR Translations
Y . Ti tarted
L Borers Translations, names & messages fme starte
Translations &
Download Translaﬁons Y names
Software Fansianons & messages Time finished
TS Translations
Amncuncements
Registry

You receive the status of the last backup.
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View Contents of Backup Location (Web)
1. Go to the DEFINITY ONE Home page:

Lucent Technologles @
Bail Labe Innewat ot

DEFINITY ONE™ Comynunicalions Systam

The singie soiution for
your smali business needs.

Home

Administer
System

DeriniTy OHE provides you with
a high functionality, cost
effective systerm enabling you to
meet your current business
challenges head on while
providing the infrastructure to
bridge you to future
opportunities.

User Services

2. Click Administer System.
3. You receive a screen similar to the following:
Uszsername and Password Required

Enter uzermame far august. dr. lucent.com at
auguzt. dr.lucent. com:

Uger Mame: ||

Pazzword: I

Ok I Cancel I

4. Type your login ID and password.

The login ID that you use must have the correct backup permissions. You
must be a member of the Officeadmin login group.

You receive the following screen:

System Administration
= DEFINITY ECS on Bosnia B The first two linkes will worle only
= Intuity AUDIE on Bosnia if wou have already nstalled
Home u Defanlt AUDIE Settings DEFINITY Site Administration
o AUDE Metworlding of Four cotmputer.
m System Mamtenance Clicke on the
Sy n
=Backup & Restore Devwnload Saftware link
User Services = Shutdown or Restart Bosnia at the left to install

Remote Control - pcénywhere DEFINITY Site Administration.

Download = Start Hest Service on Bosnia
Software o Stop Host Service on Bosnia
= Start Java Client on your computer

Lucent Technologles

BeilLabs Innevati
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5. Click Backup&Restore.

You receive the following screen:

Lmrnediate Backup = Last scheduled backup results = Restore
Scheduled Backup u Contents of backup location

Home

Administer
System

User Services

Daownload
Software

6. Click Contents of backup location.

You receive a screen similar to the following:

Immediate Backup wu Last scheduled backup results » Restore
Scheduled Backup » Contents of backup location

Home Display current backup contents of pomcia

Administer
System

User Services Display

Download
Software

3 change default location above

7. Click Display to see the contents of the PCMCIA file.

You receive a screen similar to the following:

Immediate Backup  Last scheduled backup results u Restore
Scheduled Backup » Contents of baclkup location

Home Display current hackup contents of pcmcia

Administer % change defalt loation above

User Services Display

Dovmload
Software

You see the current backup contents.
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Shut Down
=—> NOTE:

All running processes must be shut down before upgrading software. You
must to back all translations before you shut down, follow the

[procedures]in this chapter.

1. Go to pcANYWHERE using the procedure in Chapter 2, Connectivity and
Access, ['Via pcANYWHERE”|on page 2-13

2. Type shutdown all from a bash session.
You will receive confirmation of the shutdown completion.

3. After the prompt returns, verify the shutdown by viewing the Windows NT
event log: press Start > Programs > Administration Tools > Event
Viewer.

4. Close the bash session.
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Recovery

This chapter provides information about system recovery. This chapter is
organized as follows:

« ['DEFINITY ONE System Level Shutdown and Restart” on page D-2|
« ['DEFINITY Software Reset (Recovery)” on page D-4|

» [‘Reset System 1 (DEFINITY Warm Start)” on page D-5|

» [‘Reset System 2 (DEFINITY Cold Start)” on page D-5|

» [‘Reset System 3 (DEFINITY Reboot)” on page D-5|

» [‘Reset System 4 (DEFINITY Reboot)” on page D-6

= [|‘Reset System 5 (System Reboot)” on page D-6|

When the system is initially powered up, or when an existing system experiences
a catastrophic fault that interrupts its basic functions, the system reboots.
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The following table presents system level shutdown and restart actions that can
be initiated by the system technician, the customer, and by hardware. The state
of the shutdown and restart actions is indicated by the state of the LEDs on the

TN795 processor circuit pack (See [Appendix E).|More details about the use of
the user commands can be found in the DEFINITY ONE Maintenance Manual,
555-233-111.
Table D-1. Shutdown and Restart Actions
Originated
Action Entry by Action Notes
1. “reboot command | technician | Shuts down all Used for a system reboot
nice” line entry applications with after changing an NT
from a campon to wait for | level parameter that
bash AUDIX users to requires a system reboot
session logoff. The system This may take an
restarts unacceptably long time
automatically. due to campon of AUDIX
logons.
2. “reboot command | technician | Shuts down all Used for a system reboot
immediate” | line entry applications with a guaranteed reboot
from a without waiting for time of a few minutes.
bash AUDIX users to log | This action does not wait
session off. The system for AUDIX users to be
restarts logged off from AUDIX.
automatically.
3. command | technician | Shuts down Used for system
“shutdown line entry application upgrade. The campon
all” from a software while option may cause an
bash leaving NT up. An unacceptable wait time.
session optional “campon” | The “start all” command

option may be used
to wait for AUDIX
users to log off.

can be used to restart
the application software.

Continued on|next page
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Table D-1. Shutdown and Restart Actions
Originated
Action Entry by Action Notes
4. command | technician | Shuts down AUDIX | Used to shut down
“shutdown line entry while leaving AUDIX if the machine
audix” from a DEFINITY and NT name is changed. The
bash up. An optional “start audix” command
session “campon” option can be used to restart
may be used to AUDIX. The campon
wait for AUDIX option may cause an
users to log off. unacceptable wait time.
5. command | technician | Shuts down the Used to shut down the
“shutdown line entry system without system in preparation for
system” from a restarting it An removing AC power or
bash optional “campon” removing the TN795
session options may by Processor circuit pack.
used to wait for The campon option may
AUDIX users to log | cause an unacceptable
off. The system wait time.The system can
does not restart be restarted only by
automatically. removing and restoring
power or reseating the
TN795.
6.“delayed | web page | technician/ | Wait for AUDIX Used to shut down the
shutdown” from a customer users to log of f system in preparation for
button web before starting a removing AC power or
browser system shutdown. removing the TN795

The system may or
may not restart
automatically,
depending on a
“restart” option.

Processor circuit pack

Continued on|next page
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Table D-1. Shutdown and Restart Actions
Originated
Action Entry by Action Notes
7. web page | technician/ | Do not wait for Used to shut down the
“immediate | from a customer AUDIX users to log | system in preparation for
shutdown” | web off before starting a | removing AC power or
button browser system shutdown. removing the TN795
The system may or | Processor circuit pack
may not restart
automatically,
depending on a
“restart” option.
8. Faceplate | technician/ | Shut down the Used to shut down the
shutdown of the customer system after system in preparation for
button on TN795 closing all removing AC power or
the processor applications. The removing the TN795
faceplate of | board system will not Processor circuit pack.
the TN795 restart The system can be
processor automatically. restarted only by
board removing and restoring
power or reseating the
TN795.
9. Wiring Loss of AC | Shut down the Provides a graceful
Detection from the power for system after shutdown when AC
of the loss UPSZ3A2 | more than | closing all power is lost for more
of AC alarm one minute | applications. The than one minute.
power by adapterto system will restart
the UPS the Major automatically upon
Alarm restoration of AC
lead on power.
the TN795

DEFINITY Software Reset (Recovery)

There are severe reset levels available to restart DEFINITY software. These resets
can be user initiated with the reset system n command (where n is the reset

level). They may also be automatically initiated by system software in response to
certain error conditions.
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A system is reset due to a loss of power, or through:
» Reset commands entered during a SAT terminal session.

» Maintenance software, from which the system can reset itself. (This
process starts when certain software and hardware errors are detected by
the software.)

A WARNING:
When the system is rebooted or reset at level 2, 3, 4, or 5, all voice
terminal and attendant console features are adversely affected.
Users should be advised of services that are lost and that, as a
result, must be reactivated.

The SAT display and circuit pack LEDs indicate the progress of the recovery
process.

Reset System 1 (DEFINITY Warm Start)

» This recovery takes about 60 seconds.
« All software is reset.

» All stable phone calls remain up.

» In-progress calls are dropped.

= No new calls can be made during this time.

Reset System 2 (DEFINITY Cold Start)

The following are reset:
» All software
« TDM Bus

» All Port circuit packs

All telephone sessions are dropped. Telephones begin to reconnect to the switch
within 60 seconds.

Reset System 3 (DEFINITY Reboot)

This is the same as|Reset System 4| (see below). This command is retained for
consistency with other DEFINITY products.
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Reset System 4 (DEFINITY Reboot)

» Emergency Transfer is invoked in this reset.
= System processes are reloaded from hard disk into memory
= All port circuit packs are reset.

» Alltelephone sessions are dropped.

Telephones begin to reconnect to the switch within 60 seconds.

Reset System 5 (System Reboot)

This is the same as Reset System 4 (see above).
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LED Boot Sequence/TN795 Processor

This chapter provides information about the LED boot sequence of the TN795
circuit pack.

This chapter is organized as follows:

[‘LED Boot Sequence” on page E-1

[“TN795 Processor Circuit Pack” on page E-1|

[“TN795 Processor Circuit Pack LEDs (after booting)” on page E-2|
« [‘LED States” on page E-5|

LED Boot Sequence

TN795 Processor Circuit Pack

When power is first applied to DEFINITY ONE, or when the system reboots, the
LEDs on the TN795 circuit pack will light according to this sequence:

1. Alllights on the TN795 will rapidly blink in sequence, from bottom to top
(also known as “racing lights”).

2. Within 1 minute, the second light from the top will blink green:
= When the LED is more on than off it indicates BIOS loading
» More off than on indicates NT loading

3. The third LED from the top will blink amber to indicate application firmware
loading.

4. When firmware is loaded, the LEDs will blink in sequence again (racing
lights), then all LEDs will light and then go off.
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The DEFINITY ONE system is now under normal operating conditions.
When the system is operating normally you will see

» The amber LED (third from the top) will blink quickly once every 10
seconds, indicating the firmware/NT watchdog processes are
communicating.

» Another blinking LED (clock) flashes when the firmware for the
clock is communicating.

Any other LEDs that are illuminated indicate an alarm or problem with DEFINITY
ONE. For more information about alarms, see chapter 4, DEFINITY ONE Alarms
in DEFINITY ONE™ Communications System Maintenance, 555-233-111.

The emergency transfer LED is on if a reset 4 occurs or if power is cycled.

TN795 Processor Circuit Pack LEDs (after
booting)

The front panel has two groups of LEDs. One group indicates the status of the
pack, and the other group (which includes the Major, Minor, and Warning alarms)
reflects maintenance conditions in the entire system.

» Red (alarm)—the system has detected a fault in this circuit pack.
=> NOTE:
Alarms on the PROCR, PR-MAINT, SW-CTL, and PKT-INT
maintenance objects are indicated by the red LED on the Processor
circuit pack.
» Green (test)—the system is running tests on this circuit pack.

= Amber —in an operating system, this LED indicates that the handshaking
between the firmware and the NT operating system is occurring by
flashing briefly once every 10 seconds.

» PCMCIA (amber) - the flash disk is in use
= MAJOR ALARMS (red)
= MINOR ALARMS (red)

» CLOCK (amber) — blinks once every 4 seconds.
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» EM XFER (red)—indicates emergency transfer has been invoked

=>» NOTE:
If the AC power cord is unplugged, the emergency transfer feature
invokes, however the EMERGENCY TRANSFER LED (red) is not lit
due to loss of AC power. The system gracefully shuts down in about
3 minutes.

» OK REMOVE (green) — steady indicates that it is OK to remove the TN795
processor circuit pack.

A WARNING:

DO NOT REMOVE the TN795 circuit pack unless the Complete
Shutdown LED is illuminated. Failure to heed this warning may
result in loss of data and/or damage to equipment.
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Min Alarm
Clock

Emergency
Transfer
On
Auto €
off

Complete O{»
Shutdown O'\
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O
Maj Alarm O
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Do Not Remove Board Until
Shutdown Is Complete
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Figure Notes
1. PCMCIA slots
2. Red LED
3. Green LED
4. Amber LED
5. PCMCIA In Use LED
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. Emergency Transfer On/Auto/Off

switch

. Complete Shutdown - safe to pull

board when green LED is on

. Shutdown switch - gracefully shuts

down system

Figure E-1. TN795 Circuit Pack Faceplate
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LED States
The following table summarizes the TN795 circuit pack LED states.
Table E-1. TN795 Circuit Pack LED States
k)
N
[}
g | 2 g s | 8 | 8
5 | = B | E 8 | ¢ | 8| % | & g
o = = o = = o : g =
B x o 3 B = T g 2 = 8 2 ©
LED x IS g P 2 g S = T S % %) g b
LED Name Col 3 ki) @ ) 8 e k) w g Pt = % =3 &
or o = < @ 8 5 | & g E © a g
2 < L % 2 = ke 38 g >
&3 |g|¢® E | g SIS 182|838
2 | % T | 3 & | o | 8 | & | § | &
© o] IS iy
© =
o
3
TN795 CP red on on on on on sw on on on on on on
Alarm
TN795 Test green off on flash flash off sw sw off on flash on flash
1 3 2 4
TN7951In yel- off off off off flash flash sw off on flash off flash
Use low 2 4 2 4
PCMCIA yel- on on a sw sw sw a sw sw on off on on on
low w |
- -
2 2
Major Alarm red off off 3 off off off g sw sw off off off on on
[hd o4
Minor Alarm red off off off off off sw sw off off off on on
Clock Status yel- off off off off off clk clk off off off on on
low
ETR red on on on on on sw sw on on on on on
OK to green off on on off off off flash on on off on on
Remove 3

flashl— 800ms ON, 200ms OFF
flash2— 500ms ON, 500ms OFF
flash3— 200ms ON, 800ms OFF

flash4— 200ms OFF on every sanity heartbeat

flash5— 1 sec ON, 1 sec OFF
sw— Software Controlled
clk— Similar to the TN2182 Tone/Clock LED
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Status LEDs

This chapter provides information about the Status LEDs.

This chapter is organized as follows:

[‘Attendant Console LEDs” on page F-1

[‘Other Circuit Packs” on page F-1|

« [‘Circuit Pack Status LEDs” on page F-2|

« [‘Power Supply LEDs” on page F-3|

Attendant Console LEDs

The console has two red LEDs, labeled ALM and ACK. The left LED lights
steadily when there is a Major or Minor alarm at the switch cabinet. The right LED
lights steadily if the alarm has been successfully reported to INADS. If the system
is unable to report the alarm to INADS, the LED flashes; signhaling the attendant
to call INADS and report the alarm. If a modem is used, the system calls INADS
automatically.

Other Circuit Packs

You may see some LEDs on power up on the other circuit packs. Under normal
operation, you should not see LEDs lit on the circuit packs, with the following
exception: A solid green LED on any circuit pack indicates that diagnostic tests
are being executed on that circuit pack.
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Circuit Pack Status LEDs

Each circuit pack has three LEDs on the front panel visible at the front of the
carrier. On all circuit packs, except the 650A Power Unit, the LEDs indicate:

1. Red (alarm) — If the circuit pack is communicating with the system, the
system has detected a fault in this circuit pack. An on-board alarm for this
circuit pack is displayed in the Alarm Log.

The circuit pack also lights this LED when either the circuit pack has not
yet initialized communication with the system or when the circuit pack
loses contact with the system and stops functioning (circuit pack is said to
be “in reset”). In these cases, there may not be an alarm in the Alarm Log.
To determine if the red LED is lit because the circuit pack is not in contact
with the system, issue the list configuration board PCSS command,
where PCSS refers to the slot containing this circuit pack. If the system
does not detect the circuit pack, this command returns | denti fi er not
assi gned or no board.

If the circuit pack has just been inserted, the system may still be initializing
the circuit pack. If, after 5 minutes, the circuit pack still has not initialized
communications with the system, check the MO for any special
instructions. If the MO does not provide the needed information, perform
the following steps:

» Check the Error Log for TONE-BD and TDM-BUS errors. Enter test
tdm 1 test tone-clock. Follow appropriate sections for any
TONE-BD and TDM-BUS errors.

» Reseat the suspect circuit pack.

A WARNING:
Reseating the TN795 may be very destructive. This should be done
only if the Complete Shutdown LED is illuminated. Otherwise, you
must shut down before reseating.

Wait 5 minutes. Then issue the list configuration board PCSS
command. If the result indicates that the system still has not
registered the circuit pack, go to next step.

» If the system seems to be functioning correctly, but the circuit pack
does not start communicating with the system, replace the circuit
pack.

2. Green (test)—the system is running tests on this circuit pack.
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3. Yellow (busy)—indicates that the circuit pack is in use.

=>» NOTE:
A port circuit pack also lights its red LED when it performs
initialization tests (for example, when the circuit pack is initially
inserted into the system). If all initialization tests pass, the red LED is
turned off. If any initialization tests fail, the red LED remains lighted
and the circuit pack is not placed into service.

During the various states of operation (start-up testing, normal operation,

circuit failure, and so forth) circuit pack status LED indications appear as
shown in Table F-1.

Table F-1. Control and Port Circuit Pack Status LEDs

Equipment
Type LED Description
Port Circuit Red On briefly during power up, circuit pack reseating,
Packs resetting, and system reset. Steadily on if circuit
pack fails start-up test or fails while in use. Off
during normal operation.

Green Briefly on during circuit pack testing following
power up, circuit pack reseating, and system
reset. On during periodic, scheduled, and system
technician demanded testing. Off during normal
operation.

Yellow | On when any port in the circuit pack is in use,
otherwise, off.

Power Supply LEDs

Table 1-6/shows the LED and alarm conditions for the 650A Power Supply. Ring
voltage and neon bus output do not activate alarm status.
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Table F-2. LED and Alarm Conditions

Condition LED Status Alarm State

Normal Red off; Open
Yellow on

No input power Red off; Closed
Yellow off

DC output not present | Red on; Closed

(except Neon) Yellow off

Fan alarm Red on; Closed

Yellow on
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GAS Commands in the bash shell

This chapter provides information about bash (Bourne Again Shell) commands
that are used in the installation process. It also includes information on the setip
command. These commands are not available to the customer.

bash Commands

The following commands are useful for administration and installation tasks.
These commands are allowed for the lucent logins. After choosing the bash shell,
type the name of the command. Refer to DEFINITY ONE Communications
System Maintenance, 555-233-111 for more detailed information.

Table G-1. Bash Commands for lucent Logins

Command Description
alarmorig Turns on alarm origination from the GAM (INADS)
alarmstat Gives global alarm status (major, minor, or none) for

the GAM, DEFINITY, and AUDIX

cleargamalarm

Clears alarms after analysis

Continued onlnext page
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Table G-1. Bash Commands for lucent Logins

Command Description

dlstat Displays the status of all the applications groups
running on the system.

Lists all the processes associated with an
application that is only partially up and the status of
each process (+ => up and - => down).

Lists all the processes associated with an
application regardless of its state.

environment Temperature and supply displays voltages on
TN795

ftpserv Enables the ftp service

gamalarmstat Displays GAM alarm information formatted as
follows:

mm/dd/yyyy = month/day/year

NT Event Log Name= System | Security |
Application

Alarm Source= NT | GAM | LAC | GSK | VFM | GAS
NT Event Type = Error | Warn | Info

Alarm Type = Major | Minor

Event ID= Event field in NT Event Log

ACKed= ACKed, NACKED, FAILURE, NO_OSS_

RESPONSE
installconfig Installs license file (INADS)
lucent help Lists all commands
net user Used to add/activate logins, change passwords
0SS Sets telephone numbers for outgoing INADS calls
pcANYWHERE If no argument is given, pcANYWHERE will start. If

? is typed, help is displayed, if -v is typed, the
version of the command is displayed, and if -c is
typed, pcANYWHERE is stopped.

Continued onnext page
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Table G-1. Bash Commands for lucent Logins

Command Description

reboot Reboots system as follows:

nice: Shuts down applications and Windows NT in
a graceful manner

immediate: reboots the system without waiting for
the applications to shut down, causing possible
loss of voice messages that are being recorded
and all calls drop

restartcause Displays the restart causes for system (for
technician/TSC)

serialnumber Reads and displays the serial number of the circuit
pack

setip Sets the IP address, subnet mask, and default

gateway of the LAN interface to the customer’s LAN
(out the splitter cable). Turns on RAS. Reboot is
required for this to take effect.

shutdown Shuts down:
all: Lucent DEFINITY ONE applications

system: all Lucent DEFINITY ONE applications and
windows NT

appname: the name of the application to be shut
down

camp-on: (AUDIX feature) notifies users that a
system shutdown will happen and waits for users to
end their sessions before shutting down.

setip Command

The setip command is used from a bash shell to set certain NT specific settings.
To get to a bash shell, telnet to the DEFINITY ONE over any interface, login, and
select the bash option. Once you are in a bash shell you can run setip. Note
setip settings require a reboot before taking effect, as such please set all
necessary parameters before issuing the reboot command.
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To display current settings:
Run setip with no parameters, this will display the current system settings.

Setip allows you to set the customer’'s LAN address along with subnet mask,
gateway, DNS and WINS settings. It also allows you to set the machine name
and the RAS IP addresses.

Setting the machine name in NT:

To set the machine name, in a bash shell, type setip name=machineName.
Please limit the machine name to 10 characters. Setip will allow you to enter
more characters, however AUDIX will only display the first 10 characters of the
machine name in its administration window.

Ex: setip name=mysite

After having set the machine name, the setip command will display the old
settings as well as the new settings.

=>» NOTE:
You will also need to set the host name. See[*Setting DNS addresses and Host]
[Name:on page G-5

Setting RAS IP address:

To set the RAS IP address, in a bash shell, type setip ras=ip-address, where
ip-address is the dotted IP address.

Ex: setip ras=10.21.053, NOTE: INADS will provide this IP address.
=>» NOTE:
This command not only sets the RAS IP address, it also starts the service. Turn off RAS

service if system is set up without a modem.

After having set the RAS IP address, the setip command will display the old
settings as well as the new settings.
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Setting the customer’s LAN, DNS and WINS
information:

Setting LAN address:

To set the customer LAN address please get the IP address, subnet mask, and
default gateway addresses from the customer. Next from a bash shell, run the
setip cust=ip-addr,netmask[,gateway]. Note the gateway address is optional but
the ip-address and subnet mask are required.

Ex: setip cust=155.9.162.121,255.255.255.0,155.9.162.2

After having set the customer’s IP address, the setip command will display the
old settings as well as the new settings.

Setting DNS addresses and Host Name:

If the customer is using DNS you can set DNS information with the setip
dns=name,domain-name,primary-ns-ip-addr[,secondary-ns-ip-address], This
will set the DNS host name, domain name, and set the list of name server IP
addresses.

Note that the customer may have one, two, or more different domain name
servers (DNS).

Ex: setip dns=CustomerHost,CustomerDomain.com,155.9.1.10,155.9.15.14

After having set the customer’'s DNS IP addresses, the setip command will
display the old settings as well as the new settings.

Setting WINS addresses:

If the customer is using WINS you can set WINS information with the setip
wins=[ip-addr-primary[,ip-addr-backup]]. This will set the IP address of the
primary and secondary IP addresses for the windows NetBios on the TCP name
server.

Ex: setip wins=155.9.145.1,155.9.145.4

After having set the customer’'s WINS IP address, the setip command will display
the old settings as well as the new settings.

Once you have set all the appropriate settings for your location, from a bash shell
run reboot nice to restart the machine with the new settings.
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Other Commands

ftpserv command

The ftpserv command is executed from a bash shell and is used to turn on and
off the file transfer protocol on the DEFINITY ONE. If you attempt to ftp into the
DEFINITY ONE and you get a connection refused message, then ftp is not running.
To turn on ftp from a bash shell type: ftpserv

To turn off ftp from a bash shell type: ftpserv -c

pcanywhere command

The pcanywhere command is used to turn on and off the pcAnywhere host
service.

To turn pcAnywhere on, from a bash shell, type: pcanywhere.

To turn pcAnywhere off, from a bash shell, type: pcanywhere -c.

rasdrop command

The rasdrop command is executed from a bash shell, it causes the Remote

Access Server (RAS) service to be stopped and started again. There is a two
minute delay from the time the command is executed till the service is toggled.
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d1stat command

The d1stat command is used from a bash shell to determine what percentage of
the system is up and running. To determine what applications are running or
what state of “upness” the applications are in, you can run the d1stat command
from a bash shell.

Ex. estonia-lucentl>d1stat

NTr as 2/ 2 UP
NTweb 1/ 1 UP
pcAnywher e 0/ 1 DOWN
NTconsol e 2/ 2 UP
NTpl at f orm 6/ 6 UP
NT 11/11 UP
CoResSer v 5/ 5 UP
DEFI NI TY 51/51 UP
Cor ner St one 4/ 4 UP
AUDI X 15/ 33 PARTI ALLY UP
AUDI XNet 0/ 5 DOWN
M SC 24/ 0 UP

ner o- | ucent 1>

net user commands
The net user commands are used to manipulate NT level logins on the DEFINITY
ONE system. The net user commands can be used to add new logins, change
passwords on existing logins, or simply to enable/disable existing NT accounts.
To add a new user execute the following command from a bash shell

net user username password

To change the password of an existing login, execute the following command
from a bash shell

net user username newpassword

To enable an existing login that is disabled, execute the following command from
a bash shell

net user username /active
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Installer’s Connectivity Quick
Reference Tear-Out Sheet

This appendix provides is a tear-out quick reference sheet about connectivity including
physical connection, access, and login information.

Physical Connection IP Address
Local Monitor/Mouse/Keyboard 127.1
PCMCIA Network Connection 192.11.13.6

RAS Modem (Dial-up) 10.21.0.X (X is Customer Dependent —

Lucent Assigns)

Customer’s LAN Customer Dependent

Once you are connected, there are several ways to access DEFINITY ONE, as shown in
the next table.

Access Method
Telnet <ip addr> [Start > Run...]
DSA using appropriate ip-addrs

Web Browser http://<ip-addr>

pcANYWHERE lucentl, lucent2, lucent3

The following table shows Lucent Personnel Login information.

Logins to Enter System Logins to Enter DEFINITY Logins to Enter AUDIX
lucentl dinit atsc

lucent2 dinads acraft

lucent3 dcraft acraft
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= Each row of logins has the same password. For example, the lucentl, dinit, and
atsc logins all have the same password.

= The lucent logins are used for web browser and pcANYWHERE access.
= Alllogins can be used for Telnet access.

= Thed and alogins (columns 2 and 3) are used for DSA access.
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A

AC
1. Alternating current.

2. See analog.

Access Security Gateway (ASG)
A feature built into the Lucent Access Control (LAC) module that authenticates and protects logins
to the LAC.

administer
To access and change parameters associated with the services or features of a system.

analog
The representation of information by continuously variable physical quantities such as amplitude,
frequency, and phase. See also

analog data
Data that is transmitted over a digital facility in analog (PCM) form. The data must pass through a
modem either at both ends or at a modem pool at the distant end.

analog telephone
A telephone that receives acoustic voice signhals and sends analog electrical signals along the
telephone line. Analog telephones are usually served by a single wire pair (tip and ring). The
model-2500 telephone set is a typical example of an analog telephone.

ASCII (American Standard Code for Information Interchange)
The standard code for representing characters in digital form. Each character is represented by an
8-bit code (including parity bit).

Audio Information Exchange (AUDIX)
A fully integrated voice-mail system. Can be used with a variety of communications systems to
provide call-history data, such as subscriber identification and reason for redirection.

AUDIX
See Audio Information Exchange (AUDIX).

B

Basic Rate Interface (BRI)
A standard ISDN frame format that specifies the protocol used between two or more communica-
tions systems. BRI runs at 192 Mbps and provides two 64-kbps B-channels (voice and data) and
one 16-kbps D-channel (signaling). The D-channel connects, monitors, and disconnects all calls.
It also can carry low-speed packet data at 9.6 kbps.

Bash (Bourne Again Shell)
Unix-like command line interpreter.
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C
cabinet

Housing for racks, shelves, or carriers that hold electronic equipment.

cable
Physical connection between two pieces of equipment (for example, data terminal and modem) or
between a piece of equipment and a termination field.

cable connector
A jack (female) or plug (male) on the end of a cable. A cable connector connects wires on a cable
to specific leads on telephone or data equipment.

call accounting system (CAS)
This software feature provides recording, costing, and reporting of call detail records. Recording
includes the capability to set record discard criteria that allow the customer to specify the data
recorded. Costing uses tariff databases and user-defined parameters. Reporting produces both
periodic reports for individual users, organizations, accounts, user-defined criteria, and demand
statistics.

Call Detail Recording (CDR)
Textual Representation of call traffic

carrier
An enclosed shelf containing vertical slots that hold circuit packs.

CAS
Call Accounting System

central office (CO)
The location housing telephone switching equipment that provides local telephone service and
access to toll facilities for long-distance calling.

central office (CO) codes
The first three digits of a 7-digit public-network telephone number in the United States.

central office (CO) trunk
A telecommunications channel that provides access from the system to the public network through
the local CO.

circuit
1. An arrangement of electrical elements through which electric current flows.
2. A channel or transmission path between two or more points.

circuit pack
A card on which electrical circuits are printed, and IC chips and electrical components are
installed. A circuit pack is installed in a switch carrier.

communications system
The software-controlled processor complex that interprets dialing pulses, tones, and keyboard
characters and makes the proper connections both within the system and external to the system.
The communications system itself consists of a digital computer, software, storage device, and
carriers with special hardware to perform the connections. A communications system provides
voice and data communications services, including access to public and private networks, for
telephones and data terminals on a customer’s premises. See also
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compact modular cabinet (CMC)
The chassis and shelf hardware used to support the DEFINITY ONE hardware platform, derived
from (actually the same as) the DEFINITY ProLogix cabinet.

D
digital
The representation of information by discrete steps. See also

digital trunk
A circuit that carries digital voice and/or digital data in a telecommunications channel.

E

E1
A digital transmission standard that carries traffic at 2.048 Mbps. The E1 facility is divided into 32
channels (DS0s) of 64 kbps information. Channel 0 is reserved for framing and synchronization
information. A D-channel occupies channel 16.

G

GEDI
Graphically Enhanced DEFINITY interface. Is an enhanced system access terminal (SAT) with a
Windows look.

Global Administration Subsystem (GAS)
A module that provides command line access to certain administration and maintenance functions
needed by services tools and provides administration support for parameters in the DEFINITY
ONE system that are not otherwise provided by the DEFINITY ONE applications.

Global Alarm Module (GAM)
A Windows NT process that coordinates alarm reporting for the DEFINITY ONE platform. Its pri-
mary functions are to accept and forward alarms from the applications, generate alarms for Win-
dows NT, and manage the communication links to the Operations Support Systems (OSSs) via the
Windows NT TAPI interface.

Global Sanity Keeper (GSK)
A module that ensures that all authorized Lucent applications are executing on a DEFINITY ONE
server. It contains two major components, a watchdog process and a license server.

Glue Application/Module
A DEFINITY ONE application whose purpose is to integrate functionality for most or all other
DEFINITY ONE applications. Examples include Watchdog, Lucent Access Control (LAC), Global
Alarm Module (GAM), Global Administration Subsystem (GAS), and Backup/Restore.
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Graphical User Interface (GUI)
The use of pictures rather than just words to represent the input and output of a program. A pro-
gram with a GUI runs under some windowing system (for example, X Window System, Microsoft
Windows, Acorn RISC OS, and NEXTSTEP). The program displays certain icons, buttons, dialogue
boxes etc., in its windows on the screen and the user controls it mainly by moving a pointer on the
screen (typically controlled by a mouse) and selecting certain objects by pressing buttons on the
mouse while the pointer is pointing at them.

Integrated Services Digital Network (ISDN)
A public or private network that provides end-to-end digital communications for all services to
which users have access by a limited set of standard multipurpose user-network interfaces
defined by the CCITT. Through internationally accepted standard interfaces, ISDN provides digital
circuit-switched or packet-switched communications within the network and links to other ISDNs to
provide national and international digital communications. See also Integrated Services Digital
Network Basic Rate Interface (ISDN-BRI) and Integrated Services Digital Network Pri-
mary Rate Interface (ISDN-PRI).

Integrated Services Digital Network Basic Rate Interface (ISDN-BRI)
The interface between a communications system and terminal that includes two 64-kbps B-chan-
nels for transmitting voice or data and one 16-kbps D-channel for transmitting associated B-chan-
nel call control and out-of-band signaling information. ISDN-BRI also includes 48 kbps for
transmitting framing and D-channel contention information, for a total interface speed of 192 kbps.
ISDN-BRI serves ISDN terminals and digital terminals fitted with ISDN terminal adapters. See also
Integrated Services Digital Network (ISDN) andIntegrated Services Digital Network Pri-
mary Rate Interface (ISDN-PRI).

Integrated Services Digital Network Primary Rate Interface (ISDN-PRI)

The interface between multiple communications systems that in North America includes 24
64-kbps channels, corresponding to the North American digital signal level-1 (DS1) standard rate
of 1.544 Mbps. The most common arrangement of channels in ISDN-PRI is 23 64-kbps B-channels
for transmitting voice and data and 1 64-kbps D-channel for transmitting associated B-channel call
control and out-of-band signaling information. With nonfacility-associated signaling (NFAS),
ISDN-PRI can include 24 B-channels and no D-channel. See alsolntegrated Services Digital
Network (ISDN) andIntegrated Services Digital Network Basic Rate Interface (ISDN-BRI).

INTUITY AUDIX
The INTUITY AUDIX application resides on DEFINITY ONE with the Cornerstone platform to provide
subscriber messaging capabilities, including call answering and voice mailbox services.

INTUITY Message Manager
A Windows-based software product that allows INTUITY AUDIX users to receive, store, and send
their voice/fax messages from a PC. The software also enables users to create and send multime-
dia messages that include voice, fax, text, and file attachment components

ISDN
See Integrated Services Digital Network (ISDN).
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L
LED

See light-emitting diode (LED).

License Server
A component of the Global Sanity Keeper (GSK) that looks for a special encrypted control file
whose contents indicate which serial number of the TN795 Processor card is permitted to execute
on and which application are allowed to run. If the file is not present, no licenses are granted. If the
file is present, the license information is read from the file.

light-emitting diode (LED)
A semiconductor device that produces light when voltage is applied. LEDs provide a visual indica-
tion of the operational status of hardware components, the results of maintenance tests, the alarm
status of circuit packs, and the activation of telephone features.

local area network (LAN)
A networking arrangement designed for a limited geographical area. Generally, a LAN is limited in
range to a maximum of 6.2 miles and provides high-speed carrier service with low error rates.
Common configurations include daisy chain, star (including circuit-switched), ring, and bus.

Lucent Access Control (LAC)
A module that governs maintenance access to the Lucent application software.

M

maintenance
Activities involved in keeping a telecommunications system in proper working condition: the detec-
tion and isolation of software and hardware faults, and automatic and manual recovery from these
faults.

major alarm
An indication of a failure that has caused critical degradation of service and requires immediate
attention. Major alarms are automatically displayed on LEDs on the attendant console and mainte-
nance or alarming circuit pack, logged to the alarm log, and reported to a remote maintenance
facility, if applicable.

memory
A device into which information can be copied and held, and from which information can later be
obtained.

minor alarm
An indication of a failure that could affect customer service. Minor alarms are automatically dis-
played on LEDs on the attendant console and maintenance or alarming circuit pack, sent to the
alarm log, and reported to a remote maintenance facility, if applicable.

modem
A device that converts digital data signals to analog signals for transmission over telephone cir-
cuits. The analog signals are converted back to the original digital data signals by another modem
at the other end of the circuit. (MOdulator-DEModulator)

multileg cable, also called an octopus cable or a splitter cable
Processor interface cable
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N
node

A switching or control point for a network. Nodes are either tandem (they receive signals and pass
them on) or terminal (they originate or terminate a transmission path).

NT Operating System
The Windows 32-bit operating system engineered by Microsoft. NT Servers provided centralized
security, fault tolerance and additional connectivity while managing NT Workstations over a net-
work.

O

Oryx API (OAPD
Terminates the Oryx calls from the DEFINITY application and converts them to Windows NT primi-
tives. Provides information through optical calls (for example, time of day and RYON board serial
number) and supports the DEFINITY SAT interface.

(O]
Operations Support System

OSSI
Operational Support System Interface

P

PCMCIA
Personal Computer Memory Card International Association

port
A data- or voice-transmission access point on a device that is used for communicating with other
devices.

port network (PN)
A cabinet containing a TDM bus and packet bus to which the following components are con-
nected: port circuit packs, one or two tone-clock circuit packs, a maintenance circuit pack, service
circuit packs, and (optionally) up to four expansion interface (El) circuit packs in DEFINITY ECS.
Each PN is controlled either locally or remotely by a switch processing element (SPE).

port-network connectivity
The interconnection of port networks (PNs), regardless of whether the configuration uses direct or
switched connectivity.

Primary Rate Interface (PRI)
A standard ISDN frame format that specifies the protocol used between two or more communica-
tions systems. PRI runs at 1.544 Mbps and, as used in North America, provides 23 64-kbps
B-channels (voice or data) and one 64-kbps D-channel (signaling). The D-channel is the 24th
channel of the interface and contains multiplexed signaling information for the other 23 channels.
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processor interface cable
octopus cable, splitter cable, or multileg cable. See

processor port network (PPN) control carrier
A carrier containing the maintenance circuit pack, tone/clock circuit pack, and SPE circuit packs
for a processor port network (PPN) and, optionally, port circuit packs.

R

remote maintenance board (RMB)
A board provided in adjunct processors that intelligently monitors the system hardware for health
status. These include environmental conditions, PC heartbeat, and sanity checks. The RMB func-
tionality also allows modem access to the TN parent board.

RS-232C
A physical interface specified by the Electronic Industries Association (EIA). RS-232C transmits
and receives asynchronous data at speeds of up to 19.2 kbps over cable distances of up to 50
feet.

S

Sanity Keeper
See[Global Sanity Keeper

single-carrier cabinet
A combined cabinet and carrier unit that contains one carrier. See also|multileg cable, also called|
lan octopus cable or a splitter cable.|

Station Message Detail Recording (SMDR)
This software feature transmits detailed information on all incoming and outgoing calls on speci-
fied trunk groups through an switch processing element (SPE) port to an external output device,
that logs the data. SMDR is one facet of the more general Call Detail Recording (CDR) feature.

switch
Any kind of telephone switching system. See also[communications system |

switch-processing element (SPE)
A complex of circuit packs (processor, memory, disk controller, and bus-interface cards) mounted
in a PPN control carrier. The SPE serves as the control element for that PPN and, optionally, for one
or more EPNSs.

system administrator
The person who maintains overall customer responsibility for system administration. Generally, all
administration functions are performed from the Management Terminal. The switch requires a spe-
cial login, referred to as the system administrator login, to gain access to system-administration
capabilities.
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T
TCP/IP

Transmission Control Protocol/Internet Protocol

\"

Virtual Fabric Manager (VFM)
A module that allows the use of DEFINITY ECS code in a hardware environment that differs from
the one for which it was designed. One side of the VFM talks to DEFINITY ECS in protocols it
understands and changes these into methods and messages to perform needed operations in the
DEFINITY ONE environment.

W

Watchdog
A component of the Global Sanity Keeper (GSK) that is responsible for starting up the DEFINITY
ONE application software, including the downloading of the MPC860 application firmware. Watch-
dog is the first DEFINITY ONE process to run.
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|
Numerics

25-pair cable pinout,[1-69

2-wire digital station wiring,|1-43

302C1 attendant consoles,|1-40

367A adapter,[1-60

3-pair and 4-pair modularity,|1-48

400B2 adapters,[1-42

A

AC load center,check AC power,[1-12

AC power

checking,[1-12

ground wiring,[1-15

AC power and ground,|1-12
AC power supply,[1-12
AC voltage test,|1-12

accounting

set up system,[3-12

adapters

400B2,[1-42

BR851-B,|1-59

adding

circuit packs,|6-2

CO trunk,[6-2,]6-6

code calling access,|6-6

DID trunk,|6-3

DSL1 tie trunk,|6-6

FX trunk,|6-2,16-6

OPS trunk,|6-6

PCOL trunk,|6-2
pooled modem,[6-7

remote machines,|4-11

speech synthesis,| 6-6

tie trunk,[6-4

WATS trunk,| 6-2 [6-6

adjunct power,|1-42

adjunct power connection,|1-42

administering

DEFINITY for AUDIX initialization,|3-l4
administering circuit packs,[3-11

administration

AUDIX,[3-22

inital tasks,[4-2

digital networking,| 4-1

modem,[9-6

alarm

connections,[1-43,[1-52

origination disable procedure,|9-6

relay contact,| 1-52
alarm output,|1-52
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analog station (2-wire),[1-43

analog tie trunk,[1-44

APP connector information,| 1-40,|A-6,|A-13,|A-17|t0IA-19

applications

shutting down,[C-44

approved grounds,|1-13,{1-16
attendant console,|1-40

302C1,]1-40

maximum cabling distance,[1-40

attendant consoles

302C1,|1-40

LEDs,|F-1

AUDIX administration,|3-22

AUDIX commands,|3-22

AUDIX initialization,|3-14

add stations,|3-17

add test plans,|3-21

change coverage plan,|3-21

check class of restriction,| 3-16

check class of service,[3-15

check dial plan,|3-14

check hunt groups,|3-15

make a hunt group,|3-19
AUDIX networking,ﬁ%

auxiliary equipment pin designations,[A-17]to[A-19
auxiliary equipment pinout information, A-6,JA-13

auxiliary power,[1-54
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]
B
backup procedures,[C-17
bit rate

setting,[A-4
BR851-B adapter,[1-59
BRI

multipoint cabling distances,[1-61

terminating resistor,[1-55

building steel

gounding,[1-13

C

cabinets

cross connecting to MDF,|1-24

floor-mounting,|1-7

power switches,|1-15

wall mounting, [1-8

cable

diagrams,[1-40

pinout

25-pair,|];-69
cable pinouts,[A-1

cables

diagrams, A-13 JA-17]to[A-19

call accounting,|3-12
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Call Accounting System (CAS) for Windows,[3-12 |
carrier address ID
setting,[1-6 |
CAS for Windows
setting,|3-12
change machine command,|4-6
change machine remote_machine_name command,(4-14
change system-parameter limits command,|4-4
changing customer options,|3-10
Circuit Pack
TN750C,[6-9 |
circuit pack
TN795,|5-3 |
Circuit packs
slot loading,[1-29 |
circuit packs
adding,[6-2
administering,[3-11
allowable for CMC,|1-24
complete Iist,|1-24
installation,|1-29
installtion order,[1-31

LEDs,|F-2
pin designations,|A-17]to[A-19
status LEDs,|F-3

TN2185 ISDN-BRI 4-wire S Interface,|A-12
TN2224 Digital Line,|A-10,|A-16
TN744D call classifier/tone detector,lﬁQ
TN795 processor,[1-29
circuit protection
off premises, [1-33 |
CMC cabinet
equipment packed with,[1-3 |
CMCs
allowable circuit packs,|1-24
CO trunk wiring,[1-43
CO trunk, adding,|6-2,]6-6
code calling access, adding,|6-6
cold starts
with translations loading,[D-5
comcodes
equipment packed with CMC,[1-3
Command Permissions Categories form,|3-7
commands
categories,[3-8
change machine,[4-6
change system-parameter limits,[4-4
DEFINITY for user,[3-8
net user,|3-5
commandschange machine remote_machine name,l&y
commercial AC power,[1-12
components
unique to DEFINITY ONE,|1-2
concrete encased ground,|1-13
configuring
customer LAN,|2-7
modem,[9-6
Connect
laptop,|3-2
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connect

adjunct power,|1-42
connect AC power,|1-12

connect power cords,[1-18

connecting

management terminal,|1-40

connecting laptop computer,|C-2

connections
ITS

network,|6-15
copy protection,|10-2,|C-44
coupled bonding conductor,|1-17,[1-18

coupled bonding conductors (CBC)

installing,[1-18

customer LAN

configuring,[2-7

customer options

changing,[3-10

customer’s order

checking,[1-2

Issue 1
December 1999

IN-4

D

date

setting,[3-9

DC power

signaling leads,|A-1

DEFINITY logins,|B-8

DEFINITY Site Administration,[7-1

DEFINITY Site Administration (DSA),[7-1

defragment

Diskeeper,[5-5

DID trunk

wiring,[1-43

digital networking,[4-1

adding remote machines,|4-11
administering networking channels,|4-5

changing local machine information,[4-6

changing local machine profiles,|4-6

completing remote machine profiles, [4-14

feature options,[4-3

initial administration,[4-1

local machine information,|4-6

networking channels,[4-5

number of users,[4-4

remote machine profiles,|4-14

remote users,|4-4

verifying purchased options,|4-3

digital station (2-wire),|1-43
digital tie trunk,|1-45
Diskeeper,|5-5

DS1 tie trunk, adding,[6-6

DSA,|7-1

adding new switch configuration,ﬁ-8

adding new voicemail item,lL;S

components,|7-4

configuring,|7-7
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DSA, (continued)

download,|3-24

hardware configuration,l'ig

help,[7-7

installing,[B-8

launching emulation session,|7-21
launching GEDI session,[7-20

launching voicemail administration session,|7-22

logins,|B-9

start a session,|3-29

switch administration activities,ﬁ-S

switches,[7-2

voicemail,| 7-2
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E

electrical connection,[1-12

emergency transfer power panel,|l-54,|1-67
emergency transfer telephone,|1-74

equipment

checking,[1-2

comcodes for CMC equipment,| 1-3
packed with CMC cabinet,|{1-3

unpacking,[1-2

equipment checklist,[C-2

equipment room hardware

installing,[1-24

error messages

installation wizard,|9-1

exteranl modems

type-approved,|1-23

external alarm

wiring example,[1-43

external modem

installing,|1-23
U.S. Robotics, 1-76
external modem option settings,|1-23,|1-76

F

faceplates

TN795 processor circuit packs,|1-39||E-4

feature protection,[10-2

flash disk

replace,|5-5

floor grounds,|1-14
floor-mount cabinet,[1-7

FX trunk, adding,[6-2,]6-6

G

ground

rings,|1-13
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Ground Block Installation to Right Panel,[1-16

ground blocks

installing,[1-16

ground wiring

AC,[1-15

grounds

approved floor,[1-14

building steel,[1:13

concrete encased,|1-13

water pipes,[1-13

H

hard disk

replacing,[5-4

hardware

additions,|6-1

help

terminal set-up commands,(2-18

hunt groups,[3-15

I

impedance, setting,[A-4

INADS

Modem,|[9-6

initialization

AUDIX,[3-22

install circuit packs,[1-29

install coupled bonding conductors,|1-18
install equipment room hardware,| 1-24

install external modem,|1-23

install ground block,|1-16

install main distribution frame and external modem,|1-21

install sneak fuse panels,|1-34
install system cabinet,|1-6
install telephones,|1-40

installation error messages,[9-1

integration process
connecting

ITS components,[6-14

ITS to the network,[6-15

Internet Telephony Server

connecting components, [6-14

logging on,[6-15

network services, changing,|6-16

IP address

assign,[6-16

IP Trunk,[6-12

ISDN
BRI

fanout of multipoint installations,|1-61

terminating resistor,[1-55
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L
label main distribution frames,|[1-37
labels

main distribution frame,[1-37
LAN

IP Trunk,|[6-12

LAN connection,|6-18
LAN interface,[3-10

laptop computer

connecting,[C-2

mapping DEFINITY ONE to CD-ROM drive,[(C-13

verifying connection,(C-11
lead designations,|A-6

port board,%-54
telephones,[1-54

LEDs

alarms,|E-2

attendant console,| F-1

circuit packs,|F-2

indicators on maintenance/processor circuit packs,[E-2

power suppy,[E-3

TN795 processor circuit packs,@

License File,[3-3

local machines

changing information,|4-6

logging on to the ITS,|6-15

login groups,|B-2

login names,|B-2

logins

administering command permissions,|3-7

AUDIX,[3-5

AUDIX commands,|B-5

AUDIX with ASG enabled,|7-9,[7-16

customer, 3-6

customer AUDIX,|B-3

customer DEFINITY,|B-8

customer Web access,|B-3
customer Windows NT, B-7

DEFINITY,[3-6

web,|3-6

M

main distribution frames

installing external modem,|1-21

labeling,|1-37
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